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Introduction to Longview
Longview provides corporate performance management (CPM) software that leading companies use to
drive performance with speed, visibility, and financial integrity. Since 1994, many of the world's most
respected companies have been using our technology platform to create a single repository of financial
truth from which statutory consolidation, management reporting, financial planning, modeling, analysis,
budgeting, forecasting, and strategic tax can be performed quickly and accurately, enterprise wide.

Longview enables enterprise clients to collect, store, analyze, and report on data in real-time by
automating, centralizing, and standardizing any one or combination of the following key financial
processes: Planning, Budgeting, Forecasting, Consolidation, Financial Close Management, Profitability
Analytics, Statutory, XBRL Financial Reporting and Tax Provisioning. With Longview customers can
reduce overreliance on spreadsheets, improve transparency, and regain control of these key finance
functions.

Longview Tax calculates your company’s global tax charge, effective tax rate, and deferred taxes for tax
provisioning purposes. Since Longview Tax uses the same technological platform as your corporate
performance management solution, the tax reporting process is directly integrated into the corporate
close process. As one solution, consolidated pre-tax income can be reported by legal entity to
accurately calculate consolidated income tax charges and deferred taxes.

For more information on purchasing Longview Tax, contact your Longview Account Manager. Web
services are a standardized way of integrating applications over the Internet or Internet protocol-based
networks. Web services rely on certain software standards including Extensible Markup Language
(XML), Simple Object Access Protocol (SOAP), Web Service Definition Language (WSDL) and
Universal Description, Discovery & Integration (UDDI).

About this guide
This guide includes basic information on how to install your Longview system. The following sections
indicate conventions that are used in this guide.

Warnings and notes
This guide uses the following conventions for warnings and notes:

Caution: Warnings provide cautionary information on the possible effect of certain actions,
including the unintentional deletion of data. Be sure to read and understand all warnings
before performing a related procedure.

Note: Notes provide additional information to help you understand your Longview system
better. They also provide important information on exceptions to general guidelines.

Procedures
There may be several ways to perform a procedure in your Longview system.

n You may be able to choose a menu command. For example, to open a file, you can choose
Open from the File menu. In this documentation, we use: Choose File > Open.

https://insightsoftware.com/
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n You may be able to use a keyboard equivalent. For example, to exit you can press the Alt key
and then the letter F to open the File menu, and then press X for Exit.

n You may be able to click a button or icon. If a menu command has an equivalent button or icon,
an illustration of the button or icon may appear in the margin.

In this documentation, we may not describe all methods to carry out a task. Use whichever method you
prefer. Depending on the task you are performing, certain methods may not be available.

Contacting Longview
Questions? We are ready to help. For contact information for Longview, visit our web site at
insightsoftware.com/Longview/.

Understanding Tasks In Longview
Administrative Components
Longview Application Administrator and Longview Server Manager administer different aspects of the
system. Which components you should use depends on the nature of the task you want to perform.

The following table lists common administrative tasks and the corresponding component to use:

https://insightsoftware.com/
https://insightsoftware.com/Longview/
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Administrative tasks Component to use

Longview Application

Administrator

n Checking for duplicate data

n Collecting statistics

n Creating, modifying, and deleting users, groups, and
symbols

n Exporting the Data Audit Trail

n Resetting the Data Audit Trail

n Importing Data Server objects from text files

n Running restatements or recalculations

n Specifying Journal Entries settings

n Specifying NDD settings

n Working with attributes

n Working with batches

n Working with events

n Working with foreign exchange

n Working with locks

n Working with schedules

n Working with server rules (model, rollup, query, event, and
validation rules)

n Working with symbol access roles

n Working with the hierarchy

https://insightsoftware.com/
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Administrative tasks Component to use

Longview Server Manager

n Analyzing user data

n Exporting data to files

n Importing data from files

n Starting and stopping servers

n Working with Log files

n Working with server queues

n Working with server status

n Working with servers

n Working with the Data Server Configuration

Overview of Server Tasks And Roles
Server tasks fall into two broad categories that are handled by different kinds of users. Tasks that
involve managing the content of the database are handled by users with administrative permissions.
Tasks that involve creating the database and configuring the server are handled by users with
permissions to manage the database. Each of these user types must exist within the application.

Your company must have at least one user with administrative permissions. However, there can be as
many as you need; each designated to administer a different aspect of the business, or responsible for a
different geographical or organizational department, and so on.

Only one administrator can perform server maintenance tasks at a time. These tasks include, but are not
limited to:

n performing regular user maintenance (creating, deleting, and editing users)

n performing symbol maintenance

n running restatements and recalculations

Changes to the configuration and operation of databases and the server require permissions to make
these changes. Many server tasks, however, can be undertaken by regular administrators. These tasks
deal with creating, managing, and deleting:

n Users (see Maintaining Users and Groups)

n Groups (see Maintaining Users and Groups)

n Symbols ( see Maintaining Longview Hierarchies)

n Attributes (see Working With Attributes)

https://insightsoftware.com/
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n Schedules (see Working With Schedules)

n Batches (see Working With Batches)

n Locks (see Working With Locks)

n Events (see Working With Events)

You can use Longview Application Administrator to perform the following tasks:

n Create, copy, and delete users and user groups

n Set user and group permissions

n Assign users to groups

n Remove users from groups

n Create, modify, and delete symbol access roles

n Apply symbol access roles to users and groups

n Create, edit, and delete attributes, batches, schedules, symbols, and rules

n Configure intercompany eliminations, foreign exchange settings, and NDD settings

n View and delete locks

n Detect duplicate data

n Collect statistics

n View audit trail data

n Run restatements and recalculations

Conventions
Throughout this documentation, we’ve decided to present information in certain ways. We know you are
anxious to get right to work, but if you take a few moments now to read this section, you’ll learn how to
use this documentation more easily.

This guide includes the basic information on how to use Longview Application Administrator. It is
provided in two formats: PDF and online help. You may access the online help from the Help menu of
the application.

https://insightsoftware.com/
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Getting Started in Longview Application
Administrator
You can use Longview Application Administrator to manage the administrative aspects of your system,
such as users, groups, permissions, and settings.

Understanding multilingual systems
The default language for your system is English. If you intend to use Application Administrator with an
alternate language, be aware that although the user interface appears in English, symbol descriptions
will be stored in the alternate language.

Understanding window elements
Longview Application Administrator, by default, consists of four sections, each of which, except for the
Contents window, can be opened, closed, and resized relative to the other windows. Each section has a
different purpose and allows you to perform different tasks and access different information.

https://insightsoftware.com/
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Note: Certain changes you make to the appearance and arrangement of elements in
Longview Application Administrator are saved as settings and are remembered the next time
you start the application. For example, if you close the Properties pane by clicking the “X” in its
upper right corner and close the application, the Properties pane will not be displayed the next
time you start the application. To restore elements, you have hidden, click View in the menu
and then click the name of the element you want restored.

Server Explorer pane
The Server Explorer pane displays the elements of your database system in a hierarchical tree format,
grouping items together in specific categories. For example, attributes, symbols, user groups, and so
on. As well, security settings are represented, populated with user groups and users.

When you select a category in the tree, the elements grouped immediately below it are displayed in the
Contents window (for example, choosing Attributes displays symbol, system, and user, the elements
grouped under Attributes). Selecting an item in the Contents window causes its properties (if any) to
display in the Properties window at the bottom of the application window. Many items can be duplicated
or edited in the Contents window by right-clicking them and making the appropriate selection from the
pop-up menu.

Note: To perform actions that make changes to the server or its contents, you must have
permissions to operate these functions on the server.

Contents window
The Contents window displays the constituent elements of whatever is selected in the Server Explorer
pane or was double-clicked in the Contents window itself.

The Contents window provides access to the most basic items in the database hierarchy, such as
individual users and user groups, attributes, symbols, and so on. Selecting an item in the Contents
window causes its properties to display in the Properties window, and for some items, right-clicking the
item provides options to edit, copy, and/or delete it, as well as to create new instances of the same item
type.

https://insightsoftware.com/
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Information pane
Certain tabs are grouped in the Information pane. These are:

n Console Window

n Search Results Window

Each of these windows can be undocked from the others by dragging the tab out of the Information
pane. In addition, dragging the tab towards the center will cause a set of positioning arrows to appear,
allowing you to tile the tab within the group window. Tiled or ungrouped windows can be regrouped by
dragging them back to the tabs at the bottom of the Information pane. Finally, tabs can be dragged left
and right relative to one another to change the order of the group.

Console window
The Console window supplies you with information on processes you run, such as restatements and the
collection of statistics. The information shown provides details on whether processes were successful, if
they completed, and what changes were made as a result.

https://insightsoftware.com/
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Search Results window
The Search Results window displays the results of searches. If you double-click a search result, the item
is highlighted in the Contents window, and its properties and/or details display in the Properties pane.

Searches can be run on several types of items, though the parameters of the search vary from type to
type. Searches are executed by selecting a category in the Server Explorer pane (e.g., entities under
symbols) and choosing Tools > Search, and entering the criteria of your search in the appropriate fields
of the Search dialog.

Selecting Tools > Highlight Search Results turns on or turns off highlighting of the results of your search
in the Contents window.

Properties pane
Certain tabs are grouped in the Properties pane. These are:

n Properties window

n Details window

Each of these windows can be undocked from the others by dragging the tab out of the Properties pane.
In addition, dragging the tab towards the center causes a set of positioning arrows to appear, allowing
you to tile the tab within the group window. Tiled or ungrouped windows can be regrouped by dragging
them back to the tabs at the bottom of the Properties pane. Finally, tabs can be dragged left and right
relative to one another to change the order of the group.

Properties window
The Properties window gives basic information about the item currently selected in the Contents
window:

Details window
The Details window gives in-depth information about the currently selected item in the Contents window:

https://insightsoftware.com/
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Understanding menus
Various Longview Application Administrator functions are available in the menu selections. What follows
is a brief overview of each menu pick.

Note: The menu bar appears as shown above when a symbol is selected in the Contents
window. The icons available to you at any given time may vary depending upon your current
selections.

File menu
Most options under File deal with operations outside the application, such as printing, archiving, and
exporting files.

https://insightsoftware.com/
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New
This menu selection is context sensitive and provides different options in a secondary drop-down list
depending on the current selection in other areas of the application window. In general, this item
enables the creation of new access role, attributes, schedules, rules, intercompany eliminations,
symbols, groups, and users, as well as duplicate instances.

Import
Choose Import to open a dialog that lets you designate the type of item to be imported (attribute, symbol,
user, etc.), its dimension (if it is a symbol), and the location of files from which its items, descriptions (if
applicable), and parent-child relationships (if applicable) will be imported. You can use the Browse
button to select already-created import files. For more information on using Import, see Importing Server
Objects.

Export
Choose Export to open a dialog that lets you designate the type of item to be exported (attribute, symbol,
user, etc.), its dimension (if it is a symbol), and the location of files to which its items, descriptions (if
applicable), and parent-child relationships (if applicable) will be exported. You can use the Browse
buttons to select existing files, or type in a path and file name to create new files. For more information
on using Export, see Exporting Server Objects.

Page Setup
Choose Page Setup to open a dialog where you can set the printing parameters such as the paper size
and orientation, the width of page margins, and the paper source.

Print
Choose Print to open a dialog that lets you select your printer, the number or range of pages to print, and
the number of copies. The output is either the Contents window or the grouped tab window that is active
when you click Print.

Print Preview
Choose Print Preview to open a window that shows how your output will appear on the printed page
according to your current Page Setup parameters. It enables you to view one, two, three, four, or six
pages at a time, to change the magnification level of the view (but not the actual output), and to print
directly to the default printer.

Properties
Choose Properties when you have selected an item with viewable or editable properties in the Contents
window. A dialog opens displaying the properties of the item and enabling you to edit those properties
and save your changes. The information is displayed in a tabbed format. The tabs displayed and
information populated varies with the type of item of you have selected.

Exit
Choose Exit to log out of the system and close the application.

https://insightsoftware.com/
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Edit menu
The choices under the Edit menu, Undo and Redo, let you to undo an action just performed, or to redo
the action if you decide to proceed with it after having undone it. These options are available only for
symbol maintenance actions, up until Maintenance is turned off.

View menu
The choices under the View menu let you select the window elements that are displayed or active.

Details
Choose Details to display the items in the Contents window in a text-only list.

Icons
Choose Icons to display the items in the Contents window as icons.

Console Window
Choose Console Window to activate and display the Console window in the grouped tab window at the
bottom of the Contents window.

Search Results
Choose Search Results to activate and display the Search Results window in the grouped tab window at
the bottom of the Contents window.

Details Window
Choose Details Window to activate and display the Details window in the grouped tab window at the
right of the Contents window.

Property Window
Choose Property Window to activate and display the Property window in the grouped tab window at the
right of the Contents window.

https://insightsoftware.com/
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Clear console
Choose Clear console to discard the contents of the Console window.

Caution: This procedure cannot be undone.

Refresh
Choose Refresh to update the view in the Contents window.

Toolbars
This option expands into another menu that enables you to turn the Standard and Component toolbars
on or off, and to lock their positions or unlock them so that the toolbars can be repositioned in the
interface.

Component Bar
Choose this option to show or hide the Component Bar.

Status Bar
Choose this option to show or hide the Status Bar.

Tools menu
The Tools menu presents options to do with organizing, refreshing, and gathering information about
data in the system.

Change My Password
Choose Change My Password to open a dialog allowing you to change the password of the user you are
signed on with.

https://insightsoftware.com/
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Recalculate
Choose Recalculate to have values in the database recalculated and refreshed. The Recalculate dialog
opens and allows you to set the type of recalculation, which partitions to recalculate, the names of files
to archive information before and after the recalculation, and whether to collect and display statistics
about the recalculation.

For more information see Working with Restatements and Recalculations.

Caution: A recalculation can take a considerable amount of time for large databases and can
be resource intensive. Recalculations can affect other users if run during periods when they
are signed onto the system.

Audit
Choose Audit to access three options:

n Export: Export lets you query the database for records of what values in the database have
been changed and by which users and export those records to a text file. For more information,
see Exporting the Data Audit Trail.

n Recover: Recover lets you reset leaf table values to the values stored in the audit tables. This
function is useful in the event of a system failure.

n Reset: Reset removes all audit detail and sets the initial audit values to the current leaf table
values.

Note: If you are not connected to the server, Export, Recover, and Reset are disabled. If you
do not have access to view data in the server, Export is disabled.

These options are available only if your system is configured to use Data Audit Trail. For more
information, see the Longview Server Manager Guide.

Collect Statistics
Choose this function to update the collected statistics for the current server. The progress of the update
is displayed in the Console window. Statistics are updated in the following database tables:

n KLX_ULN_P000_CELLS

n KLX_UPN_P000_CELLS

n KLX_SLN_P000_CELLS

n KLX_SPN_P000_CELLS

Duplicate Detection
Choose this option to check the database for duplicate data. For more information, see Checking for
Duplicate Data.

https://insightsoftware.com/
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Foreign Exchange Setup
Choose this option to set up or modify your foreign exchange settings. For more information, see
Working with Foreign Exchange.

Journal Entries Setup
Choose this option to open the Journal Entries Setup dialog and customize the behavior of Longview
Journal Entries. For more information, see Configuring Journal Entries.

NDD Setup
Choose this option to select the modulating, independent, and dependent dimensions for N-dimensional
modeling. When you choose NDD Setup, a dialog is displayed with drop-down lists that allows you to
make your dimension selections. Subsequent dialogs enable you to change Valid Root(s) settings,
Default Symbol, and Modulating Symbol. For more information, see Specifying NDD Settings.

NDD Pattern Table Setup
Choose this option to open a pattern table dialog that allows you to make symbol selections for N-
dimensional modeling. For more information, see Setting Up or Modifying the NDD Pattern Table.

Event Rule Merging Setup
Choose this option to configure event rule merging. You may have event rules that trigger the exact
same process based on different circumstances. If this is the case, you can consider merging these
rules so that they don’t trigger the process multiple times unnecessarily. For more information, see
Specifying Event Rule Merge Settings.

Event Rule Dependencies Setup
Choose this option to configure event rule dependencies. If your system includes a rule that always
triggers another rule, you can specify this dependency so that if those two rules are triggered
simultaneously, the system waits for the preceding rule to finish before it allows the dependent rule to
process, which uses system resources more efficiently. For more information, see Specifying Event
Rule Dependencies.

Search
Choose Search to execute a search by selecting a category in the Server Explorer pane (e.g., entities
under symbols), choosing Tools > Search, and entering the criteria of your search in the appropriate
fields of the Search dialog. Searches can be run on several types of items, though the parameters of the
search vary from type to type.

The Search Results window displays the results of searches. Double-click a result to display its
properties and/or details in the Properties pane.

Highlight Search Results
Choose Tools > Highlight Search Results to highlight or not highlight the results of a search in the
Contents window.

Options
Choose Options to change the way items are displayed in the Contents window.

https://insightsoftware.com/
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For example, you can change the colors used to highlight results when you have Highlight Search
Results on. In addition, you can format how symbols are displayed, and what information about symbols
accompanies them.

Actions menu
The Actions menu provides access to functions concerned with maintaining and arranging your symbol
hierarchy.

Connect
Choose Connect to connect to the server, provided your User ID has the requisite permissions to do so.
This option becomes available when you are not connected to the server. All server tasks require that
you connect to the server as a user with administrative permissions.

Disconnect
Choose Disconnect to disconnect from the server. This option becomes available when you are
connected to the server. Once you click Disconnect you will no longer be able to view, modify, or
otherwise access the resources of the server until you connect to it again.

https://insightsoftware.com/
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Maintenance
Choose Maintenance to turn Maintenance on or off. A check mark beside the option indicates that
maintenance is active.

Exclusive Mode
Choose Exclusive Mode to turn Exclusive Mode on or off. A check mark beside the option indicates that
Exclusive Mode is active.

Dynamic Calculations
Choose Dynamic Calculations to turn the ServerMath Flag on or off.

Assign
Choose Assign to drag a selected symbol to another symbol, which then becomes its parent symbol.
This option becomes available when you select a symbol.

Assign To
Choose Assign To, to assign the previously chosen symbol to the symbol currently selected. This option
becomes available after you have used Assign.

Remove From Parent
Choose Remove From Parent when a child symbol is selected to remove the symbol from the parent's
hierarchy and place the symbol in the root of its class. This option becomes available when you have
selected a child symbol.

Duplicate Hierarchy
Choose Duplicate Hierarchy to open a dialog that lets you create a duplicate of the hierarchy. This
option becomes available when you select a root symbol of a hierarchy. A specified prefix or suffix is
added to each symbol name in the hierarchy being duplicated. For more information, see Duplicating a
Hierarchy.

Set Value
Choose Set Value to open a dialog that lets you set the attribute’s value. This option becomes available
when you select an attribute.

Delete

Caution: Deletions cannot be undone.

Choose Delete to be prompted by the system to confirm that you want to proceed before the deletion is
performed. This option becomes available when you have selected an item that can be deleted.

Help menu
The Help menu provides you with access to information on how to work in the application, and
information on the current build of the application.

https://insightsoftware.com/
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Longview Application Administrator Help
Choose Longview Application Administrator Help to open another window which presents the online
help system. The system has two panes; one on the left shows the table of contents tab, which features
an expandable and collapsible structure of topics and the subtopics grouped under them. The pane on
the left contains other tabs:

n The index tab, with clickable links to content.

n The search tab, which enables you to search the online help system for instances of words and
then access the results.

n The favorites tab, which enables you to bookmark information you have found useful for future
reference.

The pane on the right is the content pane, where the information contained in the online help system is
displayed. This pane changes to display different information based on the choices you make in the
other pane. It also features navigation buttons at the top and bottom of each topic that display the next
and previous topic respectively, and hyperlinks that take you directly to related information when clicked.

About Longview Application Administrator
Choose About Longview Application Administrator to open an information window that displays the
name of the application and its current version. This can be useful in the event that you need to contact
Longview on a service matter. To close the window, click anywhere within it.

Working in Maintenance mode
When users and administrators are working with Longview components, there may be maintenance
modes turned ON and OFF automatically as part of a process.

For information on using commands involved in maintenance, see the Longview Desktop Commands
and Functions Guide or the Longview Developer’s Guide.

Maintenance mode
When administrators make Database Maintenance changes to the Data Server repository, Maintenance
mode is usually turned ON automatically. While it is ON, the following apply:

n Users can connect and perform read-only queries

n Users can lock data areas, post journal entries, and submit data (these activities are
suspended, not stopped, while user and symbol changes are committed and refreshed)

The time required for the servers to commit and refresh can be several seconds to several minutes. The
length of time depends on several factors:

n Symbol and hierarchy sizes

n Use of other features, such as NDD or data translation

n Status of the Math queue. When user or symbol changes are committed, the submission queue
is suspended and a suspend request is sent to the Math queue. All pending math jobs in the
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queue prior to this request must complete before the Math Server can be suspended and
refreshed. When large math jobs are pending, long wait times may occur.

Exclusive mode
Exclusive mode may be turned ON automatically (if no pending submissions exist) in conjunction with
Maintenance mode and while it is ON, the following apply:

n Users can connect and perform read-only queries

n Users cannot lock data areas, post journal entries, or submit any data

If a user has turned Exclusive mode ON, the same user must turn it OFF before certain actions can be
performed by other users.

Note: If a restatement fails due to errors, exclusive mode will remain on to prevent users from
submitting data to the database. Users will not be able to turn exclusive mode off through
Application Administrator in this case. If exclusive mode needs to be turned off from a failed
restatement either run a successfully restatement or restart the servers.

https://insightsoftware.com/
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Performing General Server Tasks
Checking for duplicate data
Due to user errors or other reasons, you may sometimes have duplicate data in your system. You can
use Longview Application Administrator to check for duplicate data before you perform a data export or
a restatement.

To check for duplicate data, complete the following steps:

1. Open Longview Application Administrator.

2. Select Tools > Duplicate Detection. The Duplicate Detection dialog displays, as shown below:

3. Complete these fields:

a. Family: Select Base (to check Base data only), Schedule (to check Schedule data only), or
All (to check all data).

b. Data Option: Select Calculated, Parent, or All types of data.

c. Partition List: Specify the list of partitions you want to check.

4. Click Run. The results of the duplicate check appear in the Console window.

5. Click OK.

Working with restatements and recalculations
An enterprise restatement is a mode of calculation in which a rollup of the entire database is performed
making all values current. An enterprise restatement is required to calculate the effect of major changes
throughout the database.

A partition recalculation is a mode of calculation in which a recalculation of one partition is performed
making all values current. A partition recalculation is required to calculate the effect of changes confined
to a single partition.
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Partition recalculation does not guarantee data integrity under the following scenarios:

n If the specified partition or partitions do not cover all input leaf data needed to generate data for
the specified partition or partitions.

n If there is output data generated outside of the specified partition or partitions. You will see a
warning message in the Longview Data Server Log:

The output data generated to the following partitions were filtered out during partition recalc on
specified_partition_name: list_of_partitions.

You can use Longview Application Administrator to run a recalculation that meets your specific
requirements. For information on running a recalculation using line mode, see the Longview Server
Manager Guide.

To run a recalculation, complete the following steps:

1. Open Longview Application Administrator.

2. On the toolbar, click Recalculate. The Recalculate dialog opens.

3. Select the Recalculation Type. The recalculation types are as follows:

a. Auto: Performs steps based on lvsrvr.cfg parameters set to TRUE.

b. Regular: Restate Unadjusted, Recalculate Journals, and Restate Adjusting.
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c. Full: Restate Unadjusted, Recalculate Journals, Recalculate Eliminations, and Restate
Adjusting.

d. Basic: Restate Unadjusted and Restate Adjusting.

e. Journal Entries Only: Recalculate Journals.

4. Select the partitions you want to include in the recalculation. If you want all partitions included, click
Select all.

5. If you want to enable tracking changes to the Data Server Log file, select Before Recalculation,
After Recalculation, or both. In the adjacent text fields, provide the path and file name of the Data
Server Log file to which you want this information written.

6. If you want statistics generated by the recalculation to be recorded, select Run Collect Statistics
after recalculation.

7. If you want to view recalculation statistics, select Display recalculation statistics.

8. To run the recalculation, click OK. The results of the recalculation appear in the Console window.

Exporting the Data Audit Trail
You can use the Data Audit Trail functionality of Longview to query the database for records of the
values in the database that have been changed and by the users who changed them, and to export
those records to a text file. This information can be important in recovering from system failures,
correcting erroneous entries, and compliance with the Sarbanes-Oxley Act.

Note: Using the Data Audit Trail functionality requires that the Data Audit Trail parameter be
set to TRUE in Longview Server Manager (the default value is FALSE). In addition, the
RECALC AUDIT RESET command must be performed on the data server. For more
information, see the Longview Server Manager Guide. If you do not have access to this
functionality, contact your System Administrator.

To export the Data Audit Trail, complete the following steps:

1. Open Longview Application Administrator.

2. Select Tools > Audit > Export. The Data Audit dialog displays, as shown below:
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Note: You can enter parameters for as many criteria in the dialog as you choose. If no criterion is
specified, all data audit information is returned.

3. Enter parameters for any or all the following fields:
a. Symbols: To specify a symbol for a dimension, click in the cell under the Symbol column for

that dimension to activate a symbol selector button ( ... ). Click the button to view the Symbols
dialog and use it to select a symbol for that dimension.

Note: The data query defaults to the user attribute values found in the UGPD
[DimensionNumber]QueryDefault attributes. In addition, if you have access to only
one symbol in a dimension, the selection defaults to that symbol.

b. Schedule Dimension: To enable the use of a schedule dimension, select Include Schedule
Dimension, and use the drop-down list to select a schedule. To specify a symbol for that
dimension, click in the cell under the Symbol column for that dimension to activate a symbol
selector button ( ... ). Click the button to view the Select Symbol dialog and use it to select a
symbol for that dimension.

c. User Filter: Select User Filter and use the drop-down list to select a user. Changes made by
this user only are included in your results.

d. Date Filter: Select Date Filter, and type dates in the MM/DD/YYYY format or use the calendar
drop-down menus to select a specific date for each field.

https://insightsoftware.com/


31

e. Data Change Threshold: Select Data Change Threshold, and use the drop-down menu to
select Between, Greater Than, Less Than, or Value Of, then supply a value or values in the
field(s) below.

f. Associated With a Batch: Select Associated with a Batch and enter a batch ID number in the
field below.

g. Sorting Options: The Sorting Options enable you to specify how to sort the data audit results.

4. When you have completed configuring the criteria of your query, complete the following fields:
a. File Name: Enter a name for the Export file.

b. Location: Enter a location to which you want to save the Export file. Alternately, you can use
the Browse button to navigate to the folder to which you want to save the Export file.

Note: The Export button is unavailable until the File Name and Location are entered.

5. Click Export. A Data Audit Export progress bar opens.

Note: Depending on the size of the database and the specificity of your query, a data
audit trail export may take several minutes to complete.

6. After the export finishes, an Export Summary screen displays, as shown below. This screen
summarizes the number of entries saved as well as the number of errors encountered. 

7. Click Close.

Audit Trail Export file syntax
After the Data Audit Export is complete, the data specified by your query is exported to a text file. The
syntax of the export file depends on whether only base data was queried, or a schedule was included as
well.

Base data

ID{Dim_0{Dim_1{...{Dim_N{Old Value{New Value{Delta{Date{User{Comments

Where:
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n ID is the batch ID number.

n Dim_0{Dim_1{...{Dim_N are the symbols queried in each base dimension.

n Old Value is the old value of the data.

n New Value is the new value of the data submitted to the database.

n Delta is the difference between Old Value and New Value.

n Date is the date on which the changes were submitted to the database.

n User is the username of the user that made the changes.

n Comments is any comments associated with the changes, enclosed in double quotation marks.
If the comments already contain quotation marks, they are enclosed in a second set of double
quotation marks (""comment"").

Example:

2174{A11510{A10OPEN{B0910{DIM3SET{DIM4SET{DIM5SET{DIM6SET{DIM7SET{0{99{99
{11/26/2010 11:11:58 AM{TAXADMIN{"Trial balance input"

Schedule data

ID{Dim_0{Dim_1{...{Dim_N{Schedule{Sched_Dim1{..{Sched_DimN{Old Value{New
Value{Delta{Date{User{Comments

Where:

n ID is the batch ID number.

n Dim_0{Dim_1{...{Dim_N are the symbols queried in each base dimension.

n Schedule is the name of the schedule selected in the Schedule Dimension drop-down list.

n Sched_Dim1{...{Sched_DimN are the symbols queried in each schedule dimension.

n Old Value is the old value of the data.

n New Value is the new value of the data submitted to the database.

n Delta is the difference between Old Value and New Value.

n Date is the date on which the changes were submitted to the database.

n User is the username of the user that made the changes.
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n Comments is any comments associated with the changes, enclosed in double quotation marks.
If the comments already contain quotation marks, they are enclosed in a second set of double
quotation marks (""comment"").

Example:

3{SALES4{QAFOR01{XL2{DIM3SET{DIM4SET{VALIDATION{DIM6SET{DIM7SET{S1043{L0001
{C0001{ 1126{-112{-1238{29/11/2010 12:04:13 PM{LONGVIEW\MIHA228461{"Data
submission"

Resetting the Data Audit Trail
If your system has Data Audit Trail selected in the Server Configuration settings, you can reset Data
audit detail. If you reset Data audit detail, the trail is deleted and the initial audit values are reset to the
current leaf table values. Batch and event information is also deleted, along with related log, error, and
history files.

To reset the Data Audit Trail, complete the following steps:

1. In Longview Application Administrator, choose Tools > Audit > Data > Reset. A confirmation dialog
opens.

Caution: Clicking Yes in the next step removes all audit trail values and batch and event
information, as well as log, error, and history files in the file paths defined in the Server
Configuration settings.

2. Click Yes. The Data Audit Trail is reset.

Resetting the Metadata Audit Trail
If your system has Metadata Audit Trail selected in the Server Configuration settings and you have the
appropriate authorizations, you can reset Metadata Audit trail. If you reset Metadata Audit trail, the trail
is deleted according to the specified selections. If the Metadata Audit Trail Log Files location is set in
the Server Configuration, a log of the audit records that were reset will be created in the specified
location.

To reset the Metadata Audit Trail, complete the following steps:

1. In Longview Application Administrator, select Tools > Audit > Metadata > Reset. A dialog opens.

2. Enter parameters for any or all the following fields:
a. Date: Type dates in the YYYY/MM/DD format or use the calendar drop-down menus to select

a specific date for each field.

b. Category: To reset Metadata Audit Trail for specific category types, select one or more of the
following:

l Select All

l Attribute Maintenance
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l Authorization Maintenance

l Group Maintenance

l Group Membership Maintenance

l Role Maintenance

l Symbol Maintenance

l User Maintenance

c. Comment: Optionally, enter a command to be included with the reset action.

Caution: Clicking Reset in the next step removes the specified metadata audit trail
information.

3. Click Reset. The Metadata Audit Trail is reset.

Configuring Journal Entries
Before using Journal Entries, you can modify journal entry settings to meet your company’s needs. You
can also create sub-categories for schedule journal entries.

Specifying Journal Entries settings
You can use the Journal Entries Setup dialog to quickly set up and modify settings for Journal Entries
more easily than setting individual attributes. You can use this dialog only if you have the necessary
permissions to change settings for Journal Entries.

To use the Journal Entries Setup dialog to set up or modify Journal Entries settings, complete the
following steps:

1. Open Longview Application Administrator.

2. Select Tools > Journal Entries Setup. The Journal Entries Setup dialog displays, as shown below:
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3. On the General tab, set the following parameters:
a. Allow the Journal Entry Application ID to be modified: Specify whether the Application ID is set

only during the initial creation of the journal entries, or whether it can be modified later.

b.  Share New Journal Entries by default: Specify whether you want journal entries to be shared
by default.

c.  Share Posted Journal Entries: Specify whether all journal entries are shared after posting.

d.  Allow Journal Entries on areas marked submitted or invisible by workflow: Specify whether
you want users to be able to submit journal entries on areas of workflow that have been
submitted for approval or are invisible.

e.  Retain Deleted Journal Entries in the database: Specify if you want deleted journal entries to
be retained by the database, and users to have the option to retrieve deleted journal entries.

f.  Number of Decimal Places for Financial Journal Entries: Enter a value between 0-100 or use
the arrow buttons to raise and lower the value, to specify the number of decimal places you
want financial journal entries to display.

g.  Number of Decimal Places for Nonfinancial Journal Entries: Enter a value between 0-100 or
use the arrow buttons to raise and lower the value, to specify the number of decimal places
you want non-financial journal entries to display.

h.  Dimensions that can be unbalanced in Journal Entries: Select the check box associated with
a dimension to allow it to be unbalanced in journal entries.

4. Click the Symbols tab.
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5. For each dimension in the database, select a post-able root symbol. This symbol does not have to
be a dimension root symbol; however, make sure it contains all possible leaf symbols to be used for
adjusting journal entries. Ignore any unused dimensions.

a. To select a symbol, click in the Default Symbol cell for a dimension. A symbol selector button
( ... ) appears. Click it to open the selection dialog. You can locate and select the default
symbol for that dimension. Repeat this step for all applicable dimensions.

6. When you have completed the general settings and symbol selections, click OK.

Creating sub-categories for journal entries
You can create new journal entry sub-categories in addition to the out-of-the-box sub-categories that are
built into Longview. Sub-categories can be associated with schedules.

For more information on schedules, see Understanding Schedules.

To create a journal entry sub-category, complete the following steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Journal Entries, and select Sub-Categories. The list of sub-
categories appears in the Contents window.

https://insightsoftware.com/


37

3. Right-click and select New JE Sub-Category. The New JE Sub-Category dialog displays, as
shown below:

4. Complete the following fields:

a. Schedule Name: Use the drop-down list to select a schedule to base the sub-category on. For
Elimination journal entries, select an Intercompany Transaction schedule, such as
ICStandard. This field is optional.

b. Reclassification: Select this option to allow base details to have different amounts than the
total of the sub-details when the subcategory is applied. This field is available only if you select
a Schedule.

Note: By default, this option is not selected, which forces base details to equal the
total of the sub-details.

5. Click OK. The new sub-category appears in the list in the Contents window.

Specifying NDD settings
The N-Dimensional Distribution, or NDD, functionality of Longview facilitates the distribution of data to
all the dimensions in a database. This can be useful when, for example, it is necessary to copy data from
an Entity or Account symbol to a Product symbol.

Setting up or modifying NDD
To set or modify your system’s NDD settings, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > NDD Setup. The NDD Setup dialog displays, as shown below:
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3. Select the Modulating Dimension from the drop-down list.

4. Select Valid Root Symbols for the Modulating Dimension. Either enter the symbol name or click
the symbol selector button ( ... ) and use the symbol selection dialog to select a symbol.
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5. Select the dimension(s) that you want to be Independent from the Type column drop-down beside
the dimension. There must be at least one independent dimension for a valid NDD setup.

6. Select the Valid Root Symbols for the Independent dimension(s). Either enter the symbol name or
click the symbol selector button ( ... ) and use the symbol selection dialog to select a symbol.

7. Select the dimension(s) that you want to be Dependent from the Type column drop-down beside
the dimension. There must be at least one Dependent dimension for a valid NDD setup.
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8. Select the Valid Root Symbols for each Dependent dimension. Either enter the symbol name or
click the symbol selector button ( ... ) and use the symbol selection dialog to select a symbol.

9. Select the Dependent Default Symbols for each Dependent dimension. Either enter the symbol
name or click the symbol selector button ( ... ) and use the symbol selection dialog to select a
symbol.

10. Select the Dependent Modulating Symbols for each Dependent dimension. Either enter the
symbol name or click the symbol selector button ( ... ) and use the symbol selection dialog to select
a symbol.
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11. For every other dimension that is not Independent or Dependent, select Other as the type, and
select the Valid Root Symbols for those dimensions.

12. Once you have finished selecting types for all dimensions and assigning symbols to them (fields are
highlighted yellow to indicate that they must be completed before you can finish the NDD setup), the
OK button becomes available. Click OK. Your NDD settings are updated in the system.

Note: If you manually enter the symbol name for the last field to be completed, you must
press Enter before the OK button becomes available.
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Setting up or modifying the NDD Pattern Table
The NDD pattern table displays each dimension specified in your system’s NDD setup.

To set up or modify the NDD Pattern Table, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > NDD Pattern Table Setup. The Pattern Table Setup dialog displays, as shown
below:
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3. For each dimension, follow these steps:

a. Click the symbol selector button ( ... ) associated with the dimension’s root symbol. A symbol
selection dialog displays, as shown below:

b. Select the symbol you want to serve as the root symbol for that dimension or click the Search
icon at the top of the dialog to locate and select the symbol.

Note: If the symbol you want to select is not one of the actual root symbols, expand
the hierarchies to access symbols deeper in the hierarchy. To search for a symbol,
click the Search icon at the top of the dialog, enter a search string in either the name
or description and click OK. The first matching instance will be shown in the dialog.
To find subsequent instances, click the Search Again icon, which is represented by
binoculars with a plus symbol.

4. When you have finished selecting symbols, click OK.

Specifying Event rule settings
You can specify event rule settings that determine the merging of events and their dependencies in your
system. You can also specify event rules as persistent to improve system performance. Event rule
dependencies apply only if you are using event sequencing.

For more information on event sequencing, see Configuring Event Timing.

For more information, see:

n Specifying Event Rule Merge Settings

n Specifying Event Rule Dependencies

n Specifying Persistent Event Rules

n Specifying Parallel Event Rules
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Specifying Event rule merge settings
You may have event rules that trigger the exact same process based on different circumstances. If this
is the case, you can consider merging these rules so that they don’t trigger the process multiple times
unnecessarily.

Caution: If you have purchased Tax Provision, your system is preconfigured with event rule
merge settings for optimal performance. Changing these settings may have undesirable
consequences.

For information on creating Event rules, see Creating rules.

To specify Event rule merge settings:

1. Open Longview Application Administrator.

2. Select Tools > Event Rule Merging Setup. The Event Rule Merging Setup dialog opens.

3. Specify a comma-delimited list of IDs, per line, of the Event rules that run the same process. For
example:

30054,30058,30061

20063,20067,20068,20069

69952,69953,69954

4. When you are finished, click OK.

Specifying Event rule dependencies
If your system includes a rule that always triggers another rule, you can specify this dependency so that
if those two rules are triggered simultaneously, the system waits for the preceding rule to finish before it
allows the dependent rule to process, which uses system resources more efficiently.

Caution: If you have purchased Tax Provision, your system is preconfigured with event rule
dependencies for optimal performance. Changing these dependencies may have undesirable
consequences.

To specify Event rule dependencies:

1. Open Longview Application Administrator.

2. Select Tools > Event Rule Dependency Setup. The Event Rule Dependency Setup dialog opens.

3. On each line, specify the Event rule ID of the event that triggers a dependent rule, followed by the ID
of the dependent rule, separated by a comma. For example:

30124,30125

20234,20236
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69850,69950

4. When you are finished, click OK.

Specifying Persistent Event rules
Whenever an event rule is triggered in your system, an Application Framework process is launched to
handle the event. If you have event rules that are triggered frequently, you can specify these events as
persistent. A single Management Server process is launched to handle persistent events in the following
scenarios:

n When the server is started

n If maintenance is turned off

n If application framework is disconnected and a persistent event rule is triggered

The Management Server process remains in the system until the data server is shut down, to handle
each successive triggering of the persistent event. This improves performance, as Application
Framework is not initialized each time the event rule is triggered. All event rules in Longview Tax are
persistent by default.

Specifying event rules as persistent increases memory consumption on the data server. If you do not
allocate enough memory, specifying event rules as persistent may cause your system performance to
degrade instead of improving.

If you do not want to use this feature, set the Maximum Persistent Event Rules server configuration
parameter to 0. Persistent event rules are also impacted by the setting for the Server Timeout server
configuration parameter. For more information on setting server configuration parameters, see the
Longview Server Manager Guide.

Caution: Do not specify event rules that turn Maintenance On and Off in Application
Framework as persistent. If you do so, the data server will return an error.

System variables are used to set up procedures for use with persistent event rules.

For more information, see Working with System Variables for Persistent Event Rules.

To specify persistent Event rules:

1. Open Longview Application Administrator

2. Select Tools > Persistent Event Rule Setup. The Persistent Event Rule Setup dialog opens.

3. Enter the Event rule IDs of events to specify as persistent, one rule ID per line. For example:

30066
20089
69971
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When Event rule IDs are specified in this dialog, a corresponding rulepersists.txt file is created in the
data server working directory (for example, C:\Longview\DataServers\LongviewCPM). You
can also specify event rules as persistent or not persistent by adding or removing them respectively,
from this text file.

If you make any changes to the list of persistent event rules (in either the Persistent Event Rule
Setup dialog, or the rulepersists.txt file) or the name of the procedure launched by the
persistent event rules, you must restart the servers for your changes to take effect.

Note: Multiple persistent event rules that use the same event procedure are handled by
the same Management Server process.

4. When you are finished, click OK.

5. If you want to organize persistent event rules into groups in separate files, you can create additional
persistent event rule text files in the data server working directory. Persistent event rule files must
adhere to the following naming convention:

rulepersistsFileName.txt

In the text file, enter the Event rule IDs of additional persistent events, one rule ID per line.

If you are working in Longview Tax, the following persistent event rule text files are preconfigured:

l RulePersists_ASC.txt

l RulePersists_Common.txt

l RulePersists_IAS.txt

Do not add any persistent event rules to these files. If you want to specify additional event rules as
persistent in Longview Tax, specify them in the Persistent Event Rule Setup dialog, or the
rulepersists.txt file.

Note: When you create additional persistent event rule text files or edit existing text files,
you must restart the servers for your changes to take effect.

Specifying Parallel Event rules
If your system includes a rule that runs on multiple symbols in a dimension, you can specify this rule to
run in parallel. The system will trigger the rule to run at the same time for each independent intersection
instead of running one intersection at a time. In addition, each time a specific rule is triggered it will fire
immediately. This may allow the event to complete more efficiently, depending on the nature of the
calculations. An event rule can be set to run up to 32 events in parallel. If 0 or 1 is specified, then the rule
will not run in parallel. If the maximum number of parallel events have been fired, subsequent instances
of the same even will be held as pending until at least one of the parallel instances complete. Each of
these subsequent instances will be fired independently.
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Caution:
A persistent event rule will be ignored as persistent if the event rule is also defined as a
parallel event.
Parallel event rules cannot be merged. Any event rules that are merged and are defined as a
parallel event, will be ignored as parallel events.
It is not recommended to set parallel event rules to be dependent on other event rules. If a
parallel event rule is set to be dependent on another rule the dependent setting will be
ignored.

To specify Parallel Event rules:

1. Open Longview Application Administrator.

2. Select Tools > Parallel Event Rule Setup. The Parallel Event Rules Setup dialog opens.

3. On each line, specify the Event rule ID of the event that you want to run in parallel, followed by the
maximum number of parallel events you want to run for the specified event, separated by a comma.
Valid values for the maximum number of parallel events are 0-32, where 0 will not run the event in
parallel. For example:

30124,3
20234,0
69850,32

4. When you are finished, click OK.

Working with intercompany eliminations
Eliminations occur when intercompany transactions such as loans, investments, sales and so on,
between the parent and subsidiary organizations, are automatically deducted from the consolidated
balance sheet and the consolidated income statement. Intercompany accounts are recognized, and
automatic journal entries are posted to these accounts. Data is imported into the General Ledger
through a bridge so when an intercompany transaction is detected, it automatically creates journal
entries at the intersection of an elimination account and elimination entity.

For example, if operations in Toronto were to have a receivable from operations in Dallas, there would
be two entries in the General Ledger for this transaction — an intercompany accounts payable entry for
Dallas, and an intercompany accounts receivable entry for Toronto.

Setting up a New Standard Elimination
To set up a new standard intercompany elimination, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Intercompany Eliminations. A list of the eliminations currently
on the server appears in the Contents window.

3. Right-click anywhere in the Contents window and select New Standard Elimination. The New
Standard Elimination dialog opens.
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4. Enter a name and description for the new elimination, and select the Offset tab.

5. Type the name of the offset account or click the symbol selector button ( ... ) to choose the offset
account.

6. Click OK once you have selected the account from the selection dialog.

7. Select the Accounts tab.

8. Use the Schedule drop-down list to select the schedule holding intercompany transactions for your
account.

9. Click Add to define an account for the elimination. The Add Account dialog opens.
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10. Do one of the following:

l Type an account name.

l Use the symbol selector button ( ... ) to open the selection dialog and choose an account. Click
OK once you have selected the account.

11. Repeat step 9 for the Reporter and Contra fields.

12. Click Finish. The Add Account dialog closes.

13. When you have finished defining accounts for the elimination, click OK. The new elimination
appears in the list of eliminations.

Setting up a New Investment Elimination
To set up a new investment elimination, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Intercompany Eliminations. A list of the eliminations currently
on the server appears in the Contents window.

3. Right-click anywhere in the Contents window and select New Investment Elimination. The New
Investment Elimination dialog opens.

4. Enter a name and description for the new elimination.

5. Select the Offset tab.

6. Do one of the following:

l Type an account name.

l Use the symbol selector button ( ... ) to open the selection dialog and choose an account. Click
OK once you have selected the account.
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7. Select the Capital Accounts tab.

8. Use the Schedule drop-down list to select the schedule holding intercompany transactions for your
account.

9. Click Add to define an account for the elimination. The Add Account dialog opens.

10. Do one of the following:

l Type an account name.

l Use the symbol selector button ( ... ) to open the selection dialog and choose an account. Click
OK once you have selected the account.

11. Repeat step 10 for the Reporter and Contra fields.

12. Use the radio buttons to select the Ownership Percentage Method:

l Default

l Manual Input

13. Click Finish once you have finished with these selections.

14. Select the Investment Accounts tab.

15. Use the schedule drop-down list to select the schedule holding intercompany transactions for your
account.
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16. Click Add to define an account for the elimination. The Add Investment Account dialog opens.

17. Do one of the following:

l Type an account name.

l Use the symbol selector button ( ... ) to open the selection dialog and choose an account. Click
OK once you have selected the account.

18. Repeat step 17 for the Ownership, Reporter, and Contra fields.

19. Click Finish. The Add Investment Account dialog closes.

20. When you have finished defining accounts for the elimination, click OK. The new elimination
appears in the list of eliminations.

Editing an intercompany elimination
To make changes to an existing intercompany elimination, follow these steps.

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Intercompany Eliminations. A list of the Intercompany
Eliminations currently on the server appears in the Contents window.

3. Right-click the elimination you want to modify and select Properties. The Properties dialog opens
for the selected elimination.

4. Make your changes as needed and click OK.

https://insightsoftware.com/


52

Working With Attributes
An attribute is data used to describe the characteristics of an object in the application. For example,
SGPCompanyName is an attribute representing the name of your company, and its value is your
company name.

You can filter a list of symbols based on their attribute values in a Model or Dataspec Document. You
can filter symbols in several ways, depending on whether you want root symbols, leaf symbols,
descendants, and so on.

Understanding attribute classes
There are several attribute classes:

Attribute

class
Description

SYSTEM

(S)

Describes the entire system at the highest level. Attributes in this attribute class specify

system-wide characteristics. There is only one object in the SYSTEM attribute class — the

application itself.

USER (U)
Describes the attributes of a particular user. Each user is an object in the USER attribute

class.

SYMBOL

(Z)

Describes the characteristics of individual symbols. Each symbol is an object in the

SYMBOL attribute class.

Understanding attribute types
For each attribute class, an attribute describes some aspect of it. When these attributes are created, you
must specify what type of data values may be specified for them.

Attribute type Syntax

Date Date

List of Dates DateList

Double Double

List of Doubles DoubleList

Integer Integer

List of Integers IntegerList

String String
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Attribute type Syntax

List of Strings StringList

Symbol Symbol

List of Symbols SymbolList

Working with attribute commands and
functions
To work with attributes in Application Framework, you need to understand how to use the following
commands:

n Append Attribute

n Create Attribute

n Delete Attribute

n Refresh Attribute

n Set Attribute

You also need to understand how to use the following functions:

n AttributeExists

n AttributeFilter

n CreateList

For more information, see the Longview Developer’s Guide.

Working with Symbol attributes
Symbol attributes (prefixed with Z) are attributes that specify characteristics of individual symbols. You
can set values for these attributes to configure symbols in your Longview system.

Understanding attribute names and parameters
The following tables contain lists of attribute names and default parameters, classified by type
(SYSTEM, USER, or SYMBOL).

For more information on lists of attribute names and default parameters, see

n System attribute names and parameters

n User attribute names and parameters

n Symbol attribute names and parameters
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System attribute names and parameters

Attribute

Name
SAccessToken

Attribute

Description

Access Token

Stores the access token for OBDF authentication. This attribute type ensures the
password is not exposed through the application interface.

Attribute

type
Password

Default

value

Attribute

Name
SDataAreaStatusHierarchies

Attribute

Description

List of symbols displayed in the drop-down list and Symbol Selector in the Events Status

tool. For more information, see Specifying the Symbols Displayed in the Events Status

Tool.

Attribute

type
List of Strings

Default

value

Longview Dashboard — No default value

Longview Tax — TENTITIES#99| PSHIP#99|Juris dictions#99|En titiesHier1#99|
EntitiesHier2#99|EntitiesHier3 #99|EntitiesHie r4#99|EntitiesHier5#99

Attribute Name SElimAccountsCapital

Attribute Description List of Capital Accounts

Attribute type List of Symbols

Default value UNUSED

Attribute Name SElimAccountsInvestment

Attribute Description List of Investment Accounts

Attribute type List of Symbols

Default value UNUSED
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Attribute Name SElimAccountsOwnership

Attribute Description List of Ownership Accounts for Eliminations

Attribute type List of Symbols

Default value UNUSED

Attribute Name SElimInvestmentCurrency

Attribute Description Common Currency for Investment Elimination Percentage Calculation

Attribute type Symbol

Default value UNUSED

Attribute Name SFXAccountsBalanceSheet

Attribute Description List of Balance Sheet Accounts

Attribute type List of Symbols

Default value UNUSED

Attribute Name SFXAccountsRoundingError

Attribute Description Foreign Exchange Rounding Difference Account

Attribute type Symbol

Default value

Attribute Name SFXAllowMonetaryCTAA

Attribute Description Allow Monetary Accounts to Generate Specific CTA

Attribute type String

Default value FALSE

Attribute Name SFXElim

Attribute Description Translate Eliminations

Attribute type String

Default value FALSE

Attribute Name SFXJE

Attribute Description Translate Journal Entry Details

Attribute type String

Default value FALSE
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Attribute Name SFXGlobalRateDimensions

Attribute Description Additional Global Rate Dimensions

Attribute type List of Strings

Default value

Attribute Name SFXMethods

Attribute Description List of Translation Methods

Attribute type Symbol

Default value FXMethods

Attribute Name SFXOverrideRateDimensions

Attribute Description Additional Override Rate Dimensions

Attribute type List of Strings

Default value

Attribute Name SFXPeriodEndRate

Attribute Description Period End Rate Symbol

Attribute type Symbol

Default value FXRate_PeriodEnd

Attribute Name SFXRates

Attribute Description List of Foreign Exchange Rates

Attribute type Symbol

Default value FXRates

Attribute Name SFXSchedule

Attribute Description Translate Schedule Data

Attribute type String

Default value FALSE

Attribute Name SFXTimePeriodsSymbols

Attribute Description List of Time Period Symbols to Translate

Attribute type List of Symbols

Default value
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Attribute Name SFXTranslationAdj

Attribute Description Calculate Detailed Translation Gain/Loss

Attribute type String

Default value FALSE

Attribute Name SFXTranslations

Attribute Description List of Currency Translations

Attribute type Symbol

Default value FXTranslations

Attribute Name SGPAccountsDimension

Attribute Description Name of the Accounts Dimension

Attribute type String

Default value ACCOUNTS

Attribute Name SGPBudgetPeriod

Attribute Description Current Budget Period

Attribute type Symbol

Default value

Attribute Name SGPCompanyName

Attribute Description
Company Name

(This attribute must be set if the SPrivacyPolicyURLCustom attribute is set.)

Attribute type String

Default value

Attribute Name SGPCurrencyDimension

Attribute Description Name of the Currency Dimension

Attribute type String

Default value CURRENCY

Attribute Name SGPCurrencySymbol

Attribute Description Currencies Root Symbol

Attribute type Symbol

Default value
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Attribute Name SGPCurrentPeriod

Attribute Description Current Period

Attribute type Symbol

Default value

Attribute Name SGPCurrentYear

Attribute Description Current Year

Attribute type Symbol

Default value

Attribute

Name
SGPD0AttrSym - SGPD15AttrSym

Attribute
description

Symbol Attributes used for Attribute-driven <Dimension N> Symbol Selections, where N
is a dimension number from 0 through 15.

Attribute type List of Strings

Default value

Attribute

Name
SGPD0AttrSys - SGPD15AttrSys

Attribute
Description

System Attributes used for Attribute-driven <Dimension N> Symbol Selections, where N
is a dimension number from 0 through 15.

Attribute type List of Strings

Default value

Attribute

Name
SGPD0AttrUser - SGPD15AttrUser

Attribute
Description

User Attributes used for Attribute-driven <Dimension N> Symbol Selections, where N is
a dimension number from 0 through 15.

Attribute type List of Strings

Default value

Attribute Name SGPDecimals

Attribute Description Number of Decimals to round parent data in queries

Attribute type Integer

Default value 10
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Attribute Name SGPDecimalsLeaf

Attribute Description Number of decimals to round leaf data in queries

Attribute type Integer

Default value 10

Attribute Name SGPDecimalsSubmissions

Attribute Description Number of decimals to round data in submissions

Attribute type Integer

Default value 10

Attribute Name SGPDecimialsZero

Attribute
Description

Number of decimals to consider for determining values of zero when querying and
submitting data.

Attribute type Integer

Default value 0

Note: A value of SGPDecimalsZero is only meaningful if it is less than the value of
SGPDecimals / SGPDecimalsLeaf / SGPDecimalsSubmissions.

Attribute Name SGPDimensionDefaults

Attribute Description List of Default Symbols

Attribute type List of Symbols

Default value

Attribute Name SGPEntitiesDimension

Attribute Description Name of the Entities Dimension

Attribute type String

Default value ENTITIES

Attribute Name SGPFloatingTimePeriods

Attribute Description System Attributes used as Time Period Symbols in Templates

Attribute type List of Strings

Default value

Attribute Name SGPForecastActualPeriods

Attribute Description List of Forecast Actual Symbols
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Attribute Name SGPForecastActualPeriods

Attribute type List of Symbols

Default value

Attribute Name SGPForecastPeriods

Attribute Description List of Forecast Symbols

Attribute type List of Symbols

Default value

Attribute Name SGPForecastPeriod

Attribute Description Current Forecast Period

Attribute type Symbol

Default value

Attribute Name SGPMaxDims

Attribute Description Maximum Number of Dimensions

Attribute type Integer

Default value 16

Attribute Name SGPSchedAttrSym

Attribute
Description

Symbol Attributes used for Attribute-driven Schedule Dimension Symbol
Selections

Attribute type List of Strings

Default value

Attribute Name SGPSchedAttrSys

Attribute
Description

System Attributes used for Attribute-driven Schedule Dimension Symbol
Selections

Attribute type List of Strings

Default value

Attribute Name SGPSchedAttrUser

Attribute Description User Attributes used for Attribute-driven Schedule Dimension Symbol Selections

Attribute type List of Strings

Default value
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Attribute

Name
SGPSubmissionRules

Attribute
Description

Duplicate data handling for submissions for cells calculated by a model rule. For more
information, see Specifying duplicate data handling for submissions.

Attribute
type

String

Default
value

OFF

Attribute Name SGPTBAccount

Attribute Description Trial Balance Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTBAssetsAccount

Attribute Description Total Assets Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTBCompIncomeAccount

Attribute Description Comprehensive Income Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTBEBITAccount

Attribute Description Earnings Before Interest & Taxes Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTBLiabEquityAccount

Attribute Description Total Liabilities & S/H Equity Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTBNetIncomeAccount

Attribute Description Net Income Account Symbol
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Attribute Name SGPTBNetIncomeAccount

Attribute type Symbol

Default value

Attribute Name SGPTBOperatingProfitAccount

Attribute Description Operating Profit Account Symbol

Attribute type Symbol

Default value

Attribute Name SGPTimePeriodsActivity

Attribute Description List of Period Activity Time Periods

Attribute type List of Symbols

Default value

Attribute Name SGPTimePeriodsDimension

Attribute Description Name of the Time Period Dimension

Attribute type String

Default value TIMEPER

Attribute Name SGPTimePeriodsYTD

Attribute Description List of Year-to-Date Time Periods

Attribute type List of Symbols

Default value

Attribute Name SJEApplicationIDEditable

Attribute Description Allow the Journal Entry Application ID to be Modified?

Attribute type String

Default value FALSE

Attribute Name SJED0Default - SJED15Default

Attribute
Description

<Dimension N> Default Journal Entry Symbol, where N is a dimension number from
0 through 15.

Attribute type Symbol

Default value DIMNSET, where N is a dimension number from 0 through 15
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Attribute Name SJED0Symbols - SJED15Symbols

Attribute
Description

List of Valid <Dimension N> Symbols for Journal Entries, where N is a dimension
number from 0 through 15.

Attribute type List of Symbols

Default value DIMNSET, where N is a dimension number from 0 through 15

Attribute Name SPACPairs

Attribute Description List of PAC/YTD Pairs

Attribute type List of Strings

Default value

Attribute Name SPACSkipStaticSymbols

Attribute Description Ignore PAC/YTD calculations for non-account static symbols

Attribute type String

Default value FALSE

Attribute

Name
SPrivacyPolicyURLCustom

Attribute
Description

Link to a custom privacy policy URL.

The URL path specified must contain the http:// or https:// prefix. If this attribute value is
not defined, the custom privacy policy feature is disabled. If this attribute value is set, then
a link to the URL specified will appear in the Privacy Policy sections of Longview
Dashboard and the Longview Client. The SGPCompanyName attribute must also be set if
this attribute is set. The custom privacy policy link in the Longview Client will refer to the
company name set in the SGPCompanyName attribute.

Attribute
type

String

Default
value

Attribute

Name
SPrivacyPolicyURLLongview

Attribute
Description

Link to the Longview privacy policy URL.

The URL path specified must contain the http:// or https:// prefix. If this attribute value is
not defined, the Longview privacy policy feature is disabled. If this attribute value is set,
then a link to the URL specified will appear in the Privacy Policy sections of Longview
Dashboard and the Longview Client.

Attribute
type

String
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Attribute

Name
SPrivacyPolicyURLLongview

Default
value

Attribute Name SQuote

Attribute Description Quotation mark within Application Framework code.

Attribute type String

Default value “

Attribute Name SRECAccountsNetIncome

Attribute Description Net Income Account

Attribute type List of Symbols

Default value

Attribute

Name
SSMTPPassword

Attribute
Description

SMTP password

Stores the SMTP password for email server authentication. This attribute type ensures
the password is not exposed through the application interface.

Attribute
type

Password

Default
value

Attribute Name SSMTPServerHost

Attribute Description SMTP Server Host

Attribute type String

Default value

Attribute Name SSMTPServerPort

Attribute Description SMTP Server Port

Attribute type Integer

Default value
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Attribute Name SSMTPUserName

Attribute Description SMTP User Name

Attribute type String

Default value

Attribute Name STaxEntityAttributes

Attribute Description
Tax Entity Wizard Attributes

This attribute is currently not used.

Attribute type List of Strings

Default value

Attribute Name STaxEntityHierarchies

Attribute Description
Tax Entity Wizard Hierarchies

This attribute is currently not used.

Attribute type List of Strings

Default value

Attribute Name SWFAdminDesc

Attribute Description Workflow Administrator Description

Attribute type String

Default value

Attribute Name SWFAdminEMail

Attribute Description Workflow Administrator Email Address

Attribute type String

Default value

Attribute Name SWFAllowJE

Attribute Description Permit journal entries on submitted/invisible workflow areas

Attribute type String

Default value TRUE

Attribute Name SWFHierarchyStepApproveAll

Attribute Description Allow the owner to approve all areas in hierarchy step

Attribute type String

Default value FALSE
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Attribute Name SWFLockScheduleData

Attribute Description Lock Schedule data in Workflow processes

Attribute type String

Default value TRUE

Attribute Name SWFLogDataChanges

Attribute Description Enable Log of Data Changes (Workflow)

Attribute type String

Default value FALSE

Attribute Name SWFUseCertification

Attribute
Description

Specifies whether certification is available for approval processes in Longview
Workflow.

For more information, see Specifying certification for approval processes.

Attribute type String

Default value FALSE

Attribute

Name
SWFUseGlobalVisibility

Attribute
Description

This attribute applies only if SWFUseVisibility is set to TRUE. Specifies whether
DataAreas outside of the DataAreas specified for all approval processes are visible.

For more information, see Specifying visibility for DataAreas outside of approval
processes.

Attribute
type

String

Default
value

TRUE

Attribute

Name
SWFUseTimePeriodVisibility

Attribute
Description

This attribute applies only if SWFUseVisibility is set to TRUE. Specifies whether the
visibility settings of DataAreas for parent symbols in the time periods dimension (as
specified by SGPTimePeriods) are affected when the DataAreas for leaf symbols in the
time periods dimension are set to invisible.

For more information, see Specifying parent symbol visibility in the time periods
dimension.

Attribute
type

String
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Attribute

Name
SWFUseTimePeriodVisibility

Default
value

FALSE

Attribute Name SWFUseVisibility

Attribute
Description

Specifies whether data visibility options are available for approval processes in
LongviewWorkflow.

For more information, see Specifying data visibility options for approval processes.

Attribute type String

Default value FALSE

User attribute names and parameters

Attribute Name UAccSchedules

Attribute Description Users Accessible Schedules

Attribute type
List of Strings

Set to “ALL” to grant access to all schedules.

Default value

Attribute

Name
UD0InputDefault - UD15InputDefault

Attribute
Description

<Dimension N> Default Symbol for Data Input, where N is a dimension number from 0
through 15.This attribute applies to Longview Tax only.

Attribute
type

Symbol

Default
value

Attribute

Name
UD0QueryDefault - UD15QueryDefault

Attribute
Description

<Dimension N> Default Symbol for Data Queries, where N is a dimension number from 0
through 15. This attribute applies to Longview Tax only.

Attribute
type

Symbol

Default
value
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Attribute Name UGPCurrentGroup

Attribute
Description

Users Current Group

Note: The attribute value is set by the system when a user connects to
the system.

Attribute type String

Default value NONE

Attribute Name UGPD0InputDefault - UGPD15InputDefault

Attribute
Description

<Dimension N> Default Symbol for Data Input, where N is a dimension number from
0 through 15.

Attribute type Symbol

Default value

Attribute Name UGPD0QueryDefault - UGPD15QueryDefault

Attribute
Description

<Dimension N> Default Symbol for Data Queries, where N is a dimension number
from 0 through 15.

Attribute type Symbol

Default value

Attribute Name UJavaHome

Attribute Description JRE Install folder for Java components launched via Component Launcher.

Attribute type String

Default value

Attribute Name UJavaInitialHeapSize

Attribute
Description

Initial Heap Size (Mb) for Longview Java components launched via Component
Launcher.

Attribute type Integer

Default value 32

Attribute Name UJavaMaxHeapSize

Attribute
Description

Maximum Heap Size (Mb) for Longview Java components launched via Component
Launcher.

Attribute type Integer

Default value 1024
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Attribute Name UWebMaximumColumns

Attribute Description Maximum Number of Columns Rendered in Web   Browser

Attribute type Double

Default value 10000

Attribute Name UWebMaximumRows

Attribute Description Maximum Number of Rows Rendered in Web Browser

Attribute type Double

Default value 10000

Attribute Name UWebTheme

Attribute Description Web Application Theme

Attribute type String

Default value Longview Default Theme

Symbol attribute names and parameters

Attribute Name ZElimAccountsOffset

Attribute Description Offset Account

Attribute type Symbol

Default value

Attribute Name ZElimAllowICTransactions

Attribute Description Allow Intercompany Transactions to be Recorded Against this Entity?

Attribute type String

Default value FALSE

Attribute Name ZElimContra

Attribute Description List of Hierarchies to Eliminate this Account at the Contra's Parent

Attribute type List of Symbols

Default value

Attribute Name ZElimEntity

Attribute Description List of Hierarchies to Eliminate this Account at the Contra's Parent

Attribute type Symbol

Default value
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Attribute Name ZElimEquivalentCurrency

Attribute Description List of Equivalent Currencies

Attribute type List of Symbols

Default value

Attribute Name ZElimICSchCapital

Attribute Description Name of Schedule Holding Capital Amounts

Attribute type String

Default value

Attribute Name ZElimICSchTransactions

Attribute Description Name of Schedule Holding Intercompany Transactions

Attribute type String

Default value

Attribute Name ZElimInvestmentOwnershipAccount

Attribute Description Investment Ownership Percentage Account

Attribute type Symbol

Default value

Attribute Name ZElimInvestmentOwnershipMethod

Attribute Description Basis for Determining Capital Amount

Attribute type String

Default value

Attribute Name ZElimReporter

Attribute Description List of Hierarchies to Eliminate this Account at the Reporter's Parent

Attribute type List of Symbols

Default value

Attribute Name ZFXAccountsCTA

Attribute Description Cumulative Translation Adjustment Account

Attribute type Symbol

Default value
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Attribute Name ZFXAccountsTA

Attribute Description Translation Adjustment Account

Attribute type Symbol

Default value

Attribute Name ZFXAccountType

Attribute
Description

Foreign Exchange Account Type. For more information, see Specifying foreign
exchange account type.

Attribute type String

Default value Monetary

Attribute Name ZFXEntityIndicator

Attribute Description Entity is Translated by Foreign Exchange?

Attribute type String

Default value FALSE

Attribute Name ZFXOperationsType

Attribute
Description

Translation Method Operations Type. For more information, see Understanding
Operations Type.

Attribute type String

Default value

Attribute Name ZFXOverrideRates

Attribute Description Override Currency Translations to Use for Each Source Currency

Attribute type List of Symbols

Default value

Attribute Name ZFXR_CrossValidations

Attribute Description This attribute is currently not used.

Attribute type List of Strings

Default value

Attribute Name ZFXR_DetailsDimension

Attribute Description This attribute is currently not used.

Attribute type String

Default value
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Attribute Name ZFXR_DetailsValidation

Attribute Description This attribute is currently not used.

Attribute type List of Symbols

Default value

Attribute Name ZFXR_ReportingPeriod

Attribute Description This attribute is currently not used.

Attribute type Symbol

Default value

Attribute Name ZFXR_ReportingPeriodDetails

Attribute Description This attribute is currently not used.

Attribute type List of Symbols

Default value

Attribute Name ZFXR_ScalingFactor

Attribute Description This attribute is currently not used.

Attribute type String

Default value

Attribute Name ZFXR_ScalingFactorDecimals

Attribute Description This attribute is currently not used.

Attribute type Integer

Default value 0

Attribute Name ZFXR_ScalingFactors

Attribute Description This attribute is currently not used.

Attribute type List of Symbols

Default value

Attribute Name ZFXR_Source

Attribute Description This attribute is currently not used.

Attribute type List of Strings

Default value
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Attribute Name ZFXRateType

Attribute Description Translation Rate Type

Attribute type String

Default value

Attribute Name ZFXRoundPrecision

Attribute Description Translation Rounding Precision

Attribute type Integer

Default value 99

Attribute Name ZFXSourceCurrencies

Attribute Description List of Source Currencies

Attribute type List of Symbols

Default value

Attribute Name ZFXTimePeriodsOpen

Attribute Description List of Time Periods Related to Open Period

Attribute type List of Symbols

Default value

Attribute Name ZFXTranslations

Attribute Description Currency Translation to Use for Each Source Currency

Attribute type List of Symbols

Default value

Attribute Name ZGPCalendarDate

Attribute Description Calendar Date

Attribute type Date

Default value
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Attribute

Name
ZGPCommentSymbol

Attribute
Description

Specifies that the Symbol should be treated as a Comment Symbol.

When symbols with this attribute set to TRUE are queried, for example, in Report Viewer,
Data Grids or Longview Analysis and Reporting, the comment schedule intersection will
be displayed instead of the base data point. This feature can be used to display variance
commentary in a side-by-side format.

Note: Symbols with this attribute set to TRUE must be STATIC symbols.

Attribute
type

String

Default
value

FALSE

Attribute Name ZGPLineItemDetailReference

Attribute Description Line-Item Detail

Attribute type Symbol

Default value

Attribute Name ZGPNativeCurrency

Attribute Description Native (Functional) Currency

Attribute type Symbol

Default value

Attribute Name ZHierarchyDescription

Attribute Description Override the root symbol display description

Attribute type String

Default value

Attribute Name ZHierarchyName

Attribute Description Override the root symbol display name

Attribute type String

Default value

Attribute Name ZKPIDescription

Attribute Description This attribute is currently not used.

Attribute type String
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Attribute Name ZKPIDescription

Default value

Attribute Name ZKPIFormula

Attribute Description This attribute is currently not used.

Attribute type String

Default value

Attribute Name ZKPIReportLink

Attribute Description This attribute is currently not used.

Attribute type String

Default value

Attribute Name ZKPIVariancePositive

Attribute Description This attribute is currently not used.

Attribute type String

Default value +

Attribute Name ZKPIVarianceTolerance

Attribute Description This attribute is currently not used.

Attribute type Double

Default value 0

Attribute Name ZLIDCommentsSymbol

Attribute Description LID - Storage Symbol for Comments

Attribute type Symbol

Default value

Attribute Name ZRECAccountsRetained

Attribute Description Retained Earnings Income Account

Attribute type Symbol

Default value
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Attribute

Name
ZValidValues

Attribute
Description

List of Valid Values for Symbol

Renders this symbol as a drop list in a data view.

Use value1|value2 (displayed and stored value is the same) or
display1;value1|display2;value2 (displayed value and stored value is not the same)
stored value is always stored as a string.

Attribute
type

List of Strings

Default
value

Working with preconfigured System attributes
System attributes (prefixed with S) are preconfigured attributes that specify systemwide characteristics.
You can set values for these attributes to configure various functionalities and settings in your Longview
system.

This section contains information on these topics:

n Specifying the symbols displayed in the Events Status tool

n Specifying duplicate data handling for submissions

n Specifying System attributes for Longview Workflow

Specifying the symbols displayed in the Events
Status tool
The SDataAreaStatusHierarchies System attribute specifies the list of symbols displayed in the drop-
down list and Symbol Selector in the Events Status tool.

If no value is set for this attribute, all root symbols, and all levels of symbols below them in the data area
status dimension are displayed the drop-down list and Symbol Selector in the Events Status tool.

To specify the symbols displayed in the Events Status tool:

1. In the Server Explorer pane, expand Attributes and select SYSTEM.

2. In the Contents window, right-click SDataAreaStatusHierarchies, and select Set Value. The
Attribute Values dialog opens.

3. In the Values area, enter the symbol specification for the symbol or symbols to display in the Events
Status tool in Enter New Value.

For each symbol specification, specify a symbol name and the level of symbols below that symbol in the
hierarchy to display.

You can use the following symbol specifications:
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Specification Meaning

symbol### all leaf symbols under symbol

symbol#n all symbols under symbol n levels down, including symbol

symbol##n all parent symbols under symbol n levels down

symbol##+n all parent symbols under symbol n levels down, including symbol

Note: The specified symbols must be in the dimension specified for the Data Area Status
Dimension parameter in Longview Server Manager. For more information, see the Longview
Server Manager Guide.

The current list of symbol specifications for SDataAreaStatusHierarchies displays in Value List.

1. In the Values area, click Add to list.

2. Repeat step 3 and step 4 for each symbol specification that you want to include in the symbol list.

3. When you are finished adding symbol specifications, click Apply.

4. Click OK.

Specifying duplicate data handling for submissions
The SGPSubmissionRules System attribute specifies how duplicate data is handled for submissions for
cells calculated by a model rule.

To specify duplicate data handling for submissions:

1. In the Server Explorer pane, expand Attributes and select SYSTEM.

2. In the Contents window, right-click SGPSubmissionRules, and select Set Value. The Attribute
Values dialog opens.

3. In the Values area, specify a value for SGPSubmissionRules in Enter New Value. The current value
for SGPSubmissionRules displays in Value.

Possible values for SGPSubmissionRules include the following:

Value Description

OFF Duplicates are submitted. This is the default value.

FILTER
Non-duplicates are submitted. Duplicates are listed in a server output temp file named
username_sessionID_Duplicate.tmp.

Note: For journal entries, the duplicate coordinate check is performed during validation,
and therefore the system attribute for FILTER is handled in the same way as ERROR. The
JE validation will fail, and the user will see an error message.

4. In the Values area, click Assign to value.

5. Click Apply.

6. Click OK.
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Specifying System attributes for Longview Workflow
The following System attributes configure various functionalities and settings in Longview Workflow.

Specifying certification for approval processes
The SWFUseCertification System attribute specifies whether certification is available for approval
processes in Longview Workflow. For more information see the Workflow Designer Guide.

To specify certification for approval processes:

1. In the Server Explorer pane, expand Attributes and select SYSTEM. 

2. In the Contents window, right-click SWFUseCertification, and select Set Value. The Attribute Values
dialog opens.

3. In the Values area, specify a value for SWFUseCertification in Enter New Value. The current value
for SWFUseCertification displays in Value.

Possible values for SWFUseCertification include the following:

Value Description

TRUE

Certification is available for approval processes in LongviewWorkflow.

If this attribute is set to TRUE, the Certify data field displays in the Approval Process
wizard in LongviewWorkflow Designer. If Certify data is selected, certification definitions
can be added to approval processes.

When users work with an approval process that has a certification definition in Longview
Workflow on the web, they can certify data in that approval process.

FALSE

Certification is unavailable for approval processes in LongviewWorkflow.

If this attribute is set to FALSE, the Certify data field does not display in the Approval
Process wizard in LongviewWorkflow Designer. Certification definitions cannot be added
to approval processes.

This is the default value.

4. In the Values area, click Assign to value.

5. Click Apply.

6. Click OK.

Specifying visibility for DataAreas outside of approval
processes
The SWFUseGlobalVisibility System attribute specifies whether DataAreas outside of the DataAreas
specified for all approval process are visible to users.

Note: This attribute applies only if SWFUseVisibility is set to TRUE. For more information, see
Specifying data visibility options for approval processes.

To specify visibility for DataAreas outside of approval processes:
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1. In the Server Explorer pane, expand Attributes and select SYSTEM.

2. In the Contents window, right-click SWFUseGlobalVisibility, and select Set Value. The Attribute
Values dialog opens.

3. In the Values area, specify a value for SWFUseGlobalVisibility in Enter New Value. The current
value for SWFUseGlobalVisibility displays in Value.

Possible values for SWFUseGlobalVisibility include the following:

Value Description

TRUE
All DataAreas outside of the DataAreas specified for all approval processes are visible to
users. This is the default value.

FALSE
All DataAreas outside of the DataAreas specified for all approval processes are not visible
to users.

4. In the Values area, click Assign to value.

5. Click Apply.

6. Click OK.

Specifying parent symbol visibility in the time periods
dimension
The SWFUseTimePeriodVisibility System attribute specifies whether the visibility settings of DataAreas
for parent symbols in the time periods dimension (as specified by the SGPTimePeriods System
attribute) are affected when the DataAreas for leaf symbols in the time periods dimension are set to
invisible, for all approval processes.

Note: This attribute applies only if SWFUseVisibility is set to TRUE. For more information, see
Specifying data visibility options for approval processes.

To specify parent symbol visibility in the time periods dimension:

1. In the Server Explorer pane, expand Attributes and select SYSTEM.

2. In the Contents window, right-click SWFUseTimePeriodVisibility, and select Set Value. The
Attribute Values dialog opens.

3. In the Values area, specify a value for SWFUseTimePeriodVisibility in Enter New Value. The
current value for SWFUseTimePeriodVisibility displays in Value.

Possible values for SWFUseTimePeriodVisibility include the following:

Value Description

TRUE
When the DataAreas for leaf symbols in the time periods dimension are set to invisible,
DataAreas for parent symbols in the time periods dimension are also set to invisible.

FALSE
When the DataAreas for leaf symbols in the time periods dimension are set to invisible,
the visibility of the DataAreas for parent symbols in the time periods dimension is
unaffected. This is the default value.
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4. In the Values area, click Assign to value.

5. Click Apply.

6. Click OK.

Specifying data visibility options for approval processes
The SWFUseVisibility System attribute specifies whether data visibility options are available for
approval processes in Longview Workflow.

To specify data visibility options:

1. In the Server Explorer pane, expand Attributes and select SYSTEM.

2. In the Contents window, right-click SWFUseVisibility, and select Set Value. The Attribute Values
dialog opens.

3. In the Values area, specify a value for SWFUseVisibility in Enter New Value. The current value for
SWFUseVisibility displays in Value.

Possible values for SWFUseVisibility include the following:

Value Description

TRUE

Data visibility options are available for approval processes in LongviewWorkflow.

If this attribute is set to TRUE, the Visible field displays in the Approval Process wizard in
LongviewWorkflow Designer. Owners and Approvers can modify data visibility when
working with approval processes in LongviewWorkflow on the web.

FALSE

Data visibility options are not available for approval processes in LongviewWorkflow.

If this attribute is set to FALSE, the Visible field does not display in the Approval Process
wizard in LongviewWorkflow Designer. Owners and Approvers cannot modify data
visibility when working with approval processes. This is the default value.

4. In the Values area, click Assign to value.

5. Click Apply.

6. Click OK.

Creating and modifying attributes
While the application has many preconfigured attributes, you may want to create new attributes of your
own. You may also want to set the value of an attribute for a given symbol. This section explains how to
perform these tasks.

Naming attributes
When you are creating attributes, you should consider certain naming conventions. At first glance, an
attribute name seems rather odd. In fact, however, the name is created to provide maximum information
about its purpose. For example, the SGPTimePerYTD attribute is a general SYSTEM attribute whose
purpose is to identify time period symbols containing year-to-date data values.

To create a valid attribute name, follow these guidelines:
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n Attribute names can contain only letters or numbers; they cannot contain spaces, punctuation,
or other special characters.

n Attribute names contain a maximum of 31 characters, consisting of the following parts:

Part Possible values Description

First character

n A — Application-specific
attribute, second character
defines type

n S — Core system attribute

n U — Core user attribute

n Z — Core symbol attribute

Identifies the basic
attribute category.

Second character (for
application-specific
attributes)

n S — SYSTEM attribute

n U — USER attribute

n Z — SYMBOL attribute

Identifies the attribute
class.

Remainder

For example: GPAccountDim — Name of
the dimension that contains account
symbols

ElimAcctInv — List of investment
accounts for intercompany eliminations

Provides a description of
the purpose of the
attribute.

Creating attributes
You can create an attribute in two ways: from the file menu, or by duplicating an existing attribute.

To create an attribute, follow these steps:

1. Open Longview Application Administrator.

2. Select File > New > Attribute. The New Attribute Definition dialog opens.

3. If necessary, select the attribute’s class from the drop-down list.

https://insightsoftware.com/


82

4. Enter a name for your attribute, following the conventions outlined in “Naming attributes”.

5. Enter a description for the attribute.

6. Use the radio buttons to designate if the attribute will accept a single value (Single), or a list of
values (List).

7. Select the attribute type from the drop-down list.

8. If you selected User as the attribute type, use the Access drop-down list to designate if the attribute
may be written to, or is to be read-only.

9. If necessary, enter the default value for the attribute.

10. Click OK. The new attribute appears in the list of attributes.

Duplicating attributes
To duplicate an attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes and select the attribute class containing the attribute
you want to duplicate. A list of all the attributes for the selected class appears in the Contents
window.

3. Right-click the attribute you want to duplicate and select Duplicate.

4. Enter a name for the new attribute.

5. Enter a description for the new attribute.

6. If necessary, provide a default value for the attribute.

7. Click OK. The new attribute appears in the list of attributes.
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Modifying attributes
Note: You can modify attributes that have been created by users in your system only. It is not
possible to modify core attributes.

To modify an attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes and select the attribute class containing the attribute
you want to modify. A list of all the attributes for the selected class appears in the Contents window.

3. Right-click the attribute you want to change and select Properties.

4. Edit the properties of the attribute as required.

Note: You can modify an attribute’s Name, Description, and Default value only.

5. Click OK. Your changes are saved.

Setting attribute values
To set the value of an attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes and select the attribute class containing the attribute
for which you want to set the value(s). A list of all the attributes for the selected class appears in the
Contents window.
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3. Right-click the attribute and select Set Value. The Attribute Values dialog opens.

4. Use Object Selection buttons to organize and find objects. The objects displayed are dependent on
the attribute class. By default, the objects are arranged in tree hierarchies, if the attribute class is
SYMBOL.

l To arrange them by name regardless of their place in the hierarchy, click the List View icon.

l To search for an object, click the Search button and enter search strings in the Name and/or
Description fields.

5. Select the type/Dimension that has the object or objects for which you want to set the value of the
attribute.

6. Select the appropriate check box for the objects that contain the attributes you want to set the
values for.

7. In the Values area, enter the value for the attribute for this object. Depending on the attribute type,
additional options may be available as follows:

l Symbol, SymbolList — Click the symbol selector ( ... ) button to bring up the symbol selector.

l Date, DateList — Click the combo box drop arrow to bring up the date selector.

8. Click Assign to value.

l Some attributes can assign a list of values. If this is the case with your attribute, you will see a
list box accompanied by three buttons (the up arrow, down arrow, and X). Enter as many
values as you need. You can order the list of values by selecting a value and clicking the up
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arrow to move it up in the list, and the down arrow to move it down. Clicking X deletes the
selected value.

9. When you have finished assigning the value or values, click Apply.

10. Click OK.

Deleting attributes
Note: You can delete attributes that have been created by users in your system only. It is not
possible to delete core attributes.

To delete an attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes and select the attribute class containing the attribute
you want to delete. A list for all the attributes for the selected class appears in the Contents window.

3. Right-click the attribute you want to delete and select Delete. A confirmation dialog appears.

Caution: If you delete an attribute, it cannot be recovered. To restore a deleted attribute to
the system, it must be recreated. Use this function with caution.

4. Click Yes. The attribute is deleted.
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Maintaining Longview Hierarchies
Hierarchy maintenance refers to the maintenance of symbols in your system; their creation and deletion,
the attributes and values assigned to them, and their relationships to one another. All these aspects of
hierarchy maintenance can be performed by users with the necessary permissions.

Working with dimensions
The database contains a wealth of information, divided into different categories. For example, some of
the information describes the accounts in your General Ledger, some the worldwide locations in which
your company does business, and so on.

In the database, each broad category of data is called a dimension. More specifically, a dimension is a
set of logically similar business elements, which provides a structural organization to analyze
information. You can have a maximum of 16 dimensions in the database.

Your database
In most Longview systems, the primary dimensions are ACCOUNTS, TIMEPER, and ENTITIES.
Sometimes the name of a dimension appears in a dialog illustrated in this documentation. For example,
almost all systems contain a CURRENCY dimension. However, if your company deals solely with one
currency, you may not have a CURRENCY dimension in your database.

Your system may also include a different number of dimensions. Our hypothetical database contains six
dimensions, but your company may have as many as sixteen.

As you view the illustrations and instructions in this documentation, remember that the names and
number of dimensions in your database may be different.

ACCOUNTS dimension
The ACCOUNTS dimension is organized, like all dimensions in the database, as a hierarchy, with inputs
rolling up to subtotals, and subtotals rolling up to totals. The account symbols in your database can also
be grouped together without a mathematical relationship.

The ACCOUNTS Dimension is the only dimension that uses the Balance Type field. Balance Types can
be Credit, Debit, or Neither. Neither is the default value. Once symbols are placed within the hierarchy
and become child symbols, the Balance Type has an impact on rollup weight and the ability to alter
those weights according to the following rules:

Parent Symbol

Child Symbol

Credit Debit Neither

Credit
+ weight

Not editable

- weight

Not editable

0 weight

Editable

Debit
- weight

Not editable

+ weight

Not editable

0 weight

Editable

Neither
0 weight

Not editable

0 weight

Not editable

0 weight

Editable
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Note: The only child symbol weights that are editable occur when the parent symbol’s balance
type is Neither. All other combinations cannot be altered.

Your system probably already contains most of the account symbols your company needs. You may
find, however, that you sometimes need to add a new account symbol to the system.

For general information on how to add, edit, or delete a symbol, see Managing Symbols.

For the ACCOUNTS dimension, the valid values for the Type field are the following:

Field Description

Standard
To make the symbol add up normally (for example, months adding to quarters adding to
years).

Static

Whenever it does not make sense to total a hierarchy’s values — for example, for price
symbols or headcounts. (The parent symbols of such symbols are used only to group
symbols, not to aggregate their values.) Static symbols do not roll up in any direction,
overriding any assigned weights.

Carry
forward

For balance sheet and cash flow account symbols.

TIMEPER/TIMEPERIODS dimension
During installation of the system, the TIMEPER dimension required by your company was configured for
you. The system keeps descriptions of time period symbols up to date automatically during period-end
rollovers. Unless you change the structure of the fiscal year, you do not need to edit this.

Once time period symbols have been configured, you rarely need to edit them. However, you may need
to do so if, for example, you need to create a new time period symbol, or if a time period symbol does not
appear in the right order.

For general information on how to add, edit, or delete a symbol, see Managing Symbols.

For the TIMEPER dimension, the valid values for the Type field are the following:

Field Description

Standard For most time period symbols.

Static
Whenever it does not make sense to total a hierarchy’s values. (The parent symbols of such
symbols are used only to group symbols, not to aggregate their values.) Static symbols do
not roll up in any direction, overriding any assigned weights.

Carry
forward

For the last month in a quarter, the last quarter in a year, and so on.

ENTITIES dimension
The ENTITIES dimension contains the world-wide locations in which your company conducts business.

Once entities are configured, you rarely need to edit them. However, if, for example, your company
expands and opens a new office, you need to create a new entity symbol.
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For general information on how to add, edit, or delete a symbol, see Managing Symbols.

For the ENTITIES dimension, the valid values for the Type field are the following:

Field Description

Standard For most entities symbols.

Static

Whenever it does not make sense to total a hierarchy’s values — for example, for regional
office locations. (The parent symbols of such symbols are used only to group symbols, not
to aggregate their values.) Static symbols do not roll up in any direction, overriding any
assigned weights.

CURRENCY/CURRENCIES dimension
The CURRENCY dimension contains symbols used in the data translation process (also known as
foreign exchange).

The CURRENCY dimension contains symbols representing the various currencies used by your
company (such as total U.S. dollars or total euro), and symbols representing various data translation
methods (such as Temporal or Current).

Almost all Longview systems contain a CURRENCY dimension. However, if your company deals solely
with one currency, you may not have a CURRENCY dimension in your database.

For general information on how to add, edit, or delete a symbol, see Managing Symbols.

For the CURRENCY dimension, the valid values for the Type field are the following:

Field Description

Standard For most currency symbols.

Static

Whenever it does not make sense to total a hierarchy’s values — for example, for translation
methods. The parent symbols of such symbols are used only to group symbols, not to
aggregate their values. Static symbols do not roll up in any direction, overriding any
assigned weights.

Working with symbols
A symbol is an object representing a single item in the database. Symbols have properties such as a
name, a description, a type, a weight, and others outlined in the table below.

Property Description

Created The date and time of the symbol’s creation.

Description This refers to a description of the symbol (in the system’s default language).

Modified The date and time that the symbol was most recently modified.

Name

The name of the symbol. The name can contain a maximum of 31 alphanumeric
characters and can also contain the period ( . ) and underscore ( _ ). The name can also
begin with a number or be entirely numeric. The symbol name must be unique in the
system.
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Property Description

Parent This displays the symbol’s parent symbol, if any.

Partition In systems with partitioning, this indicates in which partition the symbol resides.

Priority

Priority is a number that designates a symbol's position in the hierarchy relative to its
parent. Symbols are listed in order of ascending priority, with zeros falling at the bottom of
the list. A symbol can have multiple parents and a different priority relative to each parent.
Child symbols are sorted by priority only when the parent's Sort Option is set to Manually.
By default, priority is set to zero.

Receive
Rollups

This indicates whether values from child symbols roll up to this symbol.

Type This indicates whether the symbol is standard, static, or carry forward.

Virtual

This indicates whether the symbol, if a parent symbol, has been designated as a virtual
parent. Data for a virtual parent symbol does not get calculated by a partition recalculation
or an enterprise restatement, but rather when the data is queried, resulting in a major
improvement in database speed. Also, parent data is not stored in the database.

Weight
This indicates whether the symbol is added to its parent ( + ), subtracted from its parent ( -
), or has no mathematical effect on its parent at all ( 0 ).

These properties are displayed and managed on the Properties page.

Symbols exist in dimensions. Occasionally they stand alone, but usually they are grouped into
hierarchies with parent-child relationships, sometimes many levels deep to a maximum of 47 levels. The
symbol under which another is immediately grouped is called its parent, and those under which its
parent is grouped (if any and including the parent symbol itself) are called ancestors. A symbol
immediately under a parent symbol is called its child symbol; it, and any symbols grouped under it, are
called the parent's descendants. A symbol can have up to 99 parents.

The highest symbol in a particular hierarchy is referred to as a root symbol. A symbol that has no child
symbols, regardless of where it resides in a hierarchy, is called a leaf symbol. It is possible, even typical,
for a symbol to be both a parent and a child. The only limitations on these relationships are that, by
definition, no root symbol can be a child symbol, and no leaf symbol can be a parent symbol.

The hierarchical relationships of your symbols are displayed in the Contents window.
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Details
Information concerning a symbol's ancestors and statistics is displayed in the Details window in its two
tabs, Ancestors and Statistics.

Ancestors tab
The Ancestors tab enables you to quickly determine which symbols your selected Symbol is under all
the way back to the root symbol. This is particularly useful in a complex hierarchy.

Note: This function searches for ancestors of the current instance of the symbol only. If the
symbol belongs to more than one parent, only the current parent and ancestors are returned.

Statistics tab
The Statistics tab provides information about the number of data points of each data type the symbol
intersects with. To gather Statistics, you can use the Tools > Collect Statistics menu option.
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Searching for symbols
Many processes involving symbols require you to first locate and access them. In a dimension with
many symbols, selecting a particular symbol out of the entire hierarchy can be time consuming and
difficult. To make the process more direct, you can search for specific symbols using the Longview
Application Administrator interface.

To use search for a symbol, follow these steps:

1. Ensure that the following prerequisites are met:

l You must be logged into Longview Application Administrator.

l You must be connected to the server.

l You must have Symbols selected in the Server Explorer pane.

l You must have a symbol dimension selected either in the expanded Symbols hierarchy in the
Server Explorer pane or in the Contents window.

When these conditions are met, the search icon at the top of the interface becomes active. Click the
icon. The Search dialog opens.

2. Complete the following fields:
a. Name: This is the name of the symbol you are looking for. You can enter a full name, or a

partial name. The search function returns all results that include the string you enter.

https://insightsoftware.com/


92

b. Description: This is the description of the symbol you are looking for. You can enter a full
description, or just part of one. The search function returns all results that include the string
you enter.

l To run the search, go to step 5. However, if you would like to include additional search
parameters, continue to the next step.

3. Click Show Advanced. The Advanced Criteria section of the dialog opens, as shown below:

4. Complete the following fields:
a. Type: Use the drop-down list to select one of the following: All, Standard, Carry Forward,

Static.

b. Virtual Status: Use the drop-down list to select one of the following: All, Virtual, Non-Virtual.

c. Weight: Use the drop-down list to select one of the following: All, Positive, Zero, Negative.

d. Rollup Status: Use the drop-down list to select one of the following: All, Receive Rollups, No
Rollups.

e. Attribute: Select this to search for a symbol with a particular attribute.

f. = or <>: Specify an attribute value to include in, or exclude from, the search.

i. = (equals): Symbols with the specified attribute value are included in the search.

ii. <> (is not equal to): Symbols with the specified attribute value are excluded from the search.

g. Search: Specify the type of symbols to be returned from the search, using on of the following
options:

i. All: All symbols are returned in the search.

ii. Parent Symbols: Parent symbols only are returned in the search.
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iii. Leaf Symbols: Leaf symbols only are returned in the search.

5. To close the Advanced Criteria section, click Hide Advanced.

6. When you have completed entering your search criteria, click Find. The results of your search are
shown in the Search Results window, and any matching symbols visible in the Contents window are
highlighted.

Duplicating a hierarchy
In some cases (for example, when you are setting up a system), you may want to create a duplicate of
all symbols in an existing hierarchy. The most efficient way to do this is by using the duplicate hierarchy
functionality. Symbol properties and descriptions are duplicated by the duplicate hierarchy functionality,
but symbol access roles and attributes are not.

Note: No data is copied when you duplicate a hierarchy.

To duplicate a hierarchy, follow these steps.

1. Open Longview Application Administrator.

2. In the Server Explorer pane, navigate to Symbols and select it.

3. Select the dimension that contains the hierarchy you want to duplicate. Its root symbols are
displayed in the Contents window.

4. Right-click the symbol that you want to be the root symbol of the duplicate hierarchy and select
Duplicate Hierarchy. The Duplicate Hierarchy dialog opens.
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Note: Maintenance must be turned off before you can duplicate a hierarchy.

5. Complete the following fields:

a. Prefix: Enter the characters that you want to precede each symbol name in the duplicate
hierarchy. A preview of symbol names in the duplicate hierarchy appears in the Sample field.

Note: Either a Prefix or a Suffix must be set. You can also set both a Prefix and a
Suffix.

b. Suffix: Enter the characters that you want to follow each symbol name in the duplicate
hierarchy. A preview of symbol names in the duplicate hierarchy appears in the Sample field.

c. Parent symbol status: Choose from the following options:

i. Inherit current status: Select this option if you want parent symbols in the duplicate hierarchy to
keep the same status as the original symbols.

ii. Set all to virtual: Select this option if you want all parent symbols to be virtual in the duplicate
hierarchy.

6. Click Duplicate. A warning dialog opens.
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7. Click Yes. A progress dialog opens.

8. When the duplicate hierarchy process is complete, a confirmation dialog opens. Click Close.

Creating new symbols
You may need to add symbols to the system beyond those in the existing hierarchy. This section
explains how to create new symbols manually.

It is possible to add new symbols to the hierarchy of a dimension by means of importing three files (the
item file, the description file, and the parent-child file).

For information on how to format and import these files, see Preparing Import Files for Symbols.

To create a symbol, follow these steps:

1. Open Longview Application Administrator.

2. Navigate to, and select, the symbol you want to assign as the parent for your new symbol.

Note: To create a root symbol, ensure that no symbol is selected.
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3. Choose File > New > Symbol. The New Symbol dialog appears, like below:

4. If you are creating a new symbol directly from a parent symbol, proceed to step 5. If you are creating
a root symbol, use the Dimension drop-down list to select the dimension into which your new
symbol will be created.

5. For Name, type a name for the symbol. The name can contain a maximum of 31 alpha-numeric
characters, can contain periods ( . ) and underscores ( _ ) and can be entirely numeric. The name
must be unique in the system.

6. For Description, type a description for the symbol in the default system language. To enter
descriptions in alternate languages, click the alternate language description icon. The
Descriptions dialog appears, where you can enter descriptions for other languages enabled in your
system.
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7. For Type, select one of the following:

a. Standard: Use this option to make the symbol add up normally (for example, months adding to
quarters adding to years). Most symbols are standard type.

b. Static: Use this option when it does not make sense to total a hierarchy’s values — for
example, for price symbols or wage rates. (The parent symbols of such symbols are used only
to group symbols, not to aggregate their values.) Static symbols do not roll up in any direction,
overriding any assigned weights.

c. Carry forward: Use this option for balance sheet and cash flow account symbols.

Note: This is available only for the Accounts and Time dimensions.

Caution: If you do not select the proper type for the symbol you are creating, you may get
inaccurate results when the system calculates the data.

8. For Balance type, choose one of the following:

Field Description

Credit Select this if the symbol is a credit symbol.

Debit Select this if the symbol is a debit symbol.

Neither Select this if the symbol is neither a credit nor a debit symbol. This is the default setting.

Note: This is available only for the Accounts dimension. For more information on balance
types, see “ACCOUNTS dimension”.

9. For Status, select one of the following:

Field Description

Virtual

To designate a parent symbol as a virtual parent. Data for a virtual parent symbol does
not get calculated by a partition recalculation or an enterprise restatement, resulting in a
major improvement in database speed. The value for the virtual parent is not stored in
the database. Instead, the value for the parent is calculated on the server side when it is
queried.

Note: This field is available only when the symbol is a parent symbol.

Receive
Rollups

To prevent a parent symbol from receiving rollup data from a child symbol. For example,
if users need to submit monthly information and have it roll up to quarters but not the
year, you can turn rollup off for the year symbol and save time during submission. After
users have submitted all data, and before you perform an enterprise restatement, you
would turn Rollup on for the year symbol.

https://insightsoftware.com/


98

Caution: Before applying or changing the virtual parent symbol feature in the hierarchy,
consult your Longview representative. Use caution before deleting or detaching child
symbols under a virtual parent symbol. If you apply the virtual parent symbol feature
incorrectly, you may cause your system to calculate totals incorrectly. Because the virtual
parent feature affects the calculation of data in the database, you must be careful in
designating symbols as virtual parent symbols.

10. For Sort Children, select one of the following:

Field Description

Ascending by Name Select this to designate sorting by name in alphabetical order.

Descending by
Name

Select this to designate sorting by name in reverse alphabetical order.

Manually
Select this to designate that sorting is to be done manually by symbol
priority.

11. Optionally, you can click the Attributes tab and assign specific values to the Attributes associated
with your new symbol. It is not necessary to do this at the time a symbol is created. It is always
possible to edit an existing symbol and modify its attribute values.

12. Click the Parents tab and review the settings for the new symbol.

13. To change the new symbol’s settings, complete the following fields. Otherwise, proceed to step 14.

Field Description

Parent
Symbol

Select this to assign the new symbol to a different parent.

Virtual
Use the drop-down list to select Yes or No to designate the parent symbol as a virtual
parent.

Weight

Use the drop-down list to select one of the following:

n + (the symbol is added to its parent)

n -(the symbol is subtracted from its parent)

n 0 (the symbol has no mathematical effect)

Note: For all dimensions other than the Accounts dimension, the default is +.
For the Accounts dimension, the default is 0 when Balance Type is Neither.

14. Click OK. The symbol appears in the hierarchy.

Duplicating a symbol
Duplicating a symbol is a quick means of creating a new symbol with the same settings as an existing
symbol.

To duplicate a symbol, follow these steps:
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1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Right-click the symbol you want to duplicate and select Duplicate. The New Symbol dialog
appears.

4. Enter a name for the new symbol.

5. Enter a description for the new symbol.

6. Optionally, you can also make changes to the other settings associated with the symbol. The New
Symbol dialog is pre-populated with the settings of the symbol being duplicated.

7. Click OK. Your new symbol appears under the same parent symbol as the original.

Managing symbols
This section explains how to modify symbols and their position in the hierarchy, and how to duplicate
and delete symbols.

Assigning a symbol to a parent
Note: You can also use the Assign and Assign To menu options to assign a symbol to a
parent. For more information see Assign and Assign To.

To assign a symbol to a parent, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Select the symbol you want to assign to a parent and drag it to the required parent symbol. A small
red arrow appears to indicate which symbol will be made the parent symbol if you release the
mouse button.

Caution: Assigning a symbol to a parent will result in data loss if the target parent is not a
parent symbol yet.

4. When you have navigated to the target parent symbol, drop the dragged symbol onto it. A data loss
warning appears if the target parent is not a parent symbol yet.
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5. Click Yes. The symbols now have a parent-child relationship.

Note: If you drag a symbol that is already assigned to a parent symbol, the hierarchy will
not be moved, but copied under the new parent symbol. To move the symbol and its
hierarchy, you must first remove it from its current parent symbol. For more information,
see Removing a Symbol from a Parent. The maximum number of parents a symbol can
have is 99.

Removing a symbol from a parent
Note: You can also use the Remove From Parent menu option to remove a symbol from a
parent. For more information see Remove From Parent.

To remove a symbol and its descendants from a parent, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Navigate to the child symbol you want to remove from its parent, and right-click it.

4. Select Remove From Parent. A confirmation dialog appears.

5. Click Yes.

The symbol, along with its hierarchy, becomes a root symbol (assuming the symbol does not belong to
any other hierarchy).

Note: If you remove all child symbols from a parent that has Virtual status, the symbol
becomes a standard leaf.

Modifying a symbol’s properties
To modify an existing symbol, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Double-click the symbol you want to modify. The Properties dialog opens with the General tab in
view.

4. Locate the property you want to change, and make changes as needed.

Note: If you do not have access to the child symbols of the symbol you are modifying, the
Balance type radio buttons (Credit, Debit, and Neither) are disabled.
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5. Click OK. Your changes are applied to the symbol.

Modifying a symbol’s attributes
To modify an existing symbol’s attribute values, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Double-click the symbol for which you want to modify attribute values. The Properties dialog opens
with the General tab in view.

4. Click the Attributes tab.

5. Locate the attribute whose value you want to change.

6. Click in the Value cell of the attribute and do one of the following:

l Enter the value you want applied to that attribute for this symbol or remove the existing value.

l If the value is another symbol, click the symbol selector button ( ... ). A dialog opens that
allows you to select the symbol you want applied as the value for the attribute. Select it and
click OK.

7. Click OK.

The value you have entered is applied to the attribute for that symbol. For more information on symbol
attributes, see Working with Attributes.

Deleting a symbol
Note: A parent symbol cannot be deleted. To make it eligible for deletion, remove its child
symbols first. For more information, see Removing a Symbol from a Parent.To delete a
symbol from a dimension, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the symbol
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Right-click the symbol you want to delete and select Delete. A confirmation dialog appears.

Caution: If you delete a symbol, it cannot be recovered, and all data associated with it is
lost. To restore a deleted symbol to the system, it must be recreated. Note that a symbol
may belong to more than one hierarchy. Deleting a symbol deletes all occurrences of the
symbol in all hierarchies. Use this function with caution.

4. Click Yes. The symbol is removed from the system.
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Comparing symbol hierarchies
You can compare the hierarchies of two symbols in the same dimension.

To do so, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbols, and select the dimension containing the hierarchy
you want to work with. A list of all the symbols for the selected dimension appears in the Contents
window.

3. Expand the symbol hierarchies to locate the symbols you want to compare.

4. Select the first symbol, hold down the CTRL key, and click on the second symbol to select it as
well.

5. Right-click one of the symbols and select Compare hierarchies. The comparison of the
hierarchies is displayed in the Search Results window.
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Working With Rules
You can configure complex logic through Longview Application Administrator. The complex logic is
known as a rule.

Understanding rule types
There are several types of rules.

n Model — For more information, see Understanding Model Rules.

n Rollup — For more information, see Understanding Rollup Rules.

n Query — For more information, see Understanding Query Rules.

n Event — For more information, see Understanding Event Rules.

n Validation — For more information, see Understanding Validation Rules.

Understanding Model rules
A model rule is an expression specifying a mathematical formula involving symbols in your Longview
database. When data is processed on the server, the system detects dependencies on these model
rules, performing the required mathematical calculations, and producing output data.

Once created, models run dynamically as you or someone else in your company imports or adds data to
the database.

Caution: When you delete a model rule from the system, data resulting from that rule will be
deleted from the database once a recalculation is run.

Understanding Rollup rules
Rollup rules define the process of calculating the values of parent symbols, all the way up to the root
symbol in each dimension.

Many combinations of dimensional detail do not need to be calculated. To improve performance, you
can configure Longview to discard these surplus combinations of data during rollup operations,
speeding up the overall time and significantly reducing the data volumes. To do so, you use a rollup rule.

Depending on your system setting for the Use Inclusion Method for Rollup Rules parameter, rollup
rules will either rollup all the data within the rule or will not rollup the data within the rule. The default
system setting does not rollup data within the area specified by the rule. For more information, see the
Longview Server Manager Guide.

There may be some confusion if a user happens to query an area not considered by the rollup rules
configured for their application. This could occur if the System Administrator missed some combinations
or chose to exclude some data because of space restrictions. In these cases, the system detects that
the query is to an area not being calculated and gives an appropriate warning to the user.
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Understanding Query rules
A query rule is an expression equating two data cubes. Query rules specify the placement of data
virtually in a data cube and are used to avoid storing redundant data in a system. When data is
processed on the server, Longview detects any query rules and retrieves data from the source cube and
places it virtually into the target cube as if it actually exists in the target cube. Query rules apply only to
base data.

Once created, query rules are applied dynamically whenever a request is made to retrieve target data
from the database.

Understanding Event rules
Event rules instruct the server to watch for certain conditions and to perform certain tasks when they
arise. Event rules are triggered by submitting either a string or a numeric value. Only numeric values that
result in a delta — that is, a difference in value between the previous and current values — will trigger a
rule. Entering a value of “0” to a string will not trigger a rule.

Caution: The procedures triggered by an event rule must reside on the server, not in the
application folders or elsewhere. Creating, editing, or deleting rules may cause changes that
you do not expect. If in doubt, see your Longview Professional Services representative.

Configuring and initiating event rules
The following configuration settings are related to event rules and must be set appropriately before you
start using event rules:

n Use Event Rules

n Event Queue Max

n Default Actions Time Interval

n Data Event Sequencing

n Max Active Data Events

n Event Profiling

For more information on these configuration settings, see the Longview Server Manager Guide.

Configuring Event timing
You can configure the timing of events using either the Default Actions Time Interval, or by using Data
Event Sequencing.

If you are using Data Event Sequencing, events are processed in iterations. Any events that are
triggered at the same time are in the initial iteration. Any events triggered while an iteration is running
wait until the next iteration. Using event sequencing ensures that the same events do not run multiple
times unnecessarily, which allows for consistent event tracking and more efficient use of system
resources.
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If you are using the Default Actions Time Interval, the system waits for an event with a specific rule ID
to run to completion before it runs the same rule ID again. The wait period also allows for subsequent
data submissions to coalesce with the initial submission.

If you are not using any event timing features, events run when triggered.

Understanding Validation rules
A validation rule compares two cubes of data in Longview database to make sure that certain cells within
those cubes equal each other. For example, Total Accounts must equal Total Liabilities and Owner’s
Equity, for all symbols in the ENTITIES, CURRENCY, and TIMEPER dimensions.

Once created, validation rules always run when you or someone else in your company imports data into
the database. For each instance in the designated cube of data where the data does not balance,
Longview stores the error message and amount in a validation data table.

Creating rules
You can use Longview Application Administrator to create server rules.

To create a rule:

1. Open Longview Application Administrator.

2. Select File > New > Rule. The New Rule dialog opens.

3. Complete these fields:

Field Description

Rule ID
Type a unique numeric value for the rule (the Rule List in the Contents window
contains a list of all existing rules and their numbers).
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Field Description

Rule Type

Select one of the following:

n Model

n Rollup

n Query

n Event

n Validation

For more information on rule types, see Understanding rule types.

Description
Type a brief description of the rule. The description can contain a maximum of 100
characters.

Email
Message

For Event rules that include email statements only, type the body of the email that
is sent when the rule is triggered.

Error Message
Template

For Validation rules only, the error message to display when validation fails.

4. For Rule, do the following:

l Type the rule. For more information on writing rule statements, see “Writing rule statements”.

l To add symbols to the rule, click Insert. The Rule Selection dialog opens, allowing you to make
selections from the dimensions list. Click OK when you are finished adding symbols.

Note: Symbols that are entirely numeric must be prefixed with an exclamation mark ( ! ) in
rules. For example, !22342 identifies 22342 as a symbol name and not a numeric value.
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5. Click OK. The new rule appears in the Rules list in the Contents window.

Copying rules
You can create a new rule by copying an existing one and then modifying it.

Caution: Creating, editing, or deleting rules may cause changes that you do not expect. If in
doubt, see your Longview Professional Services representative.

To copy an existing rule, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Rules. The Rules list appears in the Contents window.

3. Right-click the rule you want to copy and select Duplicate. A copy of the rule opens in the New Rule
dialog.

4. Make the necessary changes to the rule, including typing a new Rule ID and Description.

Note: You will not be permitted to save the rule until you have changed the rule. Exact
duplicates of existing rules are not permitted in the system.

5. Click OK. The new rule appears in the Rules list in the Contents window.
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Editing rules
You may need to edit an existing rule to either run a different type of rule or display a different error
message.

Caution: Creating, editing, or deleting rules may cause changes that you do not expect. If in
doubt, see your Longview Professional Services representative.

To edit an existing rule, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Rules. The Rules list appears in the Contents window.

3. Right-click the rule you want to modify and select Properties. The Properties dialog opens.

4. Make the necessary changes to the rule.

5. Click OK. The changes to the rule are entered into the system.

Exporting rules
You can export rules to an ASCII file. For information on exporting a rule to a file, see Exporting server
objects.

Deleting rules
You may want to delete a rule that you no longer need.

Caution: Creating, editing, or deleting rules may cause changes that you do not expect. If in
doubt, see your Longview Professional Services representative.

To delete a rule, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Rules. The Rules list appears in the Contents window.

3. Right-click the rule you want to remove and select Delete. A confirmation dialog opens.

Caution: If you delete a rule, it cannot be recovered. To restore a deleted rule to the
system, it must be recreated. Use this function with caution.

4. Click Yes. The rule is removed from the system and the Rules list.

Writing rule statements
A rule statement provides the definition for a server rule. The syntax of the rule statement varies
depending on the type of rule that you are working with.

For more information, see:
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n Writing Model rule statements

n Writing Rollup rule statements

n Writing Query rule statements

n Writing Event rule statements for emails

n Writing Event rule statements for procedures

n Writing Validation rule statements

Writing Model rule statements
In a model statement, you must specify:

n The cell coordinates of the cube of base data or schedule data from which you want to Model

n The cell coordinates of the cube of base data or schedule data to which you want to Model

The following Model statement copies the values of ACC1 from base data in a six-dimensional
database, to ACC1 in schedule data (Schedule S1160) for all the leaf symbols within the year-to-date
time period symbol and four remaining dimensions.

SCH(S1160,ACC1,YTDROOT###,#ALL,#ALL,#ALL,#ALL, 0) = KLX
(ACC1,YTDROOT###,#ALL,#ALL,#ALL,#ALL)

Where:

Field Description

SCH Identifies the data to Model as schedule data.

S1160 Specifies the schedule against which to Model data.

ACC1 Specifies the account symbol against which to Model data.

YTDROOT### Specifies all the leaf symbols within a time period symbol.

#ALL,#ALL,#ALL,#ALL
Specifies the remaining four base dimensions and state that all leaf symbols
within these dimensions will be included in the cube of data against which to
Model.

= Separates the two sides of the Model.

KLX Identifies the data to model as base data.

ACC1 Specifies the account symbol to model.

YTDROOT### Specifies all the leaf symbols within a time period symbol.

#ALL,#ALL,#ALL,#ALL
Specify the remaining four base dimensions, and state that all leaf symbols
within these dimensions will be included in the cube of data to model.

0
Offers the ability to round the calculated number to a defined precision. This
parameter is optional.
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Modeling syntax
All examples are based on three base dimensions of data and two extra schedule dimensions.

Data expression

KLX ( )

Representation of data using symbol names in each dimension to specify coordinates, for example:

KLX ( ACC1, A9701, TORONTO )

SCH ( )

Representation of schedule data using schedule name, symbol names in each base dimension, and
symbol names in each extra dimensions to specify coordinates, for example:

SCH ( S1043, ACC1, A9701, TORONTO, L1, C2 )

Range expression
#ALL

Representation of all leaf data in dimensions; for example:

KLX ( ACC1, #ALL, #ALL ) or

SCH ( S1043, ACC1, #ALL, #ALL, L1, #ALL )

###

Representation of all leaf data under a particular base dimension parent symbol. This syntax does not
apply to symbols in the extra dimensions. For example:

KLX ( ACC1, A97###, ONTARIO### ) or

SCH ( S1043, ACC1, A97###, ONTARIO###, L1, C2 )

#TOTAL

Representation of the total value in extra dimension (one per extra dimension is available), for example:

KLX ( ACC1, A97###, ONTARIO### ) (applies only to extra dimensions)

or

SCH ( S1043, ACC1, A97###, ONTARIO###, L1,#TOTAL )
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Time expression
#LAGNumber

Representation of going backward a specific number of periods in the time dimension.

n The hierarchy structure on time dimension must have a priority according to the sequence of
the time period.

n This syntax does not apply to symbols in the extra dimensions.

For example:

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, #LAG2, TORONTO ) means that in
TORONTO, value of ACC1 equals the value of last two periods of ACC2

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #LAG1,
TORONTO, L1, C2 ) means that value of C1 equals the value of last period of
C2.

#LEADNumber

Representation of going forward a specific number of periods in the time dimension.

n The hierarchy structure on time dimension must have a priority according to the sequence of
the time period.

n This syntax does not apply to symbols in the extra dimensions.

For example:

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, #LEAD2, TORONTO ) means that in
TORONTO, value of ACC1 equals the value of next two periods of ACC2.

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #LEAD2,
TORONTO, L1, C2 ) means that value of C1 equals the value of next period of
C2.

#YTDLAG

Representation of previous ending period.

n The hierarchy structure on time dimension must have a priority according to the sequence of
the time period.

n It must not be used with other expressions.

n This syntax does not apply to symbols in the extra dimensions.
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For example:

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, #YTDLAG, TORONTO ) means that in
TORONTO, value of ACC1 equals value of previous ending period of ACC2.

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #YTDLAG,
TORONTO, L1, C2 ) means that value of C1 equals the value of previous ending
period of C2.

or

SCH ( S1043, ACC1, ACTUAL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #YTDLAG,
TORONTO, L1, C2 )

#OPEN

Representation of opening period (specified by SYMBOL attribute ZFXTimePeriodsOpen).

n The type ZFXTimePeriodsOpen Attribute is a symbol list (value can be “CP99,AYR99”).
However, the function will only pick up the first defined root (CP99).

n The time range must be consistent throughout the rule.

n Can specify different opening period within the specified time range if each opening period
refers to different opening roots.

n Consider symbol A990PEN has ZFXTimePeriodsOpen attribute specified as CP99. Both CP99
and A99OPEN must be within the specified range (ACTUAL).

For example:

KLX ( ACC1, ACTUAL###, TORONTO ) = KLX ( ACC2, #OPEN, TORONTO ) - KLX ( 
ACC2, ACTUAL###, TORONTO ) means that in TORONTO, any leaf of CP99, the
value of ACC1 equals value of opening period (A99OPEN) of ACC2 - value of
ACC2

#PLUG

Refers to the ability to identify a symbol in a particular hierarchy that would be used as a “plug-to”
symbol. Whenever a certain total in that hierarchy (n levels above the plug-to symbol) changes because
of contributions from other leaf symbols, the plug-to symbol should get an equal but opposite amount
added to it. The net effect would be that the total would always be maintained at its current balance.

Consider the following hierarchy:
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Initially, everything is zero. If a delta of +10 were submitted to symbol D, it would normally roll up to
contribute +10 to A. However, the plug-to logic would apply, producing a value of -10 to G (assuming G
is the plug to symbol). The net effect causes A to remain at zero.

Symbol G is defined as the plug-to symbol for total A. If G has a positive weight, the syntax would be:

KLX(G,#ALL,...) = KLX(A#PLUG,#ALL,...) * -1

or

KLX(G,#ALL,...) = - KLX(A#PLUG,#ALL,...)

If G had a negative weight, the syntax would be:

KLX(G,#ALL,...) = KLX(A#PLUG,#ALL,...)

The value put into G is the sum of all leaf values under A, except for G itself. So, to truly keep A at zero
(or whatever its current balance is), you need to either reverse the sign of the number or specify the plug
to symbol to a negative weighting.

Modeling restrictions
There are certain restrictions when using modeling on the server assignment.

Restriction on assignment with any product or quotient of
expressions
Incorrect:

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, #ALL, TORONTO ) * KLX ( ACC3,
#ALL, TORONTO)

or
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KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, #ALL, TORONTO ) / KLX ( ACC3,
#ALL, TORONTO )

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #ALL,
TORONTO, L1, C3 ) * SCH ( S1043, ACC1, #YTDLAG, TORONTO, L1, C2 )

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, C1 ) = SCH ( S1043, ACC1, #ALL,
TORONTO, L1, C3 ) * SCH ( S1043, ACC1, #YTDLAG, TORONTO, L1, C2 )

Range restriction
All Longview expressions must have same range size in the corresponding Dimension in an equation.

Correct:

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC2, #ALL, ONTARIO###)

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #ALL,
TORONTO, L2, #ALL )

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #ALL,
TORONTO, #TOTAL, #ALL )

Incorrect:

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, A9701###, TORONTO )

or

KLX ( ACC1, #ALL, TORONTO ) = KLX ( ACC2, A9701, TORONTO ) + KLX ( ACC3,
#ALL, TORONTO )

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #ALL,
TORONTO, L2, C1 )
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or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #ALL,
TORONTO, #TOTAL, #TOTAL )

Non-specified coordinate restriction
Longview expressions must have at least one specified symbol in one of the base dimensions and at
least one specified symbol in one of the extra dimensions.

Incorrect:

KLX ( #ALL , #ALL , #ALL )

or

SCH ( S1043, ACC1, #ALL, TORONTO, #ALL , #ALL )

or

SCH ( S1043, #ALL , #ALL , #ALL , L2, #ALL )

#YTDLAG restriction
#YTDLAG can be used only on the right-hand side of the equation and cannot be used with other
combinations of Longview expressions.

Correct:

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC2, #YTDLAG, ONTARIO###)

or

SSCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #YTDLAG,
TORONTO, L2, #ALL )

or

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC2, #YTDLAG, ONTARIO###) + 100

Incorrect:

KLX ( ACC1, #YTDLAG, TORONTO ) = KLX ( ACC2, #ALL, TORONTO )

or
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KLX ( ACC1, #YTDLAG, TORONTO ) = KLX ( ACC2, #ALL, TORONTO ) + KLX ( ACC3,
#ALL, TORONTO )

LHS restriction
The left-hand side of the equation must be in the form of a single Longview expression.

Correct:

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC1, #YTDLAG, ONTARIO###) + KLX ( 
ACC2, #YTDLAG, ONTARIO###)

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) = SCH ( S1043, ACC1, #YTDLAG,
TORONTO, L2, #ALL ) + SCH ( S1043, ACC1, #YTDLAG,TORONTO, L2, #ALL )

Incorrect:

100 = KLX ( ACC2, #YTDLAG, ONTARIO###)

or

KLX ( ACC1, #ALL, ONTARIO### ) + KLX ( ACC2, #YTDLAG, ONTARIO###) = KLX ( 
ACC2, #YTDLAG, ONTARIO###)

or

SCH ( S1043, ACC1, #ALL, TORONTO, L1, #ALL ) + SCH ( S1043, ACC1, #YTDLAG,
TORONTO, L2, #ALL ) = SCH ( S1043, ACC1, #YTDLAG,

Single assignment restriction
The same coordinates cannot be in the left-hand side of two different rules.

Incorrect:

Rule Id 1

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC2, #YTDLAG, ONTARIO###) + KLX ( 
ACC3, #YTDLAG, ONTARIO###)

Rule Id 2

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC3, #YTDLAG, ONTARIO###) + KLX ( 
ACC4, #YTDLAG, ONTARIO###) or
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Rule Id 1

KLX ( ACC1, A9601, ONTARIO### ) = KLX ( ACC2, #YTDLAG, ONTARIO###) + KLX ( 
ACC3, #YTDLAG, ONTARIO###)

Rule Id 2

KLX ( ACC1, #ALL, ONTARIO### ) = KLX ( ACC3, #YTDLAG, ONTARIO###) + KLX ( 
ACC4, #YTDLAG, ONTARIO###)

#Plug restrictions
n Ability to #PLUG can only be specified to one dimension in any single rule. Therefore, the

following example is not allowed:

KLX(G,PX,...) = - KLX(A#PLUG,PY#PLUG,...)

n When #PLUG is used, the coordinates for the other dimensions must be identical. Therefore,
the following example is not allowed:

KLX(G,P1,...) = - KLX(A#PLUG,P2,...)

n Only one plug symbol may be identified for any parent value. Therefore, the following example
is not allowed:

KLX ( ACC1, CP1, … ) = - KLX ( ACCT#PLUG, CPT, … )

KLX ( ACC1, CP2, … ) = - KLX ( ACCT#PLUG, CPT, … )

n Valid only with models (not rollup rules)

#ALL restrictions
n Each KLX or SCH must have at least one specific symbol or symbol hierarchy specified. You

cannot use #ALL in its base dimension coordinate:

Incorrect:

KLX(#ALL,#ALL,#ALL) = 10

Correct:

KLX(A1###,#ALL,#ALL) = 10
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n When an equation contains KLX and SCH, #ALL cannot be specified in any extra dimension:

Incorrect:

KLX(A1###,#ALL,#ALL) = SCH(ST1,A1###,#ALL,#ALL,CO1,#ALL)

Correct:

KLX(A1###,#ALL,#ALL) = SCH(ST1,A1###,#ALL,#ALL,CO1,R01)

n When an equation contains different schedules, #ALL cannot be specified in any extra
dimension:

Incorrect:

SCH(ST2,A1###,#ALL,#ALL,LO1,#ALL) = SCH(ST1,A1###,#ALL,#ALL,LO1,#ALL)

Correct:

SCH(ST2,A1###,#ALL,#ALL,LO1,C01) = SCH(ST1,A1###,#ALL,#ALL,LO1,R01)

SCH(ST2,A1###,#ALL,#ALL,LO1,#ALL) = SCH(ST2,A1###,#ALL,#ALL,LO2,#ALL)

n It is strongly suggested that #ALL be avoided in the TIMEPER dimension when constructing
rules as its use may lead to the doubling of expected results.

Writing Rollup rule statements
Rollup rules can specify high level symbols without specifying the intermediate symbols necessary for
the rollup. For example, if a symbol C rolls to B, which rolls to A (C to B to A), there could be a rollup rule
stating: KLX(A,#ALL,#ALL)

This means “keep the data associated with A only”. Even though A depends on B, the data for B will be
discarded during the rollup operation (but A will still be calculated correctly).

You can use the following parameters in the syntax:

Field Description

#LEAF To include leaf data only.

#ALL To include all data.

### To include all leaf symbols related to the parent symbol.

#99 To include the parent symbol and 99 levels of its descendants.

Writing Query rule statements
In a query rule statement, you must specify:
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n The cell coordinates of the cube of base data that is the source of the data you want to repeat
virtually

n The cell coordinates of the target cube of base data where you want to place the virtual data

Query rule statements must be in the form target cube = source cube.

Note: The target cube must be a static Data Area. Data that is virtually placed in the target cell
does not roll up.

Caution: If a user updates the value directly in the target cube, there will be no way to retrieve
this value since any attempt to read the value of the target cube will be redirected to the source
cube.

Restrictions
There are some restrictions on query rule statements:

n Only simple KLX() = KLX() query rules are supported

n Lag and lead functions are not supported

n The target cube must be a static Data Area

n Schedule data is not supported

n Each Dimension of the source cube must:

n Have the same number of symbols as the corresponding dimension in the target cube or

n Have only one symbol

Examples
This example is a one-to-one statement for all dimensions. Each dimension of the target cube has the
same number of symbols as the corresponding dimension in the source cube.

KLX(ATTEND3A,DIM1SET,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)=

KLX(ATTDRVR1,DIM1SET,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)

This example is a one-to-many statement for the ACCOUNTS dimension. In this example, the target
cube has many symbols in the ACCOUNTS dimension set equal to one symbol in the ACCOUNTS
dimension of the source cube. All other dimensions of the target cube have the same number of symbols
as the corresponding dimensions in the source cube.

KLX(ATTEND1#99,#ALL,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)=

KLX(ATTDRVR1,#ALL,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)
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This example is a many-to-many statement for the ACCOUNTS and TIMEPER dimensions. In this
example, the target cube has many symbols in the ACCOUNTS dimension set equal to many symbols in
the ACCOUNTS dimension of the source cube. All other dimensions of the target cube have the same
number of symbols as the corresponding dimensions in the source cube. This query rule statement is
only valid if the number of symbols in ATTEND2### is equal to the number of symbols in ATTEND3###.

KLX(ATTEND2###,CP#99,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)=

KLX(ATTEND3###,CP#99,DIM2SET,DIM3SET,DIM4SET,DIM5SET,DIM6SET,DIM7SET)

Writing Event rule statements for emails
The email action causes an email to be sent to the addresses specified when data in the defined area
changes.

If your user ID contains an “at” sign ( @ ), your user ID and email address must be the same for the
Email event rule to work correctly.

Syntax

KLX(Sym0,Sym1,…SymN)=Email(ID1[,ID2[…,IDn]])[;Interval]

SCH(Sched,Sym0,…SymN,SSym0,…SSymM)= Email(ID1[,ID2[…,IDn]])[;Interval]

Where:

Interval is an optional parameter which overrides the value of

DEFAULT_ACTIONS_TIME_INTERVAL with the specified value (in minutes; valid values are 0 to
1440). If the value is not specified, the DEFAULT_ACTIONS_TIME_INTERVAL value applies.

Example
The following is an example of an event rule:

KLX(stdact###,P01YTD,nfl###,DIM3SET,DIM4SET,SUBMITQA,CCAD,DIM7SET)=RUNPROC("
someproc1.lvpro")

This rule will launch someproc1.lvpro and run the commands listed in it when data changes in the
intersection defined in the rule.

Note: In both examples, ### means that all leaf symbols that are children of the named
symbol are included in the intersection. This can also be #0-#99, the same as in database
queries.

Writing Event rule statements for procedures
The RUNPROC action causes a procedure to be executed when data in the defined area changes.
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Syntax

KLX(Sym0,Sym1,…SymN)=[Queue_ID:]RUNPROC("ProcName")[;Interval]

SCH(Sched,Sym0,…SymN,SSym0,…SSymM)=[Queue_ID:]RUNPROC("ProcName")[;Interval]

Where:

n ProcName is the location of procedure. If the path is relative, the procedure will be launched
from the server’s working directory. If the path is absolute, the working path will be changed to
that directory and the procedure will be launched from there.

Note: If an absolute path is used, lv_af.exe must be accessible from the new working
directory (either in that absolute path or in the PATH environment variable).

n Queue_ID is an optional parameter to prevent the simultaneous activation of rules with the
same Queue_ID number. The value is a three-character alphanumeric string.

n Interval is an optional parameter which overrides the value of DEFAULT_ACTIONS_TIME_
INTERVAL with the specified value (in minutes; valid values are 0 to 1440). If the value is set to
0 or not specified, the DEFAULT_ACTIONS_TIME_INTERVAL value applies.

Note:
If you make any changes to the list of persistent event rules (in either the Persistent
Event Rule Setup dialog, or the rulepersists.txt file) or the name of the procedure
launched by the persistent event rules, you must restart the servers for your changes
to take effect.
For more information on persistent event rules, see Specifying Persistent Event
rules.

Example
The following is an example of an email event rule:

KLX(stdact###,QAPLAN01,nfl###,DIM3SET,DIM4SET,SUBMITQA,CCAD,DIM7SET)=EMAIL
("n ame@domain.com");62

This rule will submit an email message to the address indicated if data changes in the data intersection
defined in the left side of the rule. If a subsequent change in data is detected, the action will not be
launched again until 62 minutes after the last time it was launched.

Caution: New rules will not go into effect until Maintenance is turned off.

Writing Validation rule statements
In a validation rule statement, you must specify:
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n The cell coordinates of the cube of base or schedule data against which you want to compare
the imported values

n The cell coordinates of the cube of base or schedule data that you want to validate

Example 1
The following validation statement compares two cubes of base data in a six-dimensional database, to
make sure certain values within those cubes are equal. This statement verifies that the value of the
account symbol A1000 equals the value of the account symbol A2000 for all the leaf symbols within the
year-to-date time period symbol and four remaining dimensions.

KLX(A1000,YTDROOT###,#ALL,#ALL,#ALL,#ALL)=

KLX(A2000,YTDROOT###,#ALL,#ALL,#ALL,#ALL)

Where:

Field Description

KLX Identifies the validation as a base data validation.

A1000 Specifies the account symbol against which to validate data.

YTDROOT### Specifies all the leaf symbols within a time period symbol.

#ALL,#ALL,#ALL,#ALL
Specify the remaining four base dimensions, and state that all leaf symbols
within these dimensions will be included in the cube of data against which to
validate data.

= Separates the two sides of the validation.

KLX Identifies the data to validate as base data.

A2000 Specifies the account symbol to validate.

YTDROOT### Specifies all the leaf symbols within a time period symbol.

#ALL,#ALL,#ALL,#ALL

Specify the remaining four base dimensions, and

state that all leaf symbols within these dimensions will be included in the cube
of data to validate.

Example 2
The following validation statement compares the total schedule data in the S1043 schedule for the
ACC1 account across all time periods and entities, with the base cell value for that account across all
time periods and entities. the schedule total and base data should match. If they do not, the validation
error message appears in a validation report.

SCH(S1043,ACC1,#ALL,#ALL,#TOTAL)=

KLX(ACC1,#ALL,#ALL)

Where:
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Field Description

SCH Identifies the data against which to validate as schedule data.

S1043 Specifies the schedule against the total of which you want to validate base data.

ACC1 Specifies the account symbol to which the schedule is associated.

#ALL,#ALL
Specify the remaining two base dimensions, and state that all leaf symbols within these
dimensions will be included in the cube of data against which to validate data.

#TOTAL
Represents the total of the schedule data against which to validate the base data. When
comparing a schedule against base data, you can select only one symbol from the
schedule dimension.

= Separates the two sides of the validation.

KLX Identifies the data to validate as base data.

ACC1 Specifies the account symbol, the totals of which you want to validate.

#ALL,#ALL
Specify the remaining two base dimensions, and state that all leaf symbols within these
dimensions will be included in the cube of data to validate.

Validation message
For each validation rule that you create, you must create a corresponding error message that will appear
in a validation report. This message specifies the cell coordinates and provides a brief description of the
error.

For example:

%ENTITIES;%TIMEPER;%PRODUCTS;%CURRENCY;ASSETS & LIABILITIES OUT OF BALANCE
BY;%VALUE

Where:

Field Description

%ENTITIES;%TIMEPER;%
PRODUCTS;%CURRENCY

Specifies the symbol coordinates of the error by dimension name.

;ASSETS & LIABILITIES
OUT OF BALANCE BY

Appears on the report for each error generated by the error statement
that compares the company’s assets and liabilities accounts.

;%VALUE
Specifies the error amount for each error generated by the error
statement.

You can also use the following parameters in the syntax of the message:

Field Description

%ENTITIESDESC;%TIMEPERDESC;
%PRODUCTSDESC;%CURR
ENCYDESC

Specify the symbol coordinates of the error by dimension
description.

[\n] Starts a new line after the current line.

[@n] Adds n blank spaces.

https://insightsoftware.com/


124

Maintaining Symbol Access Roles
Symbol access roles allow users with administrative permissions to create classes of symbol
permissions that can be applied to individual users or to user groups. These classes of permissions are
tailored to the roles that such users or user groups are likely to perform in the system. For example,
users who deal with accounts in a particular country or department can be granted specific permissions
to associated symbols that would enhance their ability to work with those areas, as opposed to the more
general and limited permissions they would have otherwise.

Since symbol access roles are stored in the system, they can be applied to users and groups easily
without requiring users with administrative permissions to reconfigure such permissions every time they
are to be granted. It also makes the creation of a vast number of user groups for different roles and
business units unnecessary. In this way, a particular user (or even several users) within a user group
can have different permissions from the ones common to the group in general.

Default symbol access roles
A range of symbol access roles are provided with Longview and can be added by following the
instructions in this chapter. The default symbol access roles that come with the application are the
following:

Role Description

Administrator_Access Administrator Role

Analysis_Reporting_Access Analysis and Reporting Access Role

Dashboard_Designer_Access Dashboard Designer Role

Default Default Role

Excel_Access Excel Access Role

FXR_Access This role is not currently used.

Input_Access Input Role

Journal_Entries Journal Entries Role

V3_Compatible_Access V3 Compatible Role

Note: Access to all components is through the V3 Compatible Role; however, users requiring
access to Longview Application Administrator need to have symbol access for the
Administrator Role.

Creating new symbol access roles
To create a new symbol access role, follow these steps:

1. Open Longview Application Administrator.

2. Select File > New > Access Role. The New Access Role dialog opens.
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3. Type a name for the new role. The name cannot contain spaces. This field is mandatory.

4. Type a description for the new role. The description can have up to 100 characters. This field is
mandatory.

5. Click in the Access Type field to use the drop-down list to select the access type for each
dimension. The types are:

a. Full: Allows access to all symbols in the dimension.

b. Restricted: Restricts access to the symbols you select.

c. Fixed: Restricts access to the single symbol in the dimension you select.

6. If you select the Restricted or Fixed access type, click the symbol selector button that appears in
the Symbols field. A selection dialog opens.
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7. To add a symbol, select the check box for the appropriate symbol.

8. Specify the following settings for the selected symbol:

a. Access: Either W (write access) or R (read-only access).

b. Level:A number between 0 and 99 designating how many levels of child symbols below the
selected symbol the users of the role have access to. This can only be set if the access type is
Restricted.

c. Priority: This is a number greater than zero to designating the precedence for the access type,
where 1 is the highest priority. For example, if a user has Read access to a leaf symbol with a
priority of 1 but Write access to that symbol’s parent with a priority of 50, the user will have
Write access to all symbols under the parent except for that read-only leaf symbol.

Note: Assigning a priority of 0 gives precedence to any other non-zero value.

Note: If the dimension is set to Full access, these settings are not available.

9. Repeat step 7 to step 8 to add the required symbols.

10. When you have completed adding the symbols you want to include in this symbol access role for
each dimension, click OK. The new role appears in the list of symbol access roles.

Modifying symbol access roles
To edit a symbol access role, follow these steps:
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1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbol Access and select Roles. A list of the symbol access
roles currently in the server appears in the Contents window.

3. Right-click the symbol access role you want to edit and select Properties. The Properties dialog
opens for the selected role.

4. Make the necessary changes to the properties of the symbol access role and click OK. Your
changes to the role are saved.

Deleting symbol access roles
Note: You can delete symbol access roles that have been created by users in your system
only. It is not possible to delete core symbol access roles.

To delete a symbol access role, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbol Access, and select Roles. A list of the symbol access
roles currently in the server appears in the Contents window.

3. Right-click the symbol access role you want to delete and select Delete. A confirmation dialog
opens.

Caution: If you delete a symbol access role, it cannot be recovered. To restore a deleted
symbol access role to the system, it must be recreated. Use this function with caution.

4. Click Yes. The role is removed from the list of symbol access roles.

Applying symbol access roles
Symbol access roles can be applied at either the group or user level. When applied to a group, all users
in that group inherit the access role (or those from the role you provide to the group). When applied to a
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user, that user alone inherits the access role (though the role may be applied to multiple users in a group
on an individual basis as well).

Applying a symbol access role to a group
To assign symbol access to a group, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbol Access > Users and Groups and select Groups. A
list of the groups residing on the server appears in the Contents window.

3. Right-click the group you want to work with and select Properties. The Symbol Access Properties
dialog opens for the selected group.

4. Click in the Access column to use the symbol selector button ( ... ) to open the symbol selection
dialog for that role. A selection dialog opens for the selected access role.

5. Locate the symbol for which you want to give access to the group and double-click it. The symbol
appears to the right.
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6. Make changes to the Access, Level, and Priority fields as needed. For more information on these
fields, see step 6 of Creating New Symbol Access Roles.

7. If you want the group to inherit symbol access from the selected role for the dimension, select
Inherit Role Access.

8. Click OK. The applied symbol access appears in the Access column for the selected role.

9. Repeat step 4 to step 8 for each role for which you want to apply symbol access.

10. When you have finished applying symbol access, click OK.

Applying a symbol access role to a user
To assign symbol access to a user, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbol Access > Users and Groups and select Users. A list
of the groups residing on the server appears in the Contents window.

3. Right-click the user you want to work with and select Properties. The Symbol Access Properties
dialog opens for the selected user.

4. Click in the Access column to use the symbol selector button ( ... ) to open the symbol selection
dialog for that role. A selection dialog opens for the selected access role.
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5. Locate the symbol for which you want to give access to the user and double-click it. The symbol
appears to the right.

6. Make changes to the Access, Level, and Priority fields as needed. For more information on these
fields, see step 6 of Creating New Symbol Access Roles.

7. If you want the use to inherit symbol access from the selected role for the dimension, select Inherit
Role Access.

8. Click OK. The applied symbol access appears in the Access column for the selected role

9. Repeat step 4 to step 8 for each role for which you want to apply symbol access.

10. When you have finished applying symbol access, click OK.
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Maintaining Users And Groups
Users with administrative permissions can perform user and group maintenance tasks in Longview
Application Administrator. These include creating new users or new groups, editing users and groups,
assigning access to a particular group, deactivating or activating users, resetting passwords and
deleting users or groups.

Note: If your system is configured to be on the ISW Platform then users cannot be created,
edited, or deleted and password cannot be reset from Longview Application Administrator.

In addition, authorizations can only be set on the users as authorizations are
limited by your user license.

Note: If your system is configured to be on the ISW platform then users cannot be
created, edited, or deleted and password cannot be reset from Longview Application
Administrator. Authorizations can be set on individual users, but are limited by the user's
license. Setting authorizations on a group overrides the user's authorizations, and only the
group authorizations apply — still subject to the user's license.

This section provides information on the following topics:

n Maintaining Users with ISW Platform Integration

n Maintaining Users

n Maintaining Groups

n Modifying User Attributes

n Granting Administrative Permissions

Maintaining Users With ISW Platform
Integration
If your system is configured to be on the ISW Platform, all user maintenance (creating users, editing

users, deleting users, and resetting user passwords) is managed by the ISW platform. User
authorizations are also limited to the type of user license they have and therefore authorizations cannot
be set on a group.

If your system is configured to be on the ISW platform, authorizations set on a group
override the user's individual authorizations, and only the group authorizations apply. If the group has no
authorizations configured, the user's individual authorizations are used instead. In all cases,
authorizations are limited by the user's license.
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Note: The following will always be read-only in Application Administrator as it is managed in
the ISW platform:

n User Name

n First Name

n Last Name

n Description (Last Name + First Name)

Synchronize users
Users that have been created or modified but have not yet been created or updated in the Longview
database need to be synchronized by a user administrator. When Synchronize Users is run, the
following will occur:

Field Description

New Users

n If the user has an Admin license only, the user will be assigned to the
UserAdministrators group.

n If the user has a Designer license or Designer and Admin licenses the user will be
assigned to the Administrators group.

n Default Authorizations based on the User’s license will be set. See Understanding
User and Group Authorizations for more information.

Note: A user must have a user license assigned to them to be synchronized in
the Longview system.

Existing

Users

n If a user’s license has changed, any authorizations that are set for the user that
are not covered by the license change will automatically be removed.

n Authorizations are updated to match the existing licenses, however any
authorizations that were explicitly removed for the user will not be changed.

Removing

Users

n Users that have been removed will be deleted from Longview.

n Users that no longer have a user license will be deleted from Longview.

To synchronize users using Longview Application Administrator, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Right-click on Users in the Server Explorer pane and select Synchronize Users.
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4. In the confirmation dialog, click Yes. A Synchronizing Users status window will appear.

5. Once the Synchronizing Users have completed a confirmation dialog will appear. Click Close to
close the confirmation dialog.

Maintaining Users
Creating users

Note: This section does not apply to systems that are on the ISW platform.

You can add users to the system and assign them to groups. Users and groups can have permissions
assigned to them that designate the symbols to which they have access. You can also edit user
attributes in Application Administrator.

To create a new user using Longview Application Administrator, follow these steps:

Note: You can also create new users by importing text files. For more information see
Preparing import files for users.

1. Open Longview Application Administrator.

2. On the File menu, select New > User. The New User dialog opens with the General tab in view.

3. In the User Name field, type a username based on the guidelines for your authentication method.

Note: The first or last character of a username cannot be a space.
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a. Longview authentication: If your company uses Longview authentication, usernames:

l can include a maximum of 63 characters

l can include any number, and any letter, uppercase or lowercase

l can include the hyphen ( - ), pound sign ( # ), exclamation point ( ! ), accent grave ( ̀ ),
tilde ( ~ ), underscore ( _ ), period ( . ), space (  ), and “at” sign ( @ )

Note: If you plan to work with the Email event rule type, and your username
contains an “at” sign ( @ ), your username and email address must be the
same.

b. Windows authentication: If your company uses Windows authentication, use the user’s
Windows username. The Windows username:

l can include a maximum of 63 characters for the total User name field

l must include the domain name, a backslash ( \ ), and the Windows username; for
example: CORP\WinUserID

l the domain name supports only two special characters: the hyphen ( - ) and underscore ( 
_ )

l the username can include the hyphen ( - ), pound sign ( # ), exclamation point ( ! ), accent
grave ( ̀ ), tilde ( ~ ), underscore ( _ ), period ( . ), and space (  )

c. Third-party web authentication: If your company uses third-party web authentication, type the
username from the third-party software. Third-party web usernames:

l can include a maximum of 63 characters

l can include the hyphen ( - ), pound sign ( # ), exclamation point ( ! ), accent grave ( ̀ ),
tilde ( ~ ), underscore ( _ ), period ( . ), space (  ), and “at” sign ( @ )

Third-party web authenticated administrative users are still able to change the passwords of
Longview authenticated users, provided the administrative users have been granted sufficient
access. Third-party web authentication is not supported for Microsoft SharePoint.

Note: If you plan to work with the Email event rule type, and your username contains
an “at” sign ( @ ), your username and email address must be the same. Usernames
containing special characters, including the “at” sign ( @ ) must be enclosed in
double quotation marks.

4. In the User section, type the user’s information in the following mandatory fields:

a. First Name: Type the user’s given name. The first name can have a maximum of 50
characters.
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b. Last Name: Type the user’s surname. The last name can have a maximum of 50 characters.

c. Description: Type a description based on the user’s role in the system. The description can
have a maximum of 100 characters.

5. In the Contact section, type the user’s information in the following optional fields:

a. Email: Type the user’s email address.

b. Home Phone: Type the user's home phone number.

c. Office Phone: Type the user's office phone number.

6. For Authentication method, select one of the following options:

a. Longview: Select this option to authenticate this user through Longview authentication.

b. Windows: Select this option to authenticate this user through their Windows domain
credentials.

c. Third-party web: Select this option to authenticate this user through a third-party web
authentication application.

Note: Users select Single Sign-On (Web) when signing on.

7. If you selected Longview as the Authentication method, complete the following mandatory fields.
Otherwise, continue to step 8.

a. Password: Type the password for the new user.

Note: Passwords cannot contain any of the following characters: double quotation
marks ( " ), pipes ( | ), dollar sign ( $ ), square brackets ( [ ),( ] ) or spaces ( ), and
cannot start with the at sign (@).

If your company enforces password complexity, passwords must meet all password
complexity restrictions, including (but not limited to) the following:

l The password must contain at least one uppercase alphabetical character (A-Z), one
lowercase alphabetical character (a-z), one base 10 digit (0-9), and one
nonalphanumeric character.

l The password must be a minimum number of characters in length.

l The password cannot contain the whole Username, First Name, or Last Name of the
user, in either uppercase or lowercase.
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l For more information on password complexity, see the Longview Server Manager Guide.

b. Confirm Password: Type the password again.

8. Click the Groups tab. Existing groups appear in the All Groups list.

9. Select the group or groups to assign the new user to.

Note: New users are automatically assigned to the AllUsers group and cannot be
removed from it. For more information, see Understanding the AllUsers group.

10. Click the Authorization tab. The tab opens with the Account Type category displayed.
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11. Assign the authorizations to the user as necessary. For more information about authorizations, see
Understanding User and Group Authorizations.

12. When you are finished, click OK. The new user appears in the Users list in the Contents window.

Editing users
To make changes to an existing user, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Double-click the name of the user you want to modify. The Properties dialog for that user opens.

4. Make the necessary changes to the user.

5. When you are finished, click OK. Your changes are applied to the user.

Deleting users
Note: This section does not apply to systems that are on the ISW platform.

To delete an existing user, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Right-click the user that you want to remove from the system and select Delete. A confirmation
dialog opens.

Caution: If you delete a user, it cannot be recovered. To restore a deleted user to the
system, it must be recreated. Use this function with caution.

4. Click Yes. The user is removed from the system and from the groups to which it was assigned.

Resetting user passwords
Note: This section does not apply to systems that are on the ISW platform.

If a user forgets their password, you may need to reset it for them, and supply them with the temporary
password you have used.

To reset a user’s password, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.
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3. Right-click the user for which you want to change the password and select Reset Password. The
Reset Password dialog opens.

4. Type the new password in the New Password and Confirm Password fields.

Note: Passwords cannot contain any of the following characters: double quotation marks
( " ), pipes ( | ), dollar sign ( $ ), square brackets ( [ ),( ] ) or spaces ( ), and cannot start with
the at sign (@).

l If your company enforces password complexity, passwords must meet all password complexity
restrictions, including (but not limited to) the following:

a. The password must contain at least one uppercase alphabetical character (A-Z), one
lowercase alphabetical character (a-z), one base 10 digit (0-9), and one non-alphanumeric
character.

b. The password must be a minimum number of characters in length.

c. The password cannot contain the whole Username, First Name, or Last Name of the user,
in either uppercase or lowercase.

l For more information on password complexity, see the Longview Server Manager Guide.

5. Click OK. The user’s password is reset.

Deactivating and Activating Users
Users can be deactivated in the Longview system. Deactivated users will not be able to sign on to
Longview, however the user’s information and settings remain in the database. When the user is
Activated, the user can sign on to Longview again.

To deactivate a user, follow these steps:

1. Open Longview Application Administrator

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Right-click on the user you want to deactivate.

4. Select Deactivate.
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5. Click Yes to deactivate the user. The user will now show as Deactivated in the Status column of the
Contents window.

To activate a user, follow these steps:

1. Open Longview Application Administrator

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Right-click on the user you want to activate.

4. Select Activate.

5. Click Yes to activate the user. The user will no longer show as Deactivated in the Status column.

Maintaining Groups
Assigning users to groups
To assign a user to a group, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Users. The list of
users appears in the Contents window.

3. Double-click the user you want to modify. The Properties dialog for that user opens.

4. Click the Groups tab. Existing groups appear in the All Groups list.

5. To add the user to a group, select the group.

6. When you are finished adding the user to groups, click OK.

Creating groups
You can use Longview Application Administrator to create new groups.

To create a new group, follow these steps:

Note: You can also create new groups by importing text files. For information on how to do
this, see Preparing import files for groups.

1. Open Longview Application Administrator.

2. On the File menu, select New > Group. The New Group dialog displays with the General tab in
view, as shown below:
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3. Complete the following fields:

a. Name: Enter a name for this group:

i. can be a combination of both letters and numbers

ii. can have a maximum of 31 characters

iii. may include the underscore (_)

iv. cannot contain spaces

b. Description: Enter a description of the new group, such as its role in the system. The maximum
number of characters the description can contain is 100.
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4. Click the Users tab. Existing users appear in the All Users list, shown below:

5. To include a user in the group, select the user.

Note: Select one of the existing groups from the Groups list to choose from the users in
that group. The users that you select to include in the new group appear in the Group
Members list.

6. Click the Authorization tab (Authorization Override if the system is configured to be on the ISW
platform). The tab opens with the Application Access – Add-In for Office category in view, like
below:
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7. Assign the following authorizations to the group as necessary. For more information about
authorizations, see Understanding User and Group Authorizations.

8. When you are finished, click OK. The new group appears in the Groups list in the Contents window.

Editing groups
To make changes to a group, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Groups. The list of
groups appears in the Contents window.

3. Double-click the group you want you modify. The Properties dialog for that group opens.

4. Make the changes you require to the group.

5. When you are finished, click OK. Your changes are applied to the group.

Deleting groups
To delete a group, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand the Users and Groups category, and select Groups. The list of
groups appears in the Contents window.

3. Right-click the group you want to delete and select Delete.

Caution: If you delete a group, it cannot be recovered. To restore a deleted group to the
system, it must be recreated. The next group in the list after the one you have deleted will
automatically be selected for deletion, so do not click Delete more than once unless you
want to delete multiple groups in a sequence. Use this function with caution.

4. In the confirmation dialog, click Yes. The group is removed from the system.

Note: Deleting a group does not delete the users who were members of it, though it may
affect their permissions. The AllUsers group is protected and cannot be deleted. For more
information on the AllUsers group, see Understanding the AllUsers Group.

Modifying User Attributes
To modify a user’s attribute settings, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Symbol Access > Users and Groups, and select Users. The
list of users appears in the Contents window.

3. Double-click the user you want to work with and select Properties. The Properties dialog opens for
that user.
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4. Select the Attributes tab to view a list of attributes associated with the user. The value an attribute
can have varies according to its purpose. For more information on user attributes, see User attribute
names and parameters.

5. When you are finished modifying a user’s attributes, click OK.

Understanding User and Group Authorizations
Authorizations can be set on both the User and the Group, unless the Longview system is on the ISW
platform, then authorizations can only be set on Users. When Longview is configured to be on the
platform, the authorizations are dependent on the type of user license the user has.

When the user is synchronized from the ISW platform and added to Longview, the authorizations are set
based on their user license however they can be modified to be less then what is provided by default.
Any authorizations that have been manually removed will not be reset upon future user
synchronizations.

Account Type Authorizations
Account Type Authorizations only apply to users and cannot be set on a group.

Authorization Description
Platform

License

User
Administrator

Select this option to make the user a user administrator. This
authorization allows this user to create groups, users and assign them
any authorizations, groups or symbol access regardless of their own
access or membership.

Admin

Designer

Service
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Authorization Description
Platform

License

Service
Account

Select this option to restrict the user to only connect through Longview
REST API and Application Framework batch mode.

Note:
n You must connect as a user with User Administrator

Authorization to set this authorization.

n When this authorization is set all other connection
related authorizations will be ignored

n Force password change, password warning and
password expiry do not apply to a Service Account
User.

Service

Application Access – Add-In for Office Authorizations

Authorization Description
Platform

License

Allow Access

Select this option to give the user access to Longview Add-In for
Office.

Note: You must also select the Connect to Application
Framework option in the Data Access category to allow
users to access the Longview Add-In for Office.

Designer

Power User

Viewer

Submit Data
This option is available only if Allow Access is selected. Select
this option to allow the user to submit data in the Longview Add-
In for Office.

Designer

Power User

Application Access – Application Administrator
Authorizations

Authorization Description
Platform

License

Allow Access
Select this option to give the user access to Longview Application
Administrator.

Admin

Designer

Service
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Application Access – Designer Authorizations

Authorization Description
Platform

License

Allow Access

Select this option to give the user access to Longview Designer.

Note: You must also select the Connect to Application Framework
option in the Data Access category to allow users to access
Longview Designer.

Designer

Data Import
Apps - Create

Select this option to allow the user to create data import apps in Longview
Designer.

Designer

Data Import
Apps - Modify

Select this option to allow the user to edit data import apps in Longview
Designer.

Designer

Data Import
Apps - Delete

Select this option to allow the user to delete data import apps in Longview
Designer.

Designer

Data Import
Apps - Publish

Select this option to allow the user to publish data import apps in Longview
Designer.

Designer

Longview
Apps - Publish

Select this option to give the user access to publish Longview Apps in
Longview Designer.

Designer

Application Access – Mappings Editor Authorizations

Authorization Description
Platform

License

Allow Access

Select this option to give the user access to the Longview
Mappings editor.

Note: You must also select the Connect to Application
Framework option in the Data Access category to
allow users to access the Mappings editor.

Designer

Power
User

Service

Manage Maps
Select this option to give the user access to create, modify, and
delete maps.

Designer

Power
User

Service

Manage Mappings
Select this option to give the user access to create, modify, and
delete mappings.

Designer

Power
User

Service
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Application Access – Server Manager Authorizations

Authorization Description
Platform

License

Allow Access
Select this option to give the user access to Longview
Server Manager.

Admin

Service

Designer

Start/Stop Servers, Turn
On/Off Dynamic Calculations

Select this option to allow the user to start and stop the
servers and turn Dynamic Calculations on and off.

Admin

Service

Designer

Application Access – Other Authorizations

Authorization Description
Platform

License

Longview
Dashboard
Designer

Select this option to give the user access to Longview Dashboard
Designer.

Designer

Longview
Journal Entries

Select this option to give the user access to Longview Journal Entries.

Designer

Power
User

Longview
Workflow
Designer

Select this option to give the user access to LongviewWorkflow Designer Designer

Longview
Analysis &
Reporting

Select this option to give the user access to Longview Analysis and
Reporting and select one of the following Reporting roles to assign to the
user:

n Publisher — Users assigned a Report Publisher role can create,
format, and publish report templates.

n Author — Users assigned a Report Author role can create their
own report views for analysis purposes and run reports.

n User — Users assigned a Report User role can use the report
templates created by a Report Publisher to analyze data.

Note: If you do not select a role, no authorization is assigned to
the user. For more information, see the Longview Analysis and
Reporting Guide.

Designer
Service

Power
user

Viewer
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Data Access Authorizations

Authorization Description
Platform
License

Connect to
Application
Framework

Select this option to allow the user to connect to Longview
Application Framework.

Note: You must select this option to allow users to access
Longview Apps, Longview Designer, Longview tools and
editors, the Longview Add-In for Office, and Longview
Client

Admin

Designer

Power User

Viewer

Service

View Data Select this option to allow the user to view data.

Designer

Power User

Viewer

Service

Modify Data Select this option to allow the user to modify data.

Designer

Power User

Service

Delete
Comments

Select this option to allow the user to delete any existing comments in
the Data Server. Users without Delete Comments authorization can
delete only their own comments before they are submitted to the
database.

Note: Delete existing comments functionality is available in
Data Grids only.

Designer

Post Own JEs
(Review)

Select this option to allow the user to review post (temporarily post)
any journal entries that they create.

Designer

Power User

Service

Post Own JEs
(Permanent)

Select this option to allow the user to permanently post any journal
entries that they create.

Designer

Power User

Service

Delete Non-
Shared JEs

Select this option to allow the user to delete non-shared journal
entries.

Designer

Service

https://insightsoftware.com/


148

Authorization Description
Platform
License

Current
Period
Journal Entry

Select any of the following options to give the user authorization
related to current period journal entries:

n Create — Allows the user to create current period journal
entries.

n Review — Allows the user to review post (temporarily post)
current period journal entries.

n Post — Allows the user to permanently post current period
journal entries.

Designer

Power User

Service

Future Period
Journal Entry

Select any of the following options to give the user authorization
related to future period journal entries:

n Create — Allows the user to create future period journal
entries.

n Review — Allows the user to review post (temporarily post)
future period journal entries.

n Post — Allows the user to permanently post future period
journal entries.

Designer

Power User

Service

Prior Period
Journal Entry

Select any of the following options to give the user authorization
related to prior period journal entries:

n Create — Allows the user to create prior period journal
entries.

n Review — Allows the user to review post (temporarily post)
prior period journal entries.

n Post — Allows the user to permanently post prior period
journal entries.

Designer

Power User

Service

Restatement
Journal Entry

Select any of the following options to give the user authorization
related to restatement journal entries:

n Create — Allows the user to create restatement journal
entries.

n Review — Allows the user to review post (temporarily post)
restatement journal entries.

n Post — Allows the user to permanently post restatement
journal entries.

Designer

Power User

Service
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Maintenance Access Authorizations

Authorization Description
Platform

License

Batches and
Events

Select this option to give the user Batches and Events
authorization. Users with Batches and Events authorization can:

n view and delete batches and events in Longview
Application Administrator

n view and delete batches and events using the User
Submissions Tool or Longview Client

Users without Batches and Events authorization can:

n view batches and events using the User Submissions Tool
or Longview Client

For more information, see Working with batches.

Admin

Designer

Foreign
Exchange
Settings

Select this option to allow the group to manage foreign exchange
settings.

Admin

Designer

NDD Settings Select this option to allow the group to manage NDD settings. Designer

Intercompany
Eliminations

Select this option to allow the group to manage intercompany
eliminations. For more information, see Working with intercompany
eliminations.

Designer

Journal
Entries

Select this option to allow the group to access Longview Journal
Entries.

Designer

Locks

Select this option to give the group Locks authorization. Groups
with Locks authorization can delete any lock in the system with the
Data Locks tool, while groups without Locks authorization can
delete their own locks only. For more information, see Working with
locks.

Designer

Service

Rules
Select this option to allow the group to maintain Rules. For more
information, see Working with rules.

Designer

Service

Schedules
Select this option to allow the group to maintain Schedules. For
more information, see Working with schedules.

Designer

Service

Symbol
Access –
Roles

Allows the user to configure symbol access for symbol access
roles. For more information, see “Maintaining symbol access roles”.

Designer

Service
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Authorization Description
Platform

License

Symbol
Access –
Groups

Allows the user to configure symbol access for groups. This option
is unavailable unless Group Administration is selected in the Users
and Groups – Groups category

Note: Groups can give symbol access only at a level that
they themselves have. For example, if a group has read-
only access to the TENTITIES symbol with a level of 10,
they can give other users, groups, and roles only read-
only access to the TENTITIES symbol, with a level of 10
or lower. For more information, see Applying a symbol
access role to a group

Does not Apply

Symbol
Access –
Users

Allows the user to configure symbol access for users.

This option is unavailable unless User Administration and at least
one group are selected in the Users and Groups – Users category.

Does not Apply

System
Attributes

Select any of the following options to give the group authorization
related to system attributes:

n Create — Allows the group to create system attributes.

n Modify — Allows the group to modify system attributes.

n Delete — Allows the group to delete system attributes.

Designer

Service

Symbol
Attributes

Select any of the following options to give the user authorization
related to symbol attributes:

n Create — Allows the user to create symbol attributes.

n Modify — Allows the user to modify symbol attributes.

n Delete — Allows the user to delete symbol attributes.

Designer

Service

User
Attributes

Select any of the following options to give the user authorization
related to user attributes:

n Create — Allows the user to create user attributes.

n Modify — Allows the user to modify user attributes.

n Delete — Allows the user to delete user attributes.

Designer

Service
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Authorization Description
Platform

License

Symbols

Select any of the following options to give the user authorization
related to symbols:

Create — Allows the user to create symbols.

Modify — Allows the user to modify symbols.

Delete — Allows the user to delete symbols.

Designer

Service

Metadata
Audit Trail

Select any of the following options to give the user authorization
related to Metadata Audit Trail.

Export – Security related — Allows the user to export Metadata Audit
Trail information for security related activity. Security related activity
includes Authorization maintenance, Group maintenance, Group
Membership maintenance, Role maintenance and User
Maintenance.

Export – Non-Security related — Allows the user to export Metadata
Audit Trail information for non-security related activity such as
attribute maintenance.

Reset – Security related — Allows the user to reset Metadata Audit
Trail information for security related activity. Security related activity
includes Authorization maintenance, Group maintenance, Group
Membership maintenance, Role maintenance and User
Maintenance.

Reset – Non-Security related — Allows the user to export Metadata
Audit Trail information for non-security related activity such as
attribute maintenance.

Admin

Designer

Service

User and Groups – Group Category Authorizations

Note: If your system is configured to run on a non-ISW platform, the following authorizations
are applicable.
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Authorization Description

Group
Administration

Select this option to allow the group to add and modify groups in the Longview
system.

In Longview Tax, this allows the group to add and modify groups via the
UserGroups.csv import file and the User Groups editor.

Note: Groups can modify only authorizations that they themselves
have. For example, if a group does not have Longview Add-In for Office
authorization, they cannot modify that authorization in other users and
groups.

Authorizations can be set on both the User and the Group, unless the Longview system is
on the ISW platform, then authorizations can only be set on Users. When Longview is configured to be
on the platform, the authorizations are dependent on the type of user license the user has.

When the user is synchronized from the ISW platform and added to Longview, the authorizations are set
based on their user license however they can be modified to be less then what is provided by default.
Any authorizations that have been manually removed will not be reset upon future user
synchronizations.

Note: For systems on the ISW Platform, when a user belongs to a group with
authorizations configured, the user's individual authorizations are ignored and only the group
authorizations apply. If the group has no authorizations configured, the user's individual
authorizations are used instead. Any group authorizations that exceed what the user's license
permits are also ignored.

Users and Groups – Users Authorizations

Authorization Description

User
Administration

Select this option to allow the group to add and modify users in the Longview system.
In Longview Tax, this also allows the group to add and modify users via the Users.csv
import file.

If User Administration is selected and AllUsers is selected for Select Groups, this also
allows the group to access the Users editor and add and modify users. For more
information on AllUsers, see Understanding the AllUsers group.

Note: Groups can modify only authorizations that they themselves have. For
example, if a group does not have Longview Serve Manager authorization,
they cannot modify that authorization in other users and groups.
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Authorization Description

Reset
Passwords

If User Administration is selected, this option is automatically selected and cannot be
cleared.

Select this option to allow the group to reset user passwords in the Longview system.

In Longview Tax, this allows the group to reset user passwords via the Users.csv
import file.

If Reset Passwords is selected and AllUsers is selected for Select Groups, this also
allows the group to access the Users editor and reset user passwords. For more
information on AllUsers, see Understanding the AllUsers group.

Select Groups

This option is available only if User Administration or Reset Passwords are selected. In
addition, AllUsers is the only group available for this option.

Note: When you edit an existing group, the AllUsers group and the group
itself are available when User Administration or Reset Passwords are
selected. For more information, see Editing groups.

Select the AllUsers group to assign the selected authorization to the group for all users
in the system. For more information on AllUsers, see Understanding the AllUsers
group.

Granting Administrative Permissions
Depending on the size and organizational requirements of your business, you may need multiple users
to manage different aspects of your Longview system. Using Longview Application Administrator, you
can grant permissions to users to suit your needs.

There are two ways to grant permissions; you can grant a set of permissions to an individual user, or you
can grant a set of permissions to a group. All users in a group are granted the permissions assigned to
that group.

Administration rules
There are certain logical rules that apply to users with administrative permissions; in particularly to those
with permissions to grant administrative permissions to other users.

Assuming the following:

n Joe is a user in groups A, B, and D, and has user administration permissions in group A.

n Alice is a user in groups A and D.

n Tony is a user in groups C and D.

n Mike is a user in group C.

Joe is:

n able to administer user Alice, because they are both in group A together and Joe has user
administrative permissions for that group.
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n unable to administer Tony, even though they are both in group D, because Joe does not have
user administrative permissions for that group.

n unable to administer Mike because they share no groups whatsoever.

Because Joe has user administrative permissions for group A, he can grant Alice administrative
permissions for that group as well. He does not have to grant Alice all his permissions for that group,
although he may if he chooses to. However, one thing he cannot do is grant Alice any permissions that
he himself does not already have (nor can he grant them to himself), and he cannot grant Alice
administrative permissions in any group in which he himself does not have user administrative
permissions. For example, while Joe, Alice, and Tony are all in group D together, Joe does not have
user administrative permissions in that group, and so cannot give them any administrative permissions
in that group (note that the exact same rules apply to symbol access and symbol access roles).

If the group in which a user has user administration permissions is the AllUsers group, that user then can
administer all users in the system. However, that user with administrative permissions must still operate
within the limits of the permissions he himself has been granted: he cannot grant to other users’
permissions or symbol access that he himself does not possess.

Understanding the AllUsers group
The AllUsers group is a system-created group related specifically to administrative permissions.

The following rules apply to the AllUsers group:

n Users are automatically assigned to the AllUsers group when they are created and cannot be
removed from it.

n The AllUsers group cannot be deleted, and the group name and description cannot be
modified.

n The AllUsers group is not displayed in the Group list when you sign on to a Longview system.

n In Longview Client, the AllUsers group is a valid user group in only the User Administration and
Reset Passwords fields in the Users editor, and the Authorization Group field in the User_
Authorization.csv import file.

Granting administrative permissions to a user
This section explains the methods by which you can give users administrative permissions.

Adding administrative permissions to a user

To grant administrative permissions to an existing user directly, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Users and Groups and select Users. The list of users appears
in the Contents window.

3. Double-click the user for which you want to grant administrative permissions. The Properties dialog
for that user opens.
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4. Click the Authorization tab.

5. Use the expandable hierarchy in the left panel to choose areas of functionality. As each is selected,
the permissions pertaining to it are displayed in the right panel. Select or clear the appropriate check
boxes to grant or deny permissions to the user.

This process is highly flexible, and by its nature, virtually any permission can be considered
administrative in some capacity or other. However, there are some permissions that might be
considered core administrative permissions that grant access that would be critical to anyone
needing to administer aspects of the system. These include, but are not necessarily limited to, the
following:

a. Application Administrator: Allow Access

b. Server Manager: Allow Access, Start/Stop Servers, Turn On/Off Dynamic Calculations

c. Users and Groups - Groups: Group Administration

Note: Users may have symbol access for the Administrator Role to be able to
perform Group Administration.

d. Users and Groups - Users: User Administration, Reset Passwords, Select Groups (for which
the user will have administration)

Note: Groups are unavailable if the user is not a member. Groups must have symbol
access for the Administrator Role to be able to perform User Administration.

6. When you have finished adding permissions to the user, click OK.

For more information on the complete range of available permissions, see Creating Users.
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Adding a user to an administrative group

To grant administrative permissions to an existing user by adding that user to a group with
administrative permissions, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Users and Groups and select Users. The list of users appears
in the Contents window.

3. Double-click the user for which you want to grant administrative permissions. The Properties dialog
for that user opens.

4. Click the Groups tab. A list of the available groups appears.

5. Select a group that has administrative permissions to add the user to that group.

6. Click OK. The user is added to the group and inherits the administrative permissions of the group.

Granting administrative permissions to a group
This section explains the methods by which you can give groups administrative permissions.

Note: To create a new group instead, follow the steps listed in Creating Groups.

Adding permissions to a group

To grant administrative permissions to an existing group, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Users and Groups, and select Groups. The list of groups
appears in the Contents window.

3. Double-click the group you want to work with. The properties dialog opens.
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4. Click the Authorization tab.

5. Use the expandable hierarchy in the left panel to choose areas of functionality. Permissions for
each category are listed in the right panel. Select or clear the appropriate check boxes to grant or
deny permissions to the group.

This process is highly flexible, and by its nature, virtually any permission can be considered
administrative in some capacity or other. However, there are some permissions that might be
considered core administrative permissions that grant access that would be critical to anyone
needing to administer aspects of the system. These include, but are not necessarily limited to, the
following:

a. Application Administrator: Allow Access

b. Server Manager: Allow Access, Start/Stop Servers, Turn On/Off Dynamic Calculations

c. Users and Groups - Groups: Group Administration

Note: Users may have symbol access for the Administrator Role to be able to
perform Group Administration.

d. Users and Groups - Users: User Administration, Reset Passwords, Select Groups (for which
the user will have administration)

Note: Groups must have symbol access for the Administrator Role to be able to
perform User Administration.

6. When you have finished adding permissions to the group, click OK.

For more information on the complete range of available permissions, see Creating Groups.
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Adding users to the group

To add users to the group and provide them with its administrative permissions, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Users and Groups, and select Groups. The list of groups
appears in the Contents window.

3. Double-click the group to add users. The Properties dialog opens.

4. Click the Users tab.

5. Select the users you want to add to the group.

6. When you are finished adding users, click OK.

Administration Rules
There are certain logical rules that apply to users with administrative permissions; in particularly to those
with permissions to grant administrative permissions to other users.

Assuming the following:

n Joe is a user in groups A, B, and D, and has user administration permissions in group A.

n Alice is a user in groups A and D.

n Tony is a user in groups C and D.

n Mike is a user in group C.

Joe is:
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n able to administer user Alice, because they are both in group A together and Joe has user
administrative permissions for that group.

n unable to administer Tony, even though they are both in group D, because Joe does not have
user administrative permissions for that group.

n unable to administer Mike because they share no groups whatsoever.

Because Joe has user administrative permissions for group A, he can grant Alice administrative
permissions for that group as well. He does not have to grant Alice all his permissions for that group,
although he may if he chooses to. However, one thing he cannot do is grant Alice any permissions that
he himself does not already have (nor can he grant them to himself), and he cannot grant Alice
administrative permissions in any group in which he himself does not have user administrative
permissions. For example, while Joe, Alice, and Tony are all in group D together, Joe does not have
user administrative permissions in that group, and so cannot give them any administrative permissions
in that group (note that the exact same rules apply to symbol access and symbol access roles).

If the group in which a user has user administration permissions is the AllUsers group, that user then can
administer all users in the system. However, that user with administrative permissions must still operate
within the limits of the permissions he himself has been granted: he cannot grant to other users’
permissions or symbol access that he himself does not possess.

Understanding the AllUsers group
The AllUsers group is a system-created group related specifically to administrative permissions.

The following rules apply to the AllUsers group:

n Users are automatically assigned to the AllUsers group when they are created and cannot be
removed from it.

n The AllUsers group cannot be deleted, and the group name and description cannot be
modified.

n The AllUsers group is not displayed in the Group list when you sign on to a Longview system.

n In Longview Client, the AllUsers group is a valid user group in only the User Administration and
Reset Passwords fields in the Users editor, and the Authorization Group field in the User_
Authorization.csv import file.
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Working With Schedules
A schedule is the concept of one or more extra dimensions, designed to store additional information on a
particular cell in the Longview database.

Understanding schedules
In the following illustration, the large cube in the center represents the database with its basic
dimensions. Each of the smaller areas represents a schedule for a particular intersection in the
database. Some schedules contain only one additional dimension; others contain two or more.

You may want to create schedules to provide extra detail for a wide variety of items, including:

n intercompany transactions

n taxes

n inventory

n property, plant, and equipment information

n meals and entertainment expenses

For example, you may have a symbol in your database for Accounts Receivable. That cell stores a total
value, but you may want to store additional information on the values that combine to produce that total,
i.e., days outstanding, client or customer. To store that additional information, you define one or more
extra dimensions in a schedule.

https://insightsoftware.com/


161

Preparing schedule definitions
A schedule definition is the criteria, defined in the Longview database, used to identify extra dimensions
for a particular cell in the Longview database.

Creating a schedule definition
To create a schedule definition, follow these steps:

1. Open Longview Application Administrator.

2. Choose File > New > Schedule. The New Schedule dialog opens.

3. Complete these fields:

Field Description

Name
Type a name for the schedule definition. The name can contain a maximum of 31
characters.

Description

Type a description for the schedule definition. The description can contain a
maximum of 255 characters.

Note: To add descriptions in languages other than the default language,
click the icon adjacent to the Description field, causing the Descriptions
dialog to display. For more information, see Adding an alternate language
description.
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Field Description

Schedule
Type

Select the type of schedule definition:

n Standard — All other schedule definitions.

n Intercompany — Schedule definitions related to intercompany eliminations.

n Static — Permits data or text input to parent symbol intersections. Data does
not rollup.

Rollup
Dimensions

Select the base dimensions in which you want the data to rollup.

4. To add extra dimensions to the schedule, click Add. The Schedule Dimension dialog appears.

5. Complete the following fields:

Field Description

Name
Type a name for the Schedule Dimension. The name can contain a maximum of 31
characters.

Description

Type a description for the Schedule Dimension. The description can contain a
maximum of 31 characters.

Note: For information on adding descriptions in languages other than the
default language, see Adding an alternate language description.
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Field Description

Dimension
Type

Select the type of schedule dimension:

n Mirror — In this type of schedule dimension, you can select a base
dimension that you want your schedule dimension to mirror. The schedule
dimension will contain a symbol for each of the symbols in the base
dimension. When you subsequently create a new symbol in the base
dimension, it will also exist in this schedule dimension.

n Numeric — Use this dimension type to specify symbols that you want to
appear in the schedule for the schedule dimension.

n Custom — Use this dimension type to create your own set of schedule
symbols.

Sort
Symbols By

Select one of the options (Name, Description, or Unsorted). The default setting is
Unsorted.

Offset
Dimension

For Intercompany schedules only. Select to use an Offset dimension.

Fixed
Symbol

For Intercompany schedules only. Type the Fixed dimension symbol. This option is
unavailable if Offset Dimension is selected.

Note: To finish creating your schedule definition, complete the settings for the dimension
(s) you have selected as described in Settings for dimension type Mirror, Settings for
dimension type Numeric, and Settings for dimension type Custom (Simple Symbol).

Settings for dimension type Mirror
To specify settings for dimension type Mirror, follow these steps:

1. Select a dimension from the Category list. The symbols for your selection populate the field to the
right.

2. Select the root symbol for your dimension. You can click the plus ( + ) signs to expand the hierarchy
or click the Search icon to locate a symbol in a complex hierarchy.
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3. Set the following settings:

Settings Description

Select entire
dimension

Select this option if you want to include the whole dimension, rather than just a
root symbol.

Include leaf
symbols only

Select this option if you do not want parent symbols to be included in the
dimension for the purposes of the schedule.

Filter by symbol
attribute

Select this option if you want to limit symbol selection to a particular value in a
particular attribute.

Symbol
attribute name

If you select Filter by symbol attribute, you must use this list to choose an
attribute.

Symbol
attribute value

If you select Filter by symbol attribute, you can use this field to supply a value for
the attribute used for the purposes of matching.

4. Click OK. Your dimension is added to the schedule.

Settings for dimension type Numeric
To specify settings for dimension type Numeric, follow these steps:

1. Use the From and To fields to set the range of symbols included.

2. Select Pad Symbols if you want zeros to be prefixed to numbers as ranges rise by a magnitude of
ten (that is, "9" becomes "09" when the range extends to 10, to "009" then it extends to 100, and so
on).

3. When you are finished, click OK. Your dimension is added to the schedule.

Settings for dimension type Custom (Simple Symbol)
To specify settings for dimension type Custom, follow these steps:

1. In the Settings area, click in the Name field.
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2. Type a name for the schedule symbol in the default system language. Names must begin with a
letter.

Note: The Description is populated automatically using the Schedule Dimension name
and the name you just typed.

3. When you have finished adding schedule symbols, click OK. Your dimension is added to the
schedule.

Note: The maximum number of symbols that can be added is 23.

4. When you have finished setting up your schedule, click OK. Your settings are saved, and your new
schedule appears in the Contents window.

Adding an alternate language description
Schedules and their dimensions have optional definitions. The first definition you can enter is in the
default language for your instance of the application. You can also add a default language description in
an alternate language where you find the alternate language description icon.

To add an alternative language description, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Schedules. A list of the schedules currently existing in the server
appears in the Contents window.

3. Right-click the schedule for which you want to add the alternate language description and choose
Properties. The Properties dialog opens for the selected schedule.

4. Click the alternate language description icon adjacent to the Description field of a schedule or open
a schedule dimension dialog by selecting a dimension from the list and clicking Edit, if available.

https://insightsoftware.com/


166

5. Click in the Language field to use the drop-down list to select your alternate language. The list
displays the two-letter international abbreviations for world languages.

6. Enter the new description in the appropriate language.

7. Click OK.

Editing a schedule
Existing schedules can be modified to extend their usefulness, or to change aspects of their setup.

To edit a schedule, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Schedules. A list of the schedules currently existing in the server
appears in the Contents window.

3. Right-click the schedule you want to change and choose Properties. The Properties dialog opens
for the selected schedule.

4. Edit the schedule as required. For more information on settings, see Creating a schedule definition.

Note: Some out-of-the-box schedules cannot be modified.

5. When you have finished editing the schedule, click OK. Your changes are saved.

Deleting a schedule
To delete a schedule definition, follow these steps:
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1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Schedules. A list of the schedules currently existing in the server
appears in the Contents window.

3. Right-click the schedule you want to delete and select Delete. A confirmation dialog opens.

Caution: If you delete a schedule, it cannot be recovered. To restore a deleted schedule
to the system, it must be recreated. Use this function with caution.

4. Click Yes. The schedule is deleted.
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Working With Foreign Exchange
If your company does business in different countries, you likely need to have consolidated financial
information expressed in one or more reporting currencies. You can use the data translation
functionality to handle complex foreign exchange.

To use currency translation in your system, you must prepare and define the related parameters. If
users try to input or import amounts before the system has been properly prepared, translated amounts
appear as zeros.

Authorizations Can...

Maintenance
Access

Data Access

Foreign Exchange Settings
View Data

View data

Maintenance
Access

Foreign Exchange Settings

Symbols - Create

Symbols - Modify

Symbols - Delete

View data and change data in the Foreign Exchange
Setup table

Data Access
View Data

Modify Data

Understanding accounts and foreign exchange
While any account can be configured to translate, only accounts with a balance type of Credit or Debit
affect translation adjustment. It is important to ensure that only accounts that are part of the trial balance
are set with a balance type of Debit or Credit. Also, the CTA and TA accounts must also have a balance
type of Debit or Credit.

n Understanding CTA and TA Accounts

n Understanding Operations Type

Understanding CTA and TA Accounts
The ZFXAccountsCTA symbol attribute determines the account that is designated as CTA. CTA
(Cumulative Translation Adjustment) records the cumulative impact of changing exchange rates as part
of equity (or cumulative comprehensive income). TA (Translation Adjustment) records the current period
impact of changing exchange rates as part of profit and loss (for the Operations Type Integrated) or as
part of comprehensive income (for the Operations Type Self Sustaining).

For the Self-Sustaining Operations Type, both CTA and TA accounts must be configured. The TA
account must not be included in any retained earnings calculation.

For Integrated Operations Type, only the TA account must be configured. The TA account is included in
any retained earnings calculation.
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Understanding Operations Type
The Operations Type setting is used to reduce the need to manually specify some of the settings related
to foreign exchange and to better handle treatment of certain types of accounts in different scenarios.

Self-Sustaining
Self-sustaining is the Operations Type associated with the current method. This method generally
treats accounts as follows.

Account Treatment

Assets Current

Liabilities Current

Equity Historical

Profit & Loss Historical

Integrated
Integrated is the Operations Type associated with the temporal method. This method generally treats
accounts as follows:

Account Treated as...

Current Assets Current

Long-term Assets Historical

Current Liabilities Current

Long-term Liabilities Historical

Equity Historical

Profit & Loss Historical

Understanding foreign exchange account types
The ZFXAccountType symbol attribute determines an account’s foreign exchange account type. If your
company is using currency translation, you must set the value for this attribute for each relevant
account.

You can set ZFXAccountType to one of the following values:

n Monetary

n Equity

n NonMonetary

n LongTermMonetary

n RevenueExpense

For information on setting this attribute, see Specifying foreign exchange account type.
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Longview treats accounts in the following ways during translation:

n Current — Accounts are translated based on the current balance at the specified rate (Balance
* Effective Rate).

n Historical — Accounts are translated based on the current balance at a blended historical rate.
This is achieved by translating the current activity at the specified rate (Translated Value in
Prior Period + Change in Balance * Effective Rate).

The Effective Rate is the rate used to translate the account in the period. This could be the rate as
specified in the account translation table or an override rate. The Period End Rate is the rate specified
by the SFXPeriodEndRate system attribute. For more information on setting these rates, see Setting
attributes for Foreign Exchange.

Monetary
This is the default setting for all carryforward accounts.

Recommended configuration:

Setting Value Additional Requirements

Method Tables > Account
Translation

Period End Rate

Cumulative Translation
Adjustment Account (CTAA)

Use this to force a monetary account to
use historical treatment.

ZFXAccountsCTA is set

SFXAllowMonetaryCTA
is set to TRUE

Treatment:

Operations Type Treatment

Self-Sustaining Current

Integrated Current

Self-Sustaining with CTAA and Additional Requirements Historical

Integrated with CTAA Historical

Equity
This is the typical setting for all equity accounts (for example, capital stock and retained earnings). This
setting differs from other historical treatment settings in that these accounts do not generate translation
adjustment between periods unless the effective rate is not the period end rate.

Recommended configuration:

Setting Value

Account Translation Table Period End Rate

Cumulative Translation Adjustment Account
(CTAA)

The value for ZFXAccountsCTA has no impact in this
case.
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Treatment:

Operations Type Treatment

Self-Sustaining Historical

Integrated Historical

NonMonetary
This is the typical setting for all non-monetary assets (for example, priority plant and equipment) and
non-monetary liabilities (for example, long term bonds). The Cumulative Translation Adjustment
Account is ignored when the operation type is Integrated (there will be no values generated in the CTAA
account regardless of the attribute set up).

Recommended configuration:

Setting Value

Account Translation Table Period End Rate

Cumulative Translation Adjustment
Account (CTAA)

Often set for property, plant, and equipment accounts which are
detailed as a continuity.

Treatment:

Operation Type Treatment

Self-Sustaining with CTAA Historical

Self-Sustaining Current

Integrated Historical

LongTermMonetary
This is special setting used only in cases where translation adjustment is recorded in a separate account
when using the Integrated operations type. The Cumulative Translation Adjustment Account is ignored
when the operation type is Self-Sustaining (there will be no values generated in the CTAA account
regardless of the attribute set up).

Recommended configuration:

Setting Value

Account Translation Table Period End Rate

Cumulative Translation Adjustment
Account (CTAA)

Often set to record the translation adjustment related in
another account.

Treatment:
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Operation Type Treatment

Self-Sustaining Current

Integrated with CTAA Historical

Integrated Current

RevenueExpense
This is the default setting for all standard accounts, typically profit and loss, so there is no need to set the
account type attribute for these accounts.

Recommended configuration:

Setting Value

Account Translation Table Average Rate

Cumulative Translation Adjustment Account
(CTAA)

The value for ZFXAccountsCTA has no impact in this
case.

Treatment

Operation Type Treatment

Self-Sustaining Historical

Integrated Historical

Understanding translation settings tables
This following table outlines where the translation setting tables data is stored. You can access
translation setting tables data using Application Administrator or any other interface that allows you to
view or modify data (import functionality, Longview Analysis and Reporting).

To take advantage of being able to set entity translation and account translation settings at a parent
level, ensure the intersection is static. Usually, setting the default accounts dimension symbol to static is
a good practice.

Table Description Specific Dimension Symbols Value

Entity
Translation

Configures which accounts translate, in
which translation method, and using which
translation rate

Accounts

Currencies

Name of
the
translation
rate
Accounts
symbol
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Table Description Specific Dimension Symbols Value

Account
Translation

Configures which accounts translate, in
which translation method, and using which
translation rate

Accounts

Currencies

Name of
the

translation
rate
Accounts
symbol

Default
Global
Rates

Stores the default global rates for each
currency translation.  These rates are used
when dimension specific global rates are not
in use or when dimension specific global
rates are in use and no rate value exists for
the symbol in the specified dimension(s).

Accounts

Time periods

Currencies

The
exchange
rate

Default
Entity
Rates

This table stores the default entity specific
rates for each currency translation.  These
rates are used when dimension specific
entity rates are not in use or when
dimension specific entity rates are in use
and no rate value exists for the symbol in the
specified dimension(s).

Accounts

Time periods

Entities

Currencies

The
exchange
rate

Default
Override
Rates

This table stores the default entity specific
rates for each currency translation.  These
rates are used when dimension specific
entity rates are not in use or when
dimension specific entity rates are in use
and no rate value exists for the symbol in the
specified dimension(s).

Accounts

Time periods

Entities

Currencies

The
exchange
rate

Dimension
Specific
Global
Rates

This table stores the dimension specific
global rates for each currency translation. 
These rates are used when dimension
specific global rates are in use and a rate
value exists for the symbol in the specified
dimension(s).

Accounts

Time periods

Currencies

Dimensions specified in
Additional Global Rate
Dimensions
(SFXGlobalRateDimensions)

The
exchange
rate

Dimension
Specific
Entity
Rates

This table stores the dimension specific
entity specific rates for each currency
translation.  These rates are when
dimension specific entity rates are in use
and a rate value exists for the symbol in the
specified dimension(s).

Accounts

Time periods

Entities

Currencies

Dimensions specified in
Additional Global Rate
Dimensions
(SFXGlobalRateDimensions)

The
exchange
rate
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Table Description Specific Dimension Symbols Value

Dimension
Specific
Override
Rates

This table stores the dimension specific
override rates for each account and
currency translation.  These rates are used
when dimension specific override rates are
in use and a rate value exists for the symbol
in the specified dimension(s).

Accounts

Time periods

Entities

Currencies

Dimensions specified in
Additional Override Rate
Dimensions
(SFXOverrideRateDimensions)

The
exchange
rate

Understanding alternative configurations for
foreign exchange
This section explains the different foreign exchange configurations you can use with Longview
Application Administrator: the traditional method, and the alternative configuration.

n Data translation: traditional configuration, used by Longview Tax

n Data translation: alternative configuration, used by Longview Close

Data translation: traditional configuration
In the traditional currency setup, each reporting currency requires a parent symbol containing the total
values in that currency — for example, TUSD. The total value in the parent symbol can come from one
or both of the following sources:

n source currency, as input by users

n server-calculated currency translated from other source currency, for example:

n TUSD is total U.S. dollars and the sum of source currency symbol USD, and server translated
symbols USDCAD, and USDCEUR.

n USDCAD is U.S. dollars, translated from CAD, Canadian source dollars

n USDEUR is U.S. dollars, translated from EUR, euro source dollars

You may choose to use the traditional method for several reasons:

n if you want to understand where all data is coming from, and isolate translation effects
independent of source currency (at a consolidated level)

n if you have complex translation requirements (in particular, multiple functional currencies on a
single entity)
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Data translation: alternative configuration
Instead of having one currency symbols for each translation to the same currency, you can use only one
source currency symbol and one translated currency symbol per currency in most cases. Each reporting
currency requires a parent symbol containing the total values in that currency — for example, USDT.
The total value in the parent symbol can come from one or both of the following sources:

n source currency, as input by users

n server-calculated currency translated from other source currency, for example:

n USDT is total U.S. dollars and is the sum of source currency symbol USD, and server
translated symbol USDFX.

For example:

n CAD translated to USDFX

n USD translated to CADFX

n GBP translated to USDFX

With the alternative configuration, ensure user access and template design correctly reflects proper
currency access. Only one functional currency per entity is permitted.

Use the alternative configuration:

n when you want currencies to be more intuitive for end users

n when you want easier configuration and manipulation of data for input and comparative
reporting

Setting attributes for Foreign Exchange
The following general system attributes must be set before you can properly configure and use Foreign
Exchange:

Attribute Description Value

SGPAccountsDimension
Accounts
Dimension

Set the value of this attribute to the name of the dimension
that holds accounts.

SGPCurrencyDimension
Currency
Dimension

Set the value of this attribute to the name of the dimension
that holds currencies.

SGPCurrentPeriod
Current
Period

Set the value of this attribute to the name of the time period
symbol that represents the current period.

SGPCurrentYear
Current
Year

Set the value of this attribute to the name of the time period
symbol that represents the current year. This symbol must
be a parent of the symbol specified for SGPCurrentPeriod.
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Attribute Description Value

SGPDimensionDefaults

List of
Dimension
FixTo
Symbols

Set the value of this attribute to the default symbol to use
for each dimension.

SGPEntitiesDimension
Entities
Dimension

Set the value of this attribute to the name of the dimension
that holds entities.

SGPTimePeriodsActivity
List of Non-
YTD Roots

Set the value of this attribute to the name of the parent
symbols that hold period activity symbols. Do not include
open periods.

SGPTimePeriodsDimension
Time
Period
Dimension

Set the value of this attribute to the name of the dimension
that holds time periods.

SGPTimePeriodsYTD
List of YTD
Roots

Set the value of this attribute to the

name of the parent symbols that hold year-to-date symbols.
Do not include open periods.

SPACPairs
List of
PAC/YTD
Pairs

Set the value of this attribute to the list of pairs of year-to-
date and period activity symbols using the following format:

YTDsymbol;PACsymbol

The specified symbols must be included in
SGPTimePeriodsYTD and SGPTimePeriodsActivity, as
appropriate.

The following Foreign Exchange-specific system attributes must be set before you can properly
configure and use Foreign Exchange:

Attribute Description Value

SFXAccounts
BalanceSheet

Balance Sheet
Account

If you are planning to use translation rounding, set this
attribute to the list of balance sheet account parent symbols.

SFXAccounts
RoundingError

Rounding Error
Account

If you are planning to use translation rounding, set this
attribute to the account that you want to use to hold rounding
differences.

SFXAllowMonetary
CTAA

Allow Monetary
Accounts to
Generate
Account-Specific
CTA

TRUE or FALSE. The default value for this attribute is
FALSE.

SFXElim
Do Elimination
Translation

If intercompany transactions will be entered in functional
currency and need to be eliminated in translated currencies
as well, set the value of this attribute to TRUE.

If you set this attribute to TRUE, you must also set the values
for SFXSchedule to TRUE
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Attribute Description Value

SFXMethods
Translation
Method List

For more information, see Configuring Translation methods.

SFXOverride
RateDimensions

Additional
Override Rate
Dimensions

Use this attribute to define dimensions used to specify
dimension specific override rates.  For example, to use
different override rates by budget scenario.

SFXPeriodEndRate
Period End Rate
Symbol

Set the value for this attribute to the account that holds the
period end rate. This rate is used in translation adjustment
and gain/loss calculations.

SFXRates
Rate Accounts
List

Set the value of this attribute to the parent account of the
foreign exchange rates in the Accounts dimension.

SFXSchedule
Do Schedule
Translation

If you want to translate Schedule Data, set the value for this
attribute to TRUE.

SFXTimePeriod
Symbols

Time Period
Translation Roots

Set the value for this attribute to the parent symbols of the
Time Period symbols to translate. You should include the
open (current) period and period activity symbols for each
year.

In some cases, you may instead specify the year-to-date
symbols. For information on this customization, contact your
Professional Services representative.

SFXTranslationAdj
Do Detail CTA
Calculation

If you want to calculate detailed translation gains/losses for
each account, set the value of this attribute to TRUE. You
must set this attribute to TRUE to generate cumulative
translation adjustments.

SFXTranslations
Translation
Currency Root

Set the value of this attribute to the parent of the translation
symbols in the currencies dimension. These symbols will hold
the actual rates for each combination of source and target
currency.

For information on currencies, see Configuring Currency
translations.

Setting symbols in foreign exchange
This section explains how to designate symbols to use for foreign exchange. You can set translation
methods, currency translations, and exchange rates.

For more information, see the following sections:

n Configuring Translation methods

n Configuring Currency translations

n Configuring Foreign exchange rates

Configuring Translation methods
To set foreign exchange translation methods, follow these steps:
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1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. In the Foreign Exchange Setup dialog, select Translation Methods.

4. In the Name column, enter a name for the method.

Translation
method Description

Temporal
Mainly used in Canada and Europe, this method uses the historical rate and value of
assets at the time of acquisition. Gain/loss goes to the Income Statement.

Current
Widely used in the U.S., this method uses the month end data translation rate.
Gain/loss goes to the equity section of the Balance Sheet.

5. Click in the Translation Adjustment Account column to activate the symbol selector button ( ... ).
Click the button. An account selection dialog appears.

6. Select the translation adjustment account from the list of available accounts and click OK. The
selected account is placed in the column.

7. In the Operations Type column, use the drop-down list to select how the various account types are
handled by foreign exchange. The choices are:

l Self-sustaining

l Integrated

Note: Operations Type choices are also affected by the Translation Method used. For
more information Operations Type, see Understanding Operations Type.

8. When you are finished adding or modifying translation methods, click OK to save your work and
close the dialog.
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Configuring Currency translations
To set foreign exchange currency translations, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. In the Foreign Exchange Setup dialog, select Currency Translations.

4. In the Name column, enter a name for the currency translation using the convention
TTargetCurrencySouceCurrency.

5. In the Description column, enter a description for the currency translation using the convention
Target Currency from Source Currency. For example, CAD from GBP.

6. When you are finished adding or modifying currency translations, click OK to save your work and
close the dialog.

Configuring Foreign exchange rates
To set foreign exchange rates, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.
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3. In the Foreign Exchange Setup dialog, select Foreign Exchange Rates.

4. In the Name column, type a name for the foreign exchange rate type.

5. In the Description column, type a description for the foreign exchange rate type.

6. In the Type column, use the drop-down list to select the type. The choices are:

l Global: If the rate varies by time and currency only (for example, a period end rate).

l Entity: If the rate varies by time, currency, and entity (for example, a proportionate ownership
rate).

7. When you are finished adding or modifying exchange rate types, click OK to save your work and
close the dialog.

Configuring parameters in foreign exchange
This section explains how to set parameters in foreign exchange. You can set Entity translations and
Account translations.

Configuring Entity Translation
To set entity translations, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.
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3. In the Foreign Exchange Setup dialog, select Entity Translation.

4. Click in the Entity column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. The Select ENTITIES Symbol dialog appears.

6. Select the entity from the list of available entities and click OK. The selected entity appears in the
Entity column.

7. Click in the Currency column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. The Select CURRENCY Symbol dialog appears.

9. Select the currency from the list and click OK. The selected currency appears in the Currency
column.

10. Click in the Translation Method column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the translation method from the list of available methods and click OK. The selected method
appears in the Translation Method column.

13. When you are finished adding or modifying method assignments, click OK to save your work and
close the dialog.

Configuring Account Translation
To set account translations, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.
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3. In the Foreign Exchange Setup dialog, select Account Translation.

4. Click in the Account column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. The Select ACCOUNTS Symbol dialog appears.

6. Select the account from the list of available accounts and click OK. The selected account appears in
the Accounts column.

7. Click in the Translation Method column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the translation method from the list of available methods and click OK. The selected method
appears in the Translation Method column.

10. Click in the Foreign Exchange Rate column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the rate from the list and click OK. The selected rate appears in the Foreign Exchange Rate
column.

13. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.

Specifying foreign exchange rates
This section explains how to set rates to be used in foreign exchange. You can set global rates, Entity
rates, and override rates.

Specifying global rates
To set global rates, follow these steps:
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1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. In the Foreign Exchange Setup dialog, select Global Rates.

4. Click in the Foreign Exchange Rate column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.

6. Select the rate from the list and click OK. The selected rate appears in the Foreign Exchange Rate
column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period appears in the Time
Period column.

10. Click in the Currency Translation column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

13. In the Rate column, enter a rate for the exchange in the cell for the current row.

14. When you are finished adding or modifying rows in Global Rates, click OK to save your work and
close the dialog.

Specifying Entity Rates
To set entity rates, follow these steps:

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.
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3. In the Foreign Exchange Setup dialog, select Entity Rates.

4. Click in the Foreign Exchange Rate column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.

6. Select the rate from the list and click OK. The selected rate appears in the Foreign Exchange Rate
column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period appears in the Time
Period column.

10. Click in the Entity column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the entity from the list of available entities and click OK. The selected entity appears in the
Entity column.

13. Click in the Currency Translation column to activate the symbol selector button ( ... ).

14. Click the symbol selector button. A selection dialog appears.

15. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

16. In the Rate column, enter a rate for the exchange in the cell for the current row.

17. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.

Specifying override rates
To set override rates, follow these steps:
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1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. In the Foreign Exchange Setup dialog, select Override Rates.

4. Click in the Account column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.

6. Select the account from the list of available accounts and click OK. The selected account appears in
the Account column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period appears in the Time
Period column.

10. Click in the Entity column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the entity from the list of available entities and click OK. The selected entity appears in the
Entity column.

13. Click in the Currency Translation column to activate the symbol selector button ( ... ).

14. Click the symbol selector button. A selection dialog appears.

15. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

16. In the Rate column, enter a rate for the exchange in the cell for the current row.

17. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.
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Setting rates for specific dimensions
It is possible to set translation rates for specific symbols in additional dimensions of your own choosing.
This involves specifying those dimensions in two attributes to access the function for those dimensions:

Attribute Description

SFXGlobalRateDimensions
The dimension(s) used as values for this attribute enable you to set
rates for those dimensions for the Dimension Specific Global Rates
and Entity Rates.

SFXOverrideRateDimensions
The dimension(s) used as values for this attribute enable you to set
rates for those dimensions for the Dimension Specific Override Rates.

Setting the SFXGlobalRateDimensions attribute
To set dimensional values for the Global and Entity Rate attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes, and select System. A list of all the System attributes
appears in the Contents window.

3. Navigate to the SFXGlobalRateDimensions attribute, and right-click it. A pop-up menu appears.

4. Select Set Value. The Attribute Values dialog opens.

5. In the Enter New Value field, type the name of the dimension for which you want to set global and
entity rates.

6. Click Add to list to enter the value. Repeat step 5 to add other dimensions if desired.

7. Optionally, you can select a value in the value list and use the arrow buttons to move it up and down
in the list, and the delete button to remove the value from the list.
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8. When you have finished assigning the value(s), click Apply to save your changes.

9. Click OK. The Attribute Values dialog closes.

Setting the SFXOverrideRateDimensions attribute
To set dimensional values for the Override Rate attribute, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, expand Attributes, and select System. A list of all the System attributes
appears in the Contents window.

3. Navigate to the SFXOverrideRateDimensions attribute, and right-click it. A pop-up menu appears.

4. Select Set value. The Attribute Values dialog opens.

5. In the Enter New Value field, type the name of the dimension for which you want to set the override
rate.

6. Click Add to list to enter the value. Repeat step 5 to add other dimensions if desired.

7. Optionally, you can select a value in the value list, and use the arrow buttons to move it up and down
in the list and the delete button to remove the value from the list.

8. When you have finished assigning the value(s), click Apply to save your changes.

9. Click OK. The Attribute Values dialog closes.

Setting the dimension-specific Global Rates
To set the Global Rate for a specific dimension, follow these steps:

Note: This procedure assumes you have completed the setup of this feature as explained in
Setting the SFXGlobalRateDimensions attribute.
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1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. Under Dimension Specific in the Foreign Exchange Setup dialog, select Global Rates.

4. Click in the Foreign Exchange Rate column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.

6. Select the rate from the list and click OK. The selected rate appears in the Foreign Exchange Rate
column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period appears in the Time
Period column.

10. Click in the Currency Translation column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

13. The subsequent columns prior to Rates, if any, will have the name of the dimension or dimensions
set in the SFXGlobalRateDimensions attribute. Click in the dimension’s column to activate the
symbol selector button ( ... ).

14. Click the symbol selector button. A selection dialog for that dimension appears.

15. Select the symbol from the list and click OK. The selected symbol appears in the dimension column.

16. Repeat step 13 to step 15 for other dimensions, if any.

17. In the Rate column, enter a rate for the exchange in the cell for the current row.
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18. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.

Setting the dimension-specific Entity Rates
To set the Entity Rate for a specific dimension, follow these steps:

Note: This procedure assumes you have completed the setup of this feature as explained in
Setting the SFXGlobalRateDimensions attribute.

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. Under Dimension Specific in the Foreign Exchange Setup dialog, select Entity Rates.

4. Click in the Foreign Exchange Rate column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.

6. Select the rate from the list and click OK. The selected rate appears in the Foreign Exchange Rate
column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period appears in the Time
Period column.

10. Click in the Entity column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the entity from the list of available entities and click OK. The selected entity appears in the
Entity column.
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13. Click in the Currency Translation column to activate the symbol selector button ( ... ).

14. Click the symbol selector button. A selection dialog appears.

15. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

16. The subsequent columns prior to Rates, if any, will have the name of the dimension or dimensions
set in the SFXGlobalRateDimensions attribute. Click in the dimension’s column to activate the
symbol selector button ( ... ).

17. Click the symbol selector button. A symbol selection dialog for that dimension appears.

18. Select the symbol from the list and click OK. The selected symbol appears in the dimension column.

19. Repeat step 16 to step 18 for other dimensions, if any.

20. In the Rate column, enter a rate for the exchange in the cell for the current row.

21. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.

Setting the dimension-specific Override Rates
To set Override Rates for a specific dimension, follow these steps:

Note: This procedure assumes you have completed the setup of this feature as explained in
Setting the SFXOverrideRateDimensions attribute.

1. Open Longview Application Administrator.

2. Select Tools > Foreign Exchange Setup. The Foreign Exchange Setup dialog opens.

3. Under Dimension Specific in the Foreign Exchange Setup dialog, select Override Rates.

4. Click in the Account column to activate the symbol selector button ( ... ).

5. Click the symbol selector button. A selection dialog appears.
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6. Select the account from the list of available accounts and click OK. The selected account appears in
the Accounts column.

7. Click in the Time Period column to activate the symbol selector button ( ... ).

8. Click the symbol selector button. A selection dialog appears.

9. Select the time period from the list and click OK. The selected time period is placed in the column.

10. Click in the Entity column to activate the symbol selector button ( ... ).

11. Click the symbol selector button. A selection dialog appears.

12. Select the entity from the list of available entities and click OK. The selected entity appears in the
Entity column.

13. Click in the Currency Translation column to activate the symbol selector button ( ... ).

14. Click the symbol selector button. A selection dialog appears.

15. Select the currency translation method from the list and click OK. The selected method appears in
the Currency Translation column.

16. The subsequent columns prior to Rates, if any, will have the name of the dimension or dimensions
set in the SFXOverrideRateDimensions attribute. Click in the dimension’s column to activate the
symbol selector button ( ... ).

17. Click the symbol selector button. A symbol selection dialog for that dimension appears.

18. Select the symbol from the list and click OK. The selected symbol appears in the dimension column.

19. Repeat step 16 to step 18 for other dimensions, if any.

20. In the Rate column, enter a rate for the exchange in the cell for the current row.

21. When you are finished adding or modifying rows in the rate table, click OK to save your work and
close the dialog.

Specifying foreign exchange account type
The ZFXAccountType Symbol attribute specifies the foreign exchange type for account symbols. For
more information on foreign exchange, see Setting symbols in foreign exchange.

To specify foreign exchange type:

1. In the Server Explorer pane, expand Attributes and select SYMBOL.

2. In the Contents window, right-click ZFXAccountType, and select Set Value. The Attribute Values
dialog opens.

3. In the Object Selection area, select the symbol to set the foreign exchange type for.

4. In the Values area, specify a value for ZFXAccountType in Enter New Value. The current value for
ZFXAccountType displays in Value.
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a. Possible values for ZFXAccountType include the following:

Value Description

Monetary The account balance is translated at the current period rate.

NonMonetary
The account balance is treated differently depending on Operations
Type. For more information, see Understanding Operations Type.

LongTermMonetary
The account balance is treated differently depending on operations
type. For more information, see Understanding Operations Type.

Equity The account valance is translated using a blended historical rate.

RevenueExpense
This attribute value is not currently used. The account balance is
translated using a blended historical rate. This is the default value for
Standard accounts.

5. In the Values area, click Assign to value.

6. Click Apply.

7. Click OK.
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Importing And Exporting Server Objects
During implementation or system maintenance, you may find it useful to import server objects, such as
attributes, symbols, or users, in bulk using an import file. Similarly, you may also want to export your
current server objects to a file for use as a backup or to import to another system.

This section includes the following topics:

n Importing Server Objects

n Exporting Server Objects

Importing Server Objects
You can import large numbers of server objects of several different types using text files that describe
the items in a manner understandable by the server. This section lists the items you can import this way,
the files required, and how those files must be constructed.

Items of the following types can be imported using the indicated files.

Type Item File Description File Group Membership File Parent-Child File

Attribute Yes Yes No No

Attribute Values Yes No No No

Journal Entry Subcategory Yes No No No

Rule Yes No No No

Schedule Yes Yes No No

Symbol Yes Yes No Yes

Symbol Access Role Yes Yes No No

User Yes No Yes No

User Authorizations Yes No No No

User Symbol Access Yes No No No

Group Yes No Yes No

Group Authorizations Yes No No No

Group Symbol Access Yes No No No

Preparing import files for attributes
To import multiple new attributes, you must create an item file that lists the basic parameters of each
attribute on a separate line. Optionally, you can also use a description file to add descriptions in
alternate languages to attributes.

Item file syntax

Create a new text file, and for each new attribute, on a separate line, include the following:

AttrClass{AttrName{AttrDesc{AttrType{AccessType{AttrDefault

https://insightsoftware.com/


194

where:

n AttrClass is the attribute class. Select one of the following:

Field Description

SYSTEM
Describes the entire Longview system at the highest level. Attributes of this
Attribute class specify systemwide characteristics. There is only one object in the
SYSTEM Attribute class — the application itself.

USER
Describes the Attributes of a particular user. Each user is an object in the USER
Attribute class.

SYMBOL
Describes the characteristics of individual symbols. Each symbol is an object in the
SYMBOL Attribute class.

n AttrName is the name of the attribute to create.

n AttrDesc is a description for the attribute, in the default language of your application.

n AttrType is the type of attribute. Select one of the following:

Field Description

DATE Date and time.

DATELIST List of one or more Date values.

DOUBLE Numeric value.

DOUBLELIST List of one or more numeric values.

INTEGER Integer value.

INTEGERLIST List of one or more INTEGER values.

STRING Alphanumeric character string.

STRINGLIST List of one or more STRING values.

SYMBOL A valid symbol.

SYMBOLLIST List of one or more SYMBOL values.

n AccessType is the type of access to assign the attribute. Select one of the following:

Field Description

READ
Read-only access, to allow the user to view the attribute value but not change it. This
is the default. Symbol and System Attributes are always Read type.

WRITE
Write access, to allow the user to set the attribute value. Write can be used only for
User Attributes.

n AttrDefault is the default value for the attribute.

Description file syntax

The description file is used to add descriptions in alternate languages to attributes.

Create a new text file, and for each attribute and language, on a separate line, include the following:
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AttrClass{AttrName{LanguageCode{TO{AttrDesc

where:

n AttrClass is the attribute class. Select one of the following:

Field Description

SYSTEM
Describes the entire Longview system at the highest level. Attributes of this
Attribute class specify system-wide characteristics. There is only one object
in the SYSTEM Attribute class — the application itself.

USER
Describes the Attributes of a particular user. Each user is an object in the
USER Attribute class.

SYMBOL
Describes the characteristics of individual symbols. Each symbol is an object
in the SYMBOL Attribute class.

n AttrName is the name of the attribute to add the description for.

n LanguageCode is the two-letter language code of the language in which the description being
added is written.

n AttrDesc is the alternate language description to assign to the attribute.

Preparing import files for attribute values
To create multiple new attribute values, you must create an item file that lists the basic parameters of
each attribute value on a separate line.

Item file syntax

Create a new text file, and for each new attribute value, on a separate line, include the following:

AttrClass{AttrName{ObjectName{AttrValue

where:

n AttrClass is SYSTEM, USER, or SYMBOL.

n AttrName is the name of the attribute.

n ObjectName varies depending on the class:
o SYSTEM — ObjectName is DBDEFAULT.
o USER — ObjectName is the username.
o SYMBOL — ObjectName is the symbol name.

n AttrValue is the attribute value.
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Syntax example:

SYSTEM{SGPAccountsDimension{DBDEFAULT{Accounts

Preparing import files for journal entry sub-categories
To create multiple new journal entry sub-categories, you must create an item file that lists the basic
parameters of each journal entry sub-category on a separate line.

Item file syntax

Create a new text file, and for each new journal entry sub-category, on a separate line, include the
following:

Syntax example:

JESubCatDesc{SchedName{RECLASSIFIED

{

EN{JESubCatDescEN

...

FR{JESubCatDescFR

}

where:

n JESubCatDesc is the description for the sub-category.

n SchedName is optional and is the name of the schedule to which to associate the journal entry
sub-category.

n RECLASSIFIED is used only when SchedName is specified, is optional, and allows base
details to have different amounts than the total of the sub-details when the sub-category is
applied. If this option is not used, base details are forced to equal the total of the sub-details.

Syntax example:

IAS2 - Inventories{{

{

EN{IAS2 - Inventories

}

Preparing import files for server rules
To create multiple new rules, you must create an item file that lists the basic parameters of each rule on
a separate line.

https://insightsoftware.com/


197

Item file syntax

Create a new text file, and for each new rule, on a separate line, include the following:

RuleID

RuleType

{ 

RuleDefn

{ 

Message

{ 

RuleDesc

{ 

where:

n RuleID is a unique numeric rule ID used to assign to the rule.

n RuleType is MODEL, VALIDATION, ROLLUP, EVENT, or QUERY.

n RuleDefn is the statement that the system will evaluate when performing the server rule.

n Message is a message that is included with the rule. This field is valid for Validation rules and
Event rules. For Validation it is the error message displayed when validation fails. For Event it is
the body text of the email that is sent out when the rule is triggered.

n RuleDesc is a description for the rule.

Syntax Example:

1000

Validation

{

SCH(ICStandard, !11300, Actual_TimePeriods, #ALL …

{

Rule 1000: 11300 (Schedule ICStandard) = 11300 …

{

%ENTITIES - %ENTITIESDESC [\n][@5]SCHEDULE: …

{

Preparing import files for schedules
To create multiple new schedules, you must create an item file that lists the basic parameters of each
schedule on a separate line.
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Item file syntax (for standard or static schedules)

Create a new text file, and for each new schedule, on a separate line, include the following:

SchedName

SchedDesc SchedType

ListDims

ExtraDimsNum

ExtraDimName "ExtraDimDesc ExtraDimType

n For ExtraDimType = MIRROR

DimName;ListofSymbols;Attr=Value

LeafInclusion

SortType

n For ExtraDimType = SIMPLE SYMBOL

SymName1,SymName2,...

SortType

n For ExtraDimType = NUMERIC

StartRange,EndRange,Padding SortType

where:

n SchedName is a name for the schedule.

n SchedDesc is a description for the schedule.

n SchedType is STATIC, which permits data or text input to parent symbol intersections, or
STANDARD for all other schedule dimensions.

n ListDims is a list of the dimensions that do not receive rollups. If there are no dimensions that
do not receive rollups, use NONE.

n ExtraDimsNum is the number of extra dimensions this schedule will have.

n ExtraDimName is the name for the extra dimension.

n ExtraDimDesc is a description for the extra dimension.
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n ExtraDimType is one of MIRROR, SIMPLE SYMBOL, or NUMERIC.

n DimName;ListofSymbols;Attr=Value is used only when ExtraDimType is MIRROR, and is the
name of a dimension, a list of symbols delimited by commas, an attribute, and the value of that
attribute. Attr=Value is optional and uses an attribute-based filter for the mirrored dimension.

n LeafInclusion is used only when ExtraDimType is MIRROR and is either TRUE or FALSE and
indicates whether to include leaf symbols.

n SortType is one of UNSORTED, SORT_NAME, or SORT_DESC.

n SymName1,SymName2,. is the list of symbols to be used in a schedule where ExtraDimType
is SIMPLE SYMBOL.

n StartRange is the value at the beginning of a range in a schedule where ExtraDimType is
NUMERIC.

n EndRange is the value at the end of a range in a schedule where ExtraDimType is NUMERIC.

n Padding is either TRUE or FALSE and indicates whether decimal padding should be used.

Item file syntax (for intercompany schedules)

Create a new text file, and for each new schedule, on a separate line, include the following:

SchedName

SchedDesc SchedType

ListDims

ExtraDimsNum

ExtraDimName "ExtraDimDesc

ExtraDimType

n For ExtraDimType = MIRROR

DimName;ListofSymbols;Attr=Value

LeafInclusion

SortType

n For ExtraDimType = SIMPLE SYMBOL

SymName1,SymName2,...

SortType
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n For ExtraDimType = NUMERIC

StartRange,EndRange,Padding

SortType

OffsetFlag

FixedDimFlag

FixedDimSymName

where:

n SchedName is the name of the schedule.

n SchedDesc is the description of the schedule.

n SchedType is INTERCOMPANY.

n ListDims is a list of the dimensions that do not receive rollups.

n ExtraDimsNum is the number of extra dimensions this schedule will have.

n ExtraDimName is the name of an extra dimension.

n "ExtraDimDesc is the description of the extra dimension.

n ExtraDimType is one of MIRROR, SIMPLE SYMBOL, or NUMERIC.

n DimName;ListofSymbols;Attr=Value is used only when ExtraDimType is MIRROR, and is the
name of a dimension, a list of symbols delimited by commas, an attribute, and the value of that
attribute. Attr=Value is optional and uses an attribute-based filter for the mirrored dimension.

n LeafInclusion is used only when ExtraDimType is MIRROR and is either TRUE or FALSE and
indicates whether to include leaf symbols.

n SortType is one of UNSORTED, SORT_NAME, or SORT_DESC.

n SymName1,SymName2,... is the list of symbols to be used in a schedule where ExtraDimType
is SIMPLE SYMBOL.

n StartRange is the value at the beginning of a range in a schedule where ExtraDimType is
NUMERIC.

n EndRange is the value at the end of a range in a schedule where ExtraDimType is NUMERIC.

n Padding is either TRUE or FALSE and indicates whether decimal padding should be used.

n OffsetFlag is either TRUE or FALSE and indicates whether this is an offset dimension.
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n FixedDimFlag is either TRUE or FALSE and indicates whether there is a fixed dimension. This
can be used only when OffsetFlag is FALSE for the extra dimension in an intercompany
schedule.

n FixedDimSymName is the name of the fixed dimension symbol. This is used only when
OffsetFlag is FALSE and FixedDimFlag is TRUE.

Syntax example: STANDARD MIRROR

MirrorSched1

Standard Mirror Schedule Example with 1 dimension

STANDARD

NONE

1

DIMNAME1

"Dimension 1 Description

MIRROR

ACCOUNTS;DIM0SET

FALSE

UNSORTED

Syntax example: INTERCOMPANY MIRROR dimension

MirrorSched2

Intercompany Mirror Schedule Example with offset dimension

INTERCOMPANY

NONE

1

OFFSET

"Dimension 1 Description

MIRROR

ENTITIES

FALSE

UNSORTED

TRUE

Syntax example: INTERCOMPANY MIRROR dimension no offset

MirrorSched3
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Intercompany Mirror Schedule Example without offset dimension

INTERCOMPANY

NONE

1

NONOFF

"Dimension 1 Description

MIRROR

ACCOUNTS;DIM0SET

FALSE

UNSORTED

FALSE

TRUE

DIM0SET

Syntax example: STANDARD NUMERIC dimension

NumericSched

Numeric Schedule

STANDARD

NONE

1

DIMENSION1

"Dimension 1 Description

NUMERIC

1,100,False

UNSORTED

Syntax example: STANDARD SIMPLE SYMBOL dimension

SimpleSymSched

Simple Symbol Schedule

STANDARD

NONE

1

DIMNAME

"Dimension Description 1

SIMPLE SYMBOL

https://insightsoftware.com/


203

Taxes,Fees,Other

UNSORTED

Description file syntax

The description file is used to add descriptions in alternate languages to schedules. The description file
can also be used to add descriptions in alternate languages to extra dimensions.

Create a new text file, and for each new schedule, on a separate line, include the following:

SchedName{DESCRIPTION{LanguageCode{TO{SchedDesc

SchedName{DIMENSION{ExtraDimName{DESCRIPTION{LanguageCode{TO{ExtraDimDesc

where:

n SchedName is the name of the schedule.

n LanguageCode is the two-letter language code of the language in which the description being
added is written.

n SchedDesc is the new alternate language description for the schedule.

n ExtraDimName is the name of an extra dimension.

n ExtraDimDesc is the description of the extra dimension.

Preparing import files for symbols
To create multiple new symbols, you must create an item file that lists the basic parameters of each
symbol on a separate line.

Note: Using this process, you can create symbols for only one dimension at a time.

Item file syntax

Create a new text file, and for each new symbol, on a separate line, include the following:

SymName{SymDesc{SymType{ChildSort{BalanceType

where:

n SymName is a name for the symbol.

n SymDesc is the description for the symbol in the default language of your Longview system.
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n SymType specifies the way the symbol should rolls up to its parent symbol. Possible types are:
o STANDARD — Used when symbols add up normally.
o CARRYFORWARD — ACCOUNTS and TIMEPER dimensions only; used for balance

sheet and cash flow account symbols.
o STATIC — Used when it does not make sense to total a hierarchy’s values.

n ChildSort specifies the way the symbols will be prioritized in the hierarchy. Possible values are:
o 0 — When using a value of 0, the ChildSort option will be By Name (Ascending).
o 1 — When using a value of 1, the ChildSort option will be By Name (Descending).
o 2 — When using a value of 2, the ChildSort option will be Manually.

n BalanceType specifies the ACCOUNTS balance type. Possible values are:
o DEBIT — Used for debit symbols.
o CREDIT — Used for credit symbols.
o NEITHER — Used if the symbol is neither credit nor debit.

Syntax example:

TESTACCOUNT{Test account description{STANDARD{2{CREDIT

Description file syntax

The description file is used to add descriptions in alternate languages to symbols.

Create a new text file, and for each new symbol, on a separate line, include the following:

SymName{DESCRIPTION{LanguageCode{TO{SymDesc

where:

n SymName is the name of the symbol.

n LanguageCode is the two-letter language code of the language in which the description being
added is written.

n SymDesc is the new alternate language description for the symbol.

Syntax example:

TESTACCOUNT{DESCRIPTION{FR{TO{testing

Parent-child file syntax

Create a new text file, and for each symbol you want to automatically assign to a parent, on a separate
line, include the following:
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SymName{PARENT{NewParentSymName{Weight{Priority

where:

n SymName is the name of the symbol.

n NewParentSymName is the name of the symbol to which SymName is to be assigned.

n Weight is the mathematical effect of a child symbol on its parent symbol. Possible values are:
o + (The symbol is added to its parent)
o - (The symbol is subtracted from its parent)
o 0 (The symbol has no mathematical effect on its parent)

n Priority is a number that designates a symbol's position in the hierarchy relative to its parent.
Symbols are listed in order of ascending priority, with zeros falling at the bottom of the list. For
more information, see “Priority”.

Syntax example:

TESTACCOUNT{PARENT{ACCOUNTPAR{+{0

Preparing import files for symbol access roles
To create multiple new symbol access roles, you must create an item file that lists the basic parameters
of each symbol on a separate line.

Item file syntax

Create a new text file, and for each new symbol, on a separate line, include the following:

AccessType{DimName{SymName{SymAccess{NumLevels{Priority

where:

AccessType is any of:

n FULL — Write access to all symbols.

n FIXED — Access to only one symbol in the dimension.

n RESTRICTED — Select each symbol and level of access (read/write and levels).

n DimName is the dimension to which AccessType refers.

n SymName is the name of a symbol to which access is being granted. This is necessary only if
AccessType is RESTRICTED or FIXED.

n SymAccess is either R (read) or W (write). This is necessary only if AccessType is
RESTRICTED or FIXED.
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n NumLevels is how many levels below this symbol in the hierarchy access is granted. This is
necessary only if AccessType is RESTRICTED.

n Priority is a number greater than zero designating the precedence for the access type, where 1
is the highest priority and a priority of 0 gives precedence to any other non-zero value. This is
necessary only if AccessType is RESTRICTED.

In addition, each role must be headed by the name of the role. The following is an example of an item file
for creating symbol access roles (where “Analysis_Reporting_Access” and “Consolidation” are the
names of the symbol access roles being created).

Analysis_Reporting_Access

{

FULL{ACCOUNTS{{{{

FULL{TIMEPERIODS{{{{

FULL{ENTITIES{{{{

FULL{CURRENCIES{{{{

FULL{DETAILS{{{{

FULL{DATATYPES{{{{

FULL{VERSIONS{{{{

FULL{PRODUCTS{{{{

FULL{PROJECTS{{{{

FULL{DIMENSION9{{{{

FULL{DIMENSION10{{{{

FULL{DIMENSION11{{{{

FULL{DIMENSION12{{{{

FULL{DIMENSION13{{{{

FULL{DIMENSION14{{{{

FULL{DIMENSION15{{{{

}

Consolidation

{

RESTRICTED{ACCOUNTS{31120{R{0{1

RESTRICTED{ACCOUNTS{36300{R{0{1

RESTRICTED{TIMEPERIODS{ACTUAL_TIMEPERIODS{W{99{1

RESTRICTED{TIMEPERIODS{BUDGET_TIMEPERIODS{R{99{1

RESTRICTED{TIMEPERIODS{BUDGET_YTD{R{99{1
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RESTRICTED{ACCOUNTS{CASHFLOW{R{99{2

RESTRICTED{ACCOUNTS{DATA_LOAD_ACCOUNTS{W{99{2

FIXED{DIMENSION10{DIMENSION10_DEFAULT{W{0{0

FIXED{DIMENSION11{DIMENSION11_DEFAULT{W{0{0

FIXED{DIMENSION12{DIMENSION12_DEFAULT{W{0{0

FIXED{DIMENSION13{DIMENSION13_DEFAULT{W{0{0

FIXED{DIMENSION14{DIMENSION14_DEFAULT{W{0{0

FIXED{DIMENSION15{DIMENSION15_DEFAULT{W{0{0

FIXED{DIMENSION9{DIMENSION9_DEFAULT{W{0{0

RESTRICTED{TIMEPERIODS{FORECAST_TIMEPERIODS{R{99{1

RESTRICTED{TIMEPERIODS{FORECAST_YTD{R{99{1

RESTRICTED{ACCOUNTS{GROSS_INVENTORY{R{0{1

RESTRICTED{ACCOUNTS{GROSS_INVENTORY{W{99{0

RESTRICTED{ACCOUNTS{IFRS_SCHEDULES_ACCOUNTS{W{99{2

RESTRICTED{ACCOUNTS{NON_FINANCIAL{W{99{2

RESTRICTED{ACCOUNTS{TRIAL_BALANCE{W{99{2

RESTRICTED{ACCOUNTS{WF_APPROVE_MONTHEND{W{99{1

RESTRICTED{ACCOUNTS{WF_TASKS{R{99{2

FULL{ENTITIES{{{{

FULL{CURRENCIES{{{{

FULL{DETAILS{{{{

FULL{DATATYPES{{{{

FULL{VERSIONS{{{{

FULL{PRODUCTS{{{{

FULL{PROJECTS{{{{

}

Description file syntax

The description file is used to add descriptions in alternate languages to symbol access roles.

Create a new text file, and for each new symbol, on a separate line, include the following:

RoleName{LanguageCode{TO{RoleDesc

where:
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n RoleName is the name of the symbol access role.

n LanguageCode is the two-letter language code of the language in which the description being
added is written.

n RoleDesc is the new alternate language description of the symbol access role.

Preparing import files for users

Note: This section does not apply to systems that are on the ISW platform.

To create multiple new users, you must create an item file that lists the basic parameters of each user on
a separate line. Exactly which parameters must be specified depends on whether you are creating
Longview authenticated users, Windows authenticated users, or third-party web authenticated users.
You can also create a parent-child file that will tell the application which user should belong to which
group.

Note: For the optional fields (Email, HomePhone, and OfficePhone), if you do not enter a
value, you must enter delimiters ( { ) for each empty field.

Item file syntax (Longview authenticated users)

Create a new text file, and for each new user, on a separate line, include the following:

UserName{LONGVIEW{UserDesc{Password{FirstName{LastName{Email{HomePhone
{OfficePhone

where:

n UserName is the name of the user being created.

n LONGVIEW is a keyword designating the authentication type.

n UserDesc is a description of the user, written in the default language of your system.

n Password is the string the user must enter to authenticate.

n FirstName is the first name of the user.

n LastName is the last name of the user.

n Email is the email address at which the user can be contacted. This field is optional.

n HomePhone is the home phone number of the user. This field is optional.

n OfficePhone is the office phone number of the user. This field is optional.

Syntax example: Longview authentication
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JWSmith{LONGVIEW{John W. Smith{lkjsi5M{John{Smith{jwsmith@work.com{555-555-

1234{555-555-4321

JYDoe{LONGVIEW{Jane Y. Doe{mlkdo6N{Jane{Doe{{{

Item file syntax (Windows authenticated users)

Create a new text file, and for each new user, on a separate line, include the following:

UserName{WINDOWS{UserDesc{FirstName{LastName{Email{HomePhone{OfficePhone

where:

n UserName is the name of the user being created.

Note: For Windows authenticated users, UserName must be in the following format:
domain\UserID.

n WINDOWS is a keyword designating the authentication type.

n UserDesc is a description of the user, written in the default language of your system.

n FirstName is the first name of the user.

n LastName is the last name of the user.

n Email is the email address at which the user can be contacted. This field is optional.

n HomePhone is the home phone number of the user. This field is optional.

n OfficePhone is the office phone number of the user. This field is optional.

Item file syntax (third-party web authenticated users)

Create a new text file, and for each new user, on a separate line, include the following:

UserName{EXTERNAL{UserDesc{FirstName{LastName{Email{HomePhone{OfficePhone

where:

n UserName is the name of the user being created.

n EXTERNAL is a keyword designating the authentication type.

n UserDesc is a description of the user, written in the default language of your system.

n FirstName is the first name of the user.
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n LastName is the last name of the user.

n Email is the email address at which the user can be contacted. This field is optional.

n HomePhone is the home phone number of the user. This field is optional.

n OfficePhone is the office phone number of the user. This field is optional.

Group membership file syntax

Create a new text file, and for each user you want to automatically assign to a group, on a separate line,
include the following:

GroupName{UserName

where:

n GroupName is the name of the group.

n UserName is the name of the user to be added to the group.

Preparing import files for user authorizations
To set the authorizations for several users at the same time, you must create an item file that lists the
authorizations for users, each parameter on a separate line. In this fashion, you can set as many
parameters for as many users as you like.

Note: For systems on the ISW platform, if the user belongs to a group with
authorizations configured, these user authorizations are ignored and the group authorizations
apply instead.

Item file syntax

Create a new text file, and for each authorization granted to a particular user, include the following:

USER{UserName{OperationName{ObjectType{ObjectName

where:

n UserName is the name of the user to whom the authorization is being granted.

n OperationName is the name of an operation as it is in the database. The Authorization
Operations are as follows:
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Value Description
Platform
License

ADDINFOROFFICE

Access the Longview Add-In for Office.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access the Longview Add-In for Office.

Designer

Power User

Viewer

ADDINFOROFFICE
SUBMITDATA

Submit data in the Longview Add-In for Office.
Designer

Power User

ANALYSISREPORTING
AUTHOR

Access Longview Analysis and Reporting as a Report
Author.

Power user

ANALYSISREPORTING
PUBLISHER

Access Longview Analysis and Reporting as a Report
Publisher.

Designer

ANALYSISREPORTING
USER

Access Longview Analysis and Reporting as a Report
User.

Viewer

APPLICATION
ADMINISTRATOR

Access Longview Application Administrator.

Admin

Designer

Service

ATTRIBUTE Manage attributes. Designer

BATCH Manage batches.
Admin

Designer

CONNECTVIA
APPLICATION
FRAMEWORK

Connect to the server using Longview Application
Framework.

Note: You must assign this authorization to
allow users or user groups to access Longview
Apps, Longview Designer, Longview tools and
editors, the Longview Add-In for Office, and
Longview Tax.

Admin

Designer

Power User

Viewer

Service

DASHBOARDDESIGNER Access Longview Dashboard Designer. Designer

DELETECOMMENTS

Delete any existing comments in the Data Server. Users
without Delete Comments authorization can delete only
their own comments before they are submitted to the
database.

Note: Delete existing comments functionality
is available in Data Grids only.

Designer
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Value Description
Platform
License

DESIGNER

Access Longview Designer.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSCREATE

Create data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSDELETE

Delete data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSMODIFY

Edit data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSPUBLISH

Publish data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERLONGVIEW
APPSPUBLISH

Publish Longview Apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

FOREIGNEXCHANGE
SETTINGS

Manage foreign exchange settings.
Admin

Designer

GROUPADMINISTRATION Perform group administration.
Does not
apply

GROUPSYMBOLACCESS Manage symbol access for groups.    
Does not
apply

INTERCOMPANYSETTINGS Manage intercompany settings. Designer

https://insightsoftware.com/


213

Value Description
Platform
License

JOURNALENTRIES Access Longview Journal Entries.
Designer

Power User

JOURNALENTRY Manage journal entries.

Designer

Power User

Service

JOURNALENTRYCURRENT
PERIODCREATE

Create current period journal entries.

Designer

Power User

Service

JOURNALENTRYCURRENT
PERIODPERMPOST

Permanently post current period journal entries.

Designer

Power User

Service

JOURNALENTRYCURRENT
PERIODREVIEWPOST

Review post current period journal entries.

Designer

Power User

Service

JOURNALENTRYDELETE Delete non-shared journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODCREATE

Create future period journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODPERMPOST

Permanently post future period journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODREVIEWPOST

Review post future period journal entries.

Designer

Power User

Service

JOURNALENTRYOWN
PERMPOST

Permanently post own journal entries.

Designer

Power User

Service

JOURNALENTRYOWN
REVIEWPOST

Review post own journal entries.

Designer

Power User

Service
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Value Description
Platform
License

JOURNALENTRYPRIOR
PERIODADJCREATE

Create prior period journal entries.

Designer

Power User

Service

JOURNALENTRYPRIOR
PERIODADJPERMPOST

Permanently post prior period journal entries.

Designer

Power User

Service

JOURNALENTRYPRIOR
PERIODADJREVIEWPOST

Review post prior period journal entries.

Designer

Power User

Service

JOURNALENTRYRE
STATEMENTCREATE

Create restatement journal entries.

Designer

Power User

Service

JOURNALENTRYRE
STATEMENTPERMPOST

Permanently post restatement journal entries.

Designer

Power User

Service

JOURNALENTRYRE
STATEMENTREVIEWPOST

Review post restatement journal entries.

Designer

Power User

Service

LOCK Manage locks.
Designer

Service

MAPPINGSEDITOR

Access the Mappings editor.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access the Mappings editor.

Designer

Power User

Service

MAPPINGSMANAGE

Create, modify, delete mappings.

Note: You must also assign the
MAPPINGSEDITOR authorization to allow
users or user groups to access the Mappings
editor.

Designer

Power User

Service
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Value Description
Platform
License

MAPSMANAGE

Create, modify, delete maps.

Note: You must also assign the
MAPPINGSEDITOR authorization to allow
users or user groups to access the Mappings
editor.

Designer

Power User

Service

MODIFYDATA Submit data.

Designer

Power User

Service

NDDSETTINGS Manage NDD settings. Designer

ROLE Manage symbol access roles.
Designer

Service

RULE Manage rules.
Designer

Service

SCHEDULE Manage schedules.
Designer

Service

SERVERMANAGER Access Longview Server Manager.

Admin

Service

Designer

SERVERMANAGERSTART Start/stop the Longview server.
Admin

Service

Designer

SERVICEACCOUNTUSER
ADMINISTRATOR

Sets the user to be a User Administrator. Service

SERVICEACCOUNTRESTAPI

Sets user to be a Service Account User.

Note: Can only be set using PUSER or a user
who has User Administrator Authorization.

Admin

Designer

Service

SYMBOL Manage symbols.
Designer

Service

SYMBOLASSIGN
Assign symbols to a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYMBOLATTRIBUTECREATE
Create symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service
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Value Description
Platform
License

SYMBOLATTRIBUTEDELETE
Delete symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYMBOLATTRIBUTEMODIFY
Modify symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYMBOLCANCREATEROOT
Create root symbols. Must be used with SYMBOL,
CREATESYMBOL.

Designer

Service

SYMBOLCANDELETEROOT
Delete root symbols. Must be used with SYMBOL,
SYMBOLDELETE.

Designer

Service

SYMBOLCREATE Create symbols. Must be used with SYMBOL.
Designer

Service

SYMBOLDELETE Delete symbols. Must be used with SYMBOL.
Designer

Service

SYMBOLREMOVE
Remove symbols from a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYMBOLSET Modify symbols. Must be used with SYMBOL.
Designer

Service

SYMBOLSWITCH
Switch symbols in a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYSTEMATTRIBUTECREATE
Create system attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYSTEMATTRIBUTEDELETE
Delete system attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYSTEMATTRIBUTEMODIFY
Modify system attributes. Must be used with
ATTRIBUTE.

Designer

Service

USERADMINISTRATION Perform user administration
Does not
apply

USERATTRIBUTECREATE Create user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERATTRIBUTEDELETE Delete user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERATTRIBUTEMODIFY Modify user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERRESETPASSWORD Reset passwords.
Does not
apply
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Value Description
Platform
License

USERSYMBOLACCESS Manage symbol access for users.
Does not
apply

VIEWDATA View data.

Designer

Power User

Viewer

Service

WORKFLOWDESIGNER Access LongviewWorkflow Designer. Designer

n ObjectType is GROUP and is used only when OperationName is USERADMINISTRATION or
USERRESETPASSWORD.

n ObjectName is the group which the authorization specified for OperationName is applied to.
ObjectName is used only when OperationName is USERADMINISTRATION or
USERRESETPASSWORD.

Note: If ObjectName is AllUsers, the specified authorization is granted to the user for all users
in the system.
For more information, see Understanding the AllUsers Group.

Syntax examples:

USER{TestUser{SYMBOL{{

USER{TestUser{USERADMINISTRATION{GROUP{GRP0

Preparing import files for group symbol access
To set the symbol access for several users at the same time, you must create an item file that lists the
symbol access for users, each parameter on a separate line. In this fashion, you can set as many
parameters for as many users as you like.

Item file syntax

Create a new text file, and for each symbol authorization granted to a particular user, include the
following:

GROUP{GroupName{SymAccessRole{Dim-Name{Inherit{SymName{Access{NumLevels
{Priority

where:

n GroupName is the name of the group to whom the access is being granted.

n SymAccessRole is the name of the symbol access role in which the symbol access being
granted resides.

https://insightsoftware.com/


218

n DimName is the dimension to which Access refers.

n Inherit indicates whether the access is inherited from the symbol access role itself and is either
TRUE or FALSE.

n SymName is the name of a symbol to which access is being granted. This needs to be set only
if inherit is set to FALSE.

n Access is either R (read) or W (write). This needs to be set only if inherit is set to FALSE.

n NumLevels is how many levels below this symbol in the hierarchy access is granted. This
needs to be set only if inherit is set to FALSE.

n Priority is a number greater than zero designating the precedence for the access type, where 1
is the highest priority and a priority of 0 gives precedence to any other non-zero value. This
needs to be set only if inherit is set to FALSE.

Syntax examples:

GROUP{Admins{V3_Compatible_Access{CONTROLS{FALSE{SYSTEM7{R{99{1

GROUP{Admins{V3_Compatible_Access{TRUE{{{{

Preparing import files for groups
To create multiple new groups, you must create an item file that lists the basic parameters of each group
on a separate line.

Item file syntax

Create a new text file, and for each new group, on a separate line, include the following:

GroupName{GroupDesc

where:

n GroupName is the name of the group being created.

n GroupDesc is a description of the group, written in the default language of your system.

Group membership file syntax
Create a new text file, and for each user you want to automatically assign to a group, on a separate line,
include the following:

GroupName{UserName

where:
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n GroupName is the name of the group.

n UserName is the name of the user to be added to the group.

Preparing import files for group authorizations

Note: This section does not apply to systems that are on the ISW platform.

To set the authorizations for several groups at the same time, you must create an item file that lists the
authorizations for groups, each parameter on a separate line. In this fashion, you can set as many
parameters for as many groups as you like.

Note: For systems on the ISW Platform, when a user belongs to a group with
authorizations configured, the group authorizations apply and the user's individual
authorizations are ignored. If the group has no authorizations configured, the user's individual
authorizations are used instead. Any group authorizations that exceed what the user's license
permits are also ignored.

Item file syntax

Create a new text file, and for each authorization granted to a particular group, include the following:

GROUP{GroupName{OperationName{ObjectType{ObjectName where:

n GroupName is the name of the group to whom the authorization is being granted.

n OperationName is the name of an operation as it is in the database. The Authorization
Operations are as follows:

Value Description
Platform
License

ADDINFOROFFICE

Access the Longview Add-In for Office.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access the Longview Add-In for Office.

Designer

Power User

Viewer

ADDINFOROFFICE
SUBMITDATA

Submit data in the Longview Add-In for Office.
Designer

Power User

ANALYSISREPORTING
AUTHOR

Access Longview Analysis and Reporting as a Report
Author.

Power user

ANALYSISREPORTING
PUBLISHER

Access Longview Analysis and Reporting as a Report
Publisher.

Designer
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Value Description
Platform
License

ANALYSISREPORTING
USER

Access Longview Analysis and Reporting as a Report
User.

Viewer

APPLICATION
ADMINISTRATOR

Access Longview Application Administrator.

Admin

Designer

Service

ATTRIBUTE Manage attributes. Designer

BATCH Manage batches.
Admin

Designer

CONNECTVIA
APPLICATION
FRAMEWORK

Connect to the server using Longview Application
Framework.

Note: You must assign this authorization to
allow users or user groups to access Longview
Apps, Longview Designer, Longview tools and
editors, the Longview Add-In for Office, and
Longview Tax.

Admin

Designer

Power User

Viewer

Service

DASHBOARDDESIGNER Access Longview Dashboard Designer. Designer

DELETECOMMENTS

Delete any existing comments in the Data Server. Users
without Delete Comments authorization can delete only
their own comments before they are submitted to the
database.

Note: Delete existing comments functionality
is available in Data Grids only.

Designer

DESIGNER

Access Longview Designer.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSCREATE

Create data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer
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Value Description
Platform
License

DESIGNERDATA
IMPORTSDELETE

Delete data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSMODIFY

Edit data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERDATA
IMPORTSPUBLISH

Publish data import apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

DESIGNERLONGVIEW
APPSPUBLISH

Publish Longview Apps in Longview Designer.

Note: You must also assign the DESIGNER
authorization to allow users or user groups to
access Longview Designer.

Designer

FOREIGNEXCHANGE
SETTINGS

Manage foreign exchange settings.
Admin

Designer

GROUPADMINISTRATION Perform group administration.
Does not
apply

GROUPSYMBOLACCESS Manage symbol access for groups.    
Does not
apply

INTERCOMPANYSETTINGS Manage intercompany settings. Designer

JOURNALENTRIES Access Longview Journal Entries.
Designer

Power User

JOURNALENTRY Manage journal entries.

Designer

Power User

Service

JOURNALENTRYCURRENT
PERIODCREATE

Create current period journal entries.

Designer

Power User

Service
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Value Description
Platform
License

JOURNALENTRYCURRENT
PERIODPERMPOST

Permanently post current period journal entries.

Designer

Power User

Service

JOURNALENTRYCURRENT
PERIODREVIEWPOST

Review post current period journal entries.

Designer

Power User

Service

JOURNALENTRYDELETE Delete non-shared journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODCREATE

Create future period journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODPERMPOST

Permanently post future period journal entries.

Designer

Power User

Service

JOURNALENTRYFUTURE
PERIODREVIEWPOST

Review post future period journal entries.

Designer

Power User

Service

JOURNALENTRYOWN
PERMPOST

Permanently post own journal entries.

Designer

Power User

Service

JOURNALENTRYOWN
REVIEWPOST

Review post own journal entries.

Designer

Power User

Service

JOURNALENTRYPRIOR
PERIODADJCREATE

Create prior period journal entries.

Designer

Power User

Service

JOURNALENTRYPRIOR
PERIODADJPERMPOST

Permanently post prior period journal entries.

Designer

Power User

Service

JOURNALENTRYPRIOR
PERIODADJREVIEWPOST

Review post prior period journal entries.

Designer

Power User

Service
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Value Description
Platform
License

JOURNALENTRYRE
STATEMENTCREATE

Create restatement journal entries.

Designer

Power User

Service

JOURNALENTRYRE
STATEMENTPERMPOST

Permanently post restatement journal entries.

Designer

Power User

Service

JOURNALENTRYRE
STATEMENTREVIEWPOST

Review post restatement journal entries.

Designer

Power User

Service

LOCK Manage locks.
Designer

Service

MAPPINGSEDITOR

Access the Mappings editor.

Note: You must also assign the
CONNECTVIAAPPLICATIONFRAMEWORK
authorization to allow users or user groups to
access the Mappings editor.

Designer

Power User

Service

MAPPINGSMANAGE

Create, modify, delete mappings.

Note: You must also assign the
MAPPINGSEDITOR authorization to allow
users or user groups to access the Mappings
editor.

Designer

Power User

Service

MAPSMANAGE

Create, modify, delete maps.

Note: You must also assign the
MAPPINGSEDITOR authorization to allow
users or user groups to access the Mappings
editor.

Designer

Power User

Service

MODIFYDATA Submit data.

Designer

Power User

Service

NDDSETTINGS Manage NDD settings. Designer

ROLE Manage symbol access roles.
Designer

Service
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Value Description
Platform
License

RULE Manage rules.
Designer

Service

SCHEDULE Manage schedules.
Designer

Service

SERVERMANAGER Access Longview Server Manager.

Admin

Service

Designer

SERVERMANAGERSTART Start/stop the Longview server.
Admin

Service

Designer

SERVICEACCOUNTUSER
ADMINISTRATOR

Sets the user to be a User Administrator. Service

SERVICEACCOUNTRESTAPI

Sets user to be a Service Account User.

Note: Can only be set using PUSER or a user
who has User Administrator Authorization.

Admin

Designer

Service

SYMBOL Manage symbols.
Designer

Service

SYMBOLASSIGN
Assign symbols to a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYMBOLATTRIBUTECREATE
Create symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYMBOLATTRIBUTEDELETE
Delete symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYMBOLATTRIBUTEMODIFY
Modify symbol attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYMBOLCANCREATEROOT
Create root symbols. Must be used with SYMBOL,
CREATESYMBOL.

Designer

Service

SYMBOLCANDELETEROOT
Delete root symbols. Must be used with SYMBOL,
SYMBOLDELETE.

Designer

Service

SYMBOLCREATE Create symbols. Must be used with SYMBOL.
Designer

Service
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Value Description
Platform
License

SYMBOLDELETE Delete symbols. Must be used with SYMBOL.
Designer

Service

SYMBOLREMOVE
Remove symbols from a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYMBOLSET Modify symbols. Must be used with SYMBOL.
Designer

Service

SYMBOLSWITCH
Switch symbols in a hierarchy. Must be used with
SYMBOL.

Designer

Service

SYSTEMATTRIBUTECREATE
Create system attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYSTEMATTRIBUTEDELETE
Delete system attributes. Must be used with
ATTRIBUTE.

Designer

Service

SYSTEMATTRIBUTEMODIFY
Modify system attributes. Must be used with
ATTRIBUTE.

Designer

Service

USERADMINISTRATION Perform user administration
Does not
apply

USERATTRIBUTECREATE Create user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERATTRIBUTEDELETE Delete user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERATTRIBUTEMODIFY Modify user attributes. Must be used with ATTRIBUTE.
Designer

Service

USERRESETPASSWORD Reset passwords.
Does not
apply

USERSYMBOLACCESS Manage symbol access for users.
Does not
apply

VIEWDATA View data.

Designer

Power User

Viewer

Service

WORKFLOWDESIGNER Access LongviewWorkflow Designer. Designer

n ObjectType is GROUP and is used only when OperationName is USERADMINISTRATION or
USERRESETPASSWORD.
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n ObjectName is the group which the authorization specified for OperationName is applied to.
ObjectName is used only when OperationName is USERADMINISTRATION or
USERRESETPASSWORD.

Note: If ObjectName is AllUsers, the specified authorization is granted to the user for all users
in the system.
For more information, see Understanding the AllUsers Group.

Syntax examples:

GROUP{Admins{SYMBOL{{

GROUP{Admins{USERRESETPASSWORD{GROUP{AllUsers

Preparing import files for user symbol access
To set the symbol access for several users at the same time, you must create an item file that lists the
symbol access for users, each parameter on a separate line. In this fashion, you can set as many
parameters for as many users as you like.

Item file syntax

Create a new text file, and for each symbol authorization granted to a particular user, include the
following:

USER{UserName{SymAccessRole{DimName{Inherit{SymName{Access{NumLevels
{Priority

where:

n UserName is the name of the user to whom the access is being granted.

n SymAccessRole is the name of the symbol access role in which the symbol access being
granted resides.

n DimName is the dimension to which Access refers.

n Inherit indicates whether the access is inherited from the symbol access role itself and is either
TRUE or FALSE.

n SymName is the name of a symbol to which access is being granted. This needs to be set only
if inherit is set to FALSE.

n Access is either R (read) or W (write). This needs to be set only if inherit is set to FALSE.

n NumLevels is how many levels below this symbol in the hierarchy access is granted. This
needs to be set only if inherit is set to FALSE.
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n Priority is a number greater than zero designating the precedence for the access type, where 1
is the highest priority and a priority of 0 gives precedence to any other non-zero value. This
needs to be set only if inherit is set to FALSE.

Syntax examples:

User{User2{V3_Compatible_Access{CONTROLS{FALSE{SYSTEM7{R{99{1

User{User2{V3_Compatible_Access{ENTITIES{TRUE{{{{

Importing files
To import the files that you have created, follow these steps:

1. Open Longview Application Administrator.

2. Select File > Import. The Import dialog opens, shown below:

3. For Item type, select the appropriate server object in the list, and click Next.

4. In the Item file field, click Next.

5. Do one of the following:

l If you are importing symbols, select the dimension in which to create the new symbols, and
click Next.

l Otherwise, continue to the next step.

6. On the file locations page, type the Item file Location.
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7. Depending on the type of file you are importing, complete the following fields, as necessary:

a. Description file (optional): Optionally, select Include descriptions. For Description file
Location, type the location of the description filed. This applies to Attributes, Schedules,
Symbols, and Symbol access roles.

b. Group membership file (optional): Optionally, select Include group memberships. For
Group membership file Location, type the location of the group membership file. This applies
to Users and Groups.

c. Parent-child file (optional): Optionally, select Include parent-child relationships. For Parent-
child file Location, type the location of the parent-child file. This applies to Symbols.

Note: You can also click Browse to navigate to, and select, the desired file.

8. Click Finish. An Import Summary dialog opens, informing you of any errors.

Exporting Server Objects
Exporting server metadata is a process that transfers database server objects to external locations. This
section explains how to export existing server objects to a file.

Metadata about the following item types can be exported to simple text files:

n attributes

n attribute values

n groups

n group authorizations

n group symbol access

n journal entry sub-categories

n server rules

n schedules

n symbols

n symbol access roles

n users

n user authorizations

n user symbol access
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Note: Users cannot be exported for systems that are on the ISW platform.

For each type of item, the following definitions and properties can be exported to files:

n Items (the name of the item and its principal parameters)

n Descriptions (the descriptions applied to the item, and its language designation)

n Group memberships (the name of the group and the names of all users that belong to that
group; this is only available when exporting information on users or groups)

n Parent-child relationships (the parent symbol of the item, if it is a child or leaf symbol; this is
available only when exporting information on symbols).

Exporting server objects to files
To export server object information, complete the following steps:

1. Open Longview Application Administrator.

2. Select File > Export. The Export dialog opens, as shown below:

3. Select the item type you want to export and click Next.

4. If you selected Attribute Values as the item type, complete these steps; otherwise, continue to the
next step:

https://insightsoftware.com/


230

a. Select one of the following attribute value type export options:

i. Export all attribute values: Exports all attribute values in the system.

ii. Export attribute values for: Exports only attribute values of the selected class. If you use this
option, you must select a class in the drop-down list.

b. Click Next. The file locations dialog opens.

c. Continue to step 6.

5. If you selected Symbol as the item type, complete these steps; otherwise, continue to the next step:
a. Select the dimension that contains the symbols to export; otherwise continue to the next step.

6. Click Next. The file locations dialog opens.

7. Continue to the next step.

8. In the Item File area, type a folder location for the Item file along with the file name and extension
(.txt) to which to save it. For example:

C:\Users\Me\ExportFiles\AttributesExport.txt.

9. Depending on the type of file you are importing, complete the following fields, as necessary:

a. Description file (optional): To export descriptions, select Include descriptions. For
Description file Location, type a folder location for the description file along with the file name
and extension (.txt) to which to save it. For example:
C:\Users\Me\ExportFiles\SymbolDescriptionsExport.txt. This field applies to
Attributes Schedules, Symbols, and Symbol Access Roles.

b. Group membership file (optional): To export group membership information, select Include
group memberships. For Group membership file Location, type a folder location for the
membership file along with the file name and extension (.txt) to which to save it. For example,
C:\Users\Me\ExportFiles\UserMembership.txt.. This field applies to Users and
Groups.

c. Parent-child file (optional): Optionally, select Include parent-child relationships. For Parent-
child file Location, type a folder location for the membership file along with the file name and
extension (.txt) to which to save it. For example:
C:\Users\Me\ExportFiles\SymbolRelationships.txt. This field applies to
Symbols.

10. Click Finish. An Export Summary dialog opens.

11. Review the summary and click Close.

Understanding export file syntax
Export files are in the same format as the related import files. For more information, see Importing
Server Objects.
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Monitoring The System
As System Administrator, you may need to monitor the system.

Working with locks
Your Longview system prevents two users from changing the same information simultaneously. This is
called a lock. The system locks to prevent data loss if anyone tries to use a function currently in use by
someone else.

Several users or all users may be affected, depending on the specifications. Since the system is meant
to be used in a multi-user environment, locks reduce the risk of overwriting data in use by another user.

Sometimes you may inadvertently lock data you are using — if, for example, your computer stops
responding before you have saved your work. In this case, you can unlock the locked data when you
return to the system.

The lock list displays certain information about the locks, in separate columns that, when clicked, will
sort the locks according to the column's property:

n The unique ID number of each lock.

n The lock description, if available.

n The owner (user) of each lock.

n Whether or not the lock involves schedule data.

n The creation date and time of the lock.

Viewing locks
To view the data locks in use, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Locks. A list of the data locks on the server appears in the
Contents window.
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3. You can view more information about a lock by selecting it. The exact nature of the data intersection
is displayed on the Details page.

Searching for a lock
In some cases, there may be many data locks in the system. It is possible to search for a specific lock or
set of locks matching certain criteria.

To search for a lock or group of locks, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Locks. A list of the current data locks on the server appears in
the Contents window.
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3. Click the search icon in the tool bar. The Search dialog opens.

4. Enter your search criteria. You may enter information for any or all these fields:

l User

l Schedule

l Symbol (you may type in this field or click the ellipsis button ( ... ) to use the
LockSymbolSearchForm dialog to choose a symbol from the hierarchy)

5. To run your search, click Find. The results matching your criteria, if any, are displayed in the Search
Results window.

Deleting a lock
To release locked data no longer in use, follow these steps:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Locks. A list of the current data locks on the server appears in
the Contents window.

3. Right-click the lock you want to delete and select Delete. A confirmation dialog appears.

Note: The Delete option is available only if you have permission to delete the lock.

Caution: If you delete a lock, it cannot be recovered. Use this function with caution. Click Yes.
The lock is deleted from the list and that data intersection becomes eligible for modification
again.

Working with batches
Users with Batches and Events authorization can view all batches and events in the database and
delete them if necessary.
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Viewing batch status
There are occasions when you may want to view information for all batches (user submissions). For
example, you can view batch information to ensure that submitted data has reached the database.

To view all the events associated with a batch, see Analyzing batch information.

To view batch information:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Batches. The batches list appears in the Contents window.

3. Review the following information:

a. ID: The system-assigned ID of the batch.

b. Description: The description of the batch.

c. Owner: The username of the owner of the batch.

d. Status: The status of the user batch. Possible values are:

l Completed — The batch completed successfully.

l Error — The batch encountered an error and failed to complete.

l In Progress — The batch is in progress.

l Incomplete — The batch did not complete.

l No Data — No data was modified by the batch.
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e. Creation Date: The date and time of creation of the batch.

f. Completion Date: The date and time of the completion of the batch, if available.

g. Elapsed Time: The amount of time required for the batch to complete (if it completed
successfully), in seconds.

Viewing batch details
The Details dialog displays extra information for batches. If the batch triggered server processes, a plus
sign ( + ) indicates that you can expand the details to view this information.

Note: To see events triggered by the batch, you must analyze the batch. For more
information, see Analyzing batch information.

The Batch Details window uses icons to indicate the status of each item. Below is a list of each icon and
what they indicate:

Icon Description

The item completed successfully.

The item encountered an error and failed to complete.

The item is in progress.

The item is pending.

The item did not complete.

The Batch Details window displays details in the following format:
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Server Format

Submission

Submission(Partition, Family, DataType[QueueInfo])(ElapsedTime)

where:

n Partition is the number of the partition on which the process is running.

n Family is one of the following:
o unadjusted — Indicates the process is running on unadjusted data.
o adjusting — Indicates the process is running on journal entry data.
o schedule — Indicates the process is running on schedule data.
o adjusting schedule — Indicates the process is running on journal entry data

posted to a schedule.

n DataType is the type of data on which the process is running and can be one of
the following:
o Leaf
o Parent
o Calculated

n QueueInfo is the position of the batch in the queue, in the format Queue #x,
where x is the position.

n ElapsedTime is the total elapsed time to completion, in seconds.

Math

Math(ElapsedTime)

where:

n ElapsedTime is the total elapsed time to completion, in seconds.

Elimination

Elimination(Partition)(ElapsedTime)

where:

n Partition is the number of the partition on which the process is running.

n ElapsedTime is the total elapsed time to completion, in seconds.
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Server Format

Writer

Writer(Partition, Family, DataType)(ElapsedTime)

where:

n Partition is the partition on which the process is running.

n Family is one of the following:
o unadjusted — Indicates the process is running on unadjusted data.
o adjusting — Indicates the process is running on journal entry data.
o schedule — Indicates the process is running on schedule data.
o adjusting schedule — Indicates the process is running on journal entry data

posted to a schedule.

n DataType is the type of data on which the process is running and can be one of
the following:
o leaf
o parent
o calculated
o CTA
o validation

n ElapsedTime is the total elapsed time to completion, in seconds.

To view batch details:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Batches. A list of the batches appears in the Contents window.

3. Select the batch that you want to view details for, and then click the Details tab.

4. Expand the details as necessary.

Analyzing batch information
In some cases, a batch may trigger an event that triggers other events, and subsequently, other
batches. You can use the Analyze dialog to view information for all tiers of items resulting from the
original batch, including the overall status of the batch and the total elapsed time that it took for it, and all
triggered batches and events, to complete.

To analyze batch information:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Batches. The batches list appears in the Contents window.

3. Right-click the batch you want to analyze and click Analyze on the context menu. The Analyze
dialog opens.
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4. Review information for the overall batch in the first line:

a. Creation Date: The creation date and time of the initial batch.

b. Completion Date: The date and time when all the batches and events completed.

c. Status: 

l Completed — The batches and events completed successfully.

l Error — One or more batches or events encountered an error and failed to complete.

l In Progress — One or more batches or events are currently in progress.

l Pending — One or more events are in the queue, pending the elapse of the interval time.

l Incomplete — One or more batches did not complete.

l No Data — No data was modified by the initial batch.

d. Elapsed Time: The total time for all batches and events to complete.

5. Review the following information:

Note: You can use the Search box to search items in the ID, Description or Status
columns. Type a search term in the Search box and click the Search button to find the next
instance. Click a column to sort the batches and events according to the column's
property.

a. ID: The type of process (Batch or Event) and its ID. If an Event has a negative ID, it has not yet
been processed and is waiting for the interval time to elapse.

b. From ID: The ID of the batch or event that triggered the batch or event.
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c. Rule ID: The Rule ID for the event.

d. Status:

l Completed — The batch or event completed successfully.

l Error — The batch or event encountered an error and failed to complete.

l In Progress — The batch or event is currently in progress.

l Pending — The event is in the queue, pending the elapse of the interval time.

l Incomplete — The batch did not complete.

l No Data — The batch contained only unmodified data.

e. Creation Date: The creation date and time of the batch or event.

f. Completion Date: The date and time when the batch or event completed.

g. Elapsed Time: The total time for the batch or event to complete.

6. When you are finished, click Close to return to the Batches list.

Deleting batch information
If the batches list becomes excessively long, you may be able to manage it by deleting batch
information, depending on your authorization and system settings.

If you have Batches and Events authorization, you can delete batch information for all batches in the
system. If you do not have Batches and Events authorization, you cannot delete batch information. For
more information, contact your System Administrator.

Note: If Data Audit Trail is ON, you cannot delete batch information. To delete batch
information when Data Audit Trail is ON, you must reset the audit tables. For more information,
see Resetting the Data Audit Trail.

To delete batch information:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Batches. A list of the batches currently on the server appears in
the Contents window.

3. Right-click the batch and select Delete. A confirmation dialog appears.

Caution: If you delete batch information, it cannot be recovered. Use this feature with
caution.

4. Click Yes. The selected batch information is deleted from the database.
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Working with events
Users with Batches and Events authorization can view information for all events in the database and
delete this information if necessary.

For information on Event rules, see Understanding Event rules.

Viewing event status
There are occasions when you may want to view information for all events in the database to review
their status.

If you want to view events within the context of the batches that triggered them, see Analyzing Batch
Information.

To view event status:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Events. The events list appears in the Contents window.

3. Review the following information:

a. ID: The system-assigned ID of the event.

b. Description: The description of the event.

c. Status: The status of the user batch. Possible values are:

l Completed — The event completed successfully with no errors.

l Error — The event failed to complete due to one or more errors.

l In Progress — The event is currently in progress.

l Pending — The event is in the queue, pending the elapse of the interval time.
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For information on how event status affects overall status, see Analyzing Batch Information.

d. Creation Date: The date and time of creation of the event.

e. Completion Date: The date and time of the completion of the event, if available.

f. Elapsed Time: The amount of time required for the event to complete (if it completed
successfully), in seconds.

Note: Click a column to sort the events according to the column's property.

Deleting event information
Your Longview System maintains event information for audit purposes in the database. You may want to
delete event information to keep the Events list manageable. You can delete event information only if
Data Audit Trail is FALSE for your system. Otherwise, you must reset the audit trail.

For more information, see Resetting the Data Audit Trail.

You must have Batches and Events authorization to delete event information. For more information on
setting user authorization, see Creating Users.

To delete event information:

1. Open Longview Application Administrator.

2. In the Server Explorer pane, select Events. A list of the events currently on the server appears in
the Contents window.

3. Right-click the event and select Delete. A confirmation dialog appears.

Caution: If you delete event information, it cannot be recovered. Deleting event
information also deletes related log, error, and history files. Use this feature with caution.

4. Click Yes. The selected event information is deleted from the database.
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